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Chapter 1. Product overview
IBM® Maximo Integrators for TRIRIGA integrates the work management
capabilities of IBM Maximo® Asset Management with the facilities management
capabilities of IBM TRIRIGA®. You can perform space and move planning and
condition assessment in IBM TRIRIGA and create work tasks that are sent to
Maximo Asset Management where the work is carried out.
IBM Maximo Integrators for TRIRIGA supports centralized facilities management,
reduces operational costs, and improves process efficiency throughout the
enterprise.
IBM Maximo Integrators for TRIRIGA includes predefined components that
support end-to-end integration between Maximo Asset Management and IBM
TRIRIGA. The Maximo Asset Management integration framework supports
inbound and outbound data transfer, business rules, integration messages, and
error management processes. The TRIRIGA Application Platform DataConnect
feature supports batch import of data and the TRIRIGA Connector for Business
Applications includes a web service for sharing transactional data with Maximo
Asset Management.

Business scenarios
IBM Maximo Integrators for TRIRIGA supports two scenarios that support
integrated space and move management and the opportunities management aspect
of facilities assessment. With integrated space and move management, you can
streamline the location of people and assets in a facility. When you perform a
condition assessment of a facility, integrated opportunities management enables
you to prioritize, schedule, and perform necessary repairs and maintenance work.

Scenario: Moving employees and their assets to a new
location
The Facilities Manager at Company ABC manages employee workspaces and the
assets that employees use in the workspaces. Sometimes it is necessary to move a
group of employees to a new location, for example to accommodate an expanding
department in a larger location.

Background
Company ABC plans to use Maximo Integrators for TRIRIGA for space and move
management. An integration specialist integrated locations, assets, and people data
between Maximo Asset Management and IBM TRIRIGA to enable integrated space
management. Employees or service desk agents can submit space move requests in
either Maximo Asset Management or IBM TRIRIGA.
Marti is a space and move planner who processes space move requests in IBM
TRIRIGA. When a work plan creates move work tasks, Marti coordinates and
plans these tasks. Jo is a work supervisor in Maximo Asset Management who
receives the move work orders and assigns the work to field operatives. Lee and
Jean are field operatives who perform move-related tasks.

© Copyright IBM Corp. 2013
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Step 1. Create a move service request
Jane manages an expanding marketing team and has authorization to move the
entire team to a larger workspace. In Maximo Asset Management, in the Create
Service Request application, Jane creates a Move service request. In the service
request, Jane selects the group option from the service request class options of
small, individual, or group. In the details section, Jane lists the employees to move,
the assets to move with them, and their current locations.

Step 2. Plan the space move
When Marti receives the Change Space service request in IBM TRIRIGA, he
reviews possible target locations in the Locations Hierarchy application. Marti can
also use the IBM TRIRIGA CAD Integrator/Publisher to visualize available
locations and to model the revised workspace allocations.
When all of the target locations are identified, Marti creates a move work task to
manage the actual move work. For each team member in the department, Marti
adds a move line item to the work task. The move line item includes the existing
location for the employee, the target location, and the assets that are associated
with the location. When all of the move line items are entered in the move work
task, Marti activates the move work task.

Step 3. Assign move tasks to field operatives
When the move work task is activated, it is sent to Maximo Asset Management,
where a corresponding work order is created. Jo, the work supervisor, reviews the
work order and plans who is responsible for completing the work. In Maximo
Asset Management, in the Scheduler application, Jo schedules work in the Gantt
view and reviews the availability of personnel to carry out the move work. Jo then
assigns the work to field operatives.

Step 4. Perform the move
The work order tasks are assigned to field operatives. Lee is an electrician who is
assigned the task to ensure that the new target locations support the power supply
requirements for the marketing employees. Jean is assigned the task to physically
move employee assets, including desks, seating, telephones, and IT equipment.
While the field operatives perform their tasks, they update the statuses of their
tasks.

Step 5. Complete the move work
When the field operatives complete their tasks, the status of the work order is
updated. The updated statuses are sent to IBM TRIRIGA which, in turn, updates
the status of the originating service request. The costs that are associated with the
work are recorded in the work order and are then sent to IBM TRIRIGA. When all
of the work is completed, IBM TRIRIGA sends the updated person and asset
records to Maximo Asset Management with the revised location information.

Integrated space and move management
With integrated space and move management, you can streamline the location of
people and assets in a facility.
The business process starts when a user creates a move request in IBM TRIRIGA or
a user creates a service request in Maximo Asset Management that is sent to IBM

2

Implementation Guide

TRIRIGA, where a move request is then generated. When a move request is
created, a service plan is applied that determines the subsequent activities. A space
and move planner reviews the service plan, plans the move work, and creates
work tasks or creates a project that includes work tasks. Each work task contains
move line items that list the people and assets that are involved in the move.
When the space and move planner activates a work task, the work task is sent to
Maximo Asset Management where an approved work order is created that
includes the move line items from the originating work task.
In Maximo Asset Management, a work supervisor reviews the work order, assigns
the work to a field operative, and records the actual costs of the work on the work
order. As the work is carried out, status updates are transferred to the
corresponding work task in IBM TRIRIGA. When the work is completed, the costs
of the work are sent to IBM TRIRIGA and IBM TRIRIGA sends updates to the asset
and person records in Maximo Asset Management with details of the locations that
were changed.
When all of the work is complete, the space and move planner can complete the
project and analyze the results.
The following diagram shows the process and integration flow between Maximo
Asset Management and IBM TRIRIGA.
Maximo Asset Management

IBM TRIRIGA

Create space / move service
request*

Create move request
Move request

Schedule for completion

Approved work order

Approve, notify, assign
request class

Complete work

Apply service plan

Capture actual costs

Plan move

Change status to complete

Create project
with tasks

Create tasks

Activate task

Actual costs

Update asset, person

Status

Update task, update MLIs

Changed location

Complete service request

Complete project

* Optional
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Scenario: Creating and updating a planned work task
The Facilities Manager at Company ABC manages building maintenance and
management. As part of a condition assessment, third-party inspection teams
inspect the buildings and assets and identify deficiencies. For each deficiency, an
opportunity record is created in IBM TRIRIGA that includes the details of the
deficiency and an estimated repair cost.

Background
Company ABC uses Maximo Integrators for TRIRIGA to integrate the assessment
of facility conditions and the potential work that results from those inspections
between IBM TRIRIGA and Maximo Asset Management. Inspection teams assess
the condition of the business systems that are associated with a building, such as
the HVAC system and the roofing system. If deficiencies are identified when the
results of the condition assessment are entered in IBM TRIRIGA, opportunity
records are created.
Chris is a facilities manager for Company ABC who evaluates the condition
assessment reports and submits funding requests with associated opportunities in
IBM TRIRIGA. Chris reviews the opportunities and creates a planned work task
for each opportunity that is approved.
Val is a planner and scheduler who receives the approved work orders and
schedules the work for completion in Maximo Asset Management.
Alex is a roofing repair technician, and Pat is a hoist and crane operator. Alex and
Pat perform facilities-related work, update the status of the planned work order,
and capture the actual costs of the work in Maximo Asset Management.

Step 1. Create a planned work task
After the results of an inspection are recorded in IBM TRIRIGA, Chris receives
approval for a funding request for roof repairs to Building 123. Chris applies the
work plan that is associated with the funding request and creates a planned work
task. Chris selects the Integrate to Maximo check box so that the planned work
task is sent to Maximo Asset Management.
Chris activates the planned work task and the work task is sent to Maximo Asset
Management where a corresponding planned work order is created.

Step 2. Assign planned work orders to technicians
In Maximo Asset Management, Val receives the planned work order. Val uses the
Work Order Tracking application to plan the activities and tasks that are required
to complete the planned work order.
In the Assignment Manager application, Val assigns the work to technicians who
have the required skills to perform the work.

Step 3. Perform the work
In Maximo Asset Management, Alex and Pat receive the planned work order.
While they perform their assigned work, they update the status of the work order
in the Work Order Tracking application. They also record the time that they spend
on the work and the details of the materials that they use.
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Step 4: Complete the work
When Alex and Pat complete their work, they update the status of their tasks and
the status of the work order changes. The updated status for the work order is sent
to IBM TRIRIGA, and the corresponding planned work task is updated. IBM
TRIRIGA updates the status of the originating funding request and the associated
opportunities.

Architecture and components
IBM Maximo Integrators for TRIRIGA installs predefined components that use the
standard integration architecture of IBM Maximo Asset Management and IBM
TRIRIGA.
Maximo Integrators for TRIRIGA requires that the following products are installed
and tested:
v Maximo Asset Management version 7.5.0.4
v TRIRIGA Application Platform version 3.3.1
v At least one of the following application products: IBM TRIRIGA Facilities
Manager version 10.3, IBM TRIRIGA Workplace Operations Manager version
10.3, IBM TRIRIGA Capital Projects Manager version 10.3
Maximo Integrators for TRIRIGA includes a package of components for each
system.

Maximo Asset Management integration package
The Maximo Asset Management integration package is a compressed file that
includes predefined integration components, including object structures, publish
channels, enterprise services, and integration controls. The Maximo integration
framework uses these components to process inbound and outbound integration
messages.
The PLUSYEXTSYS external system is preconfigured to support inbound and
outbound communication between Maximo Asset Management and IBM TRIRIGA.
After you install the integration package, you can open it in the External Systems
application and see the predefined processing components that are provided,
including publish channels and enterprise services.
Enterprise services use a combination of processing rules, integration controls, and
Java classes to process inbound messages from IBM TRIRIGA. A separate
enterprise service is provided for each inbound interface. You can view the
supported enterprise services in the External Systems application. You configure
enterprise services in the Enterprise Services application and you can create
enterprise services if you want to support additional inbound interfaces.
Publish channels use a combination of processing rules, integration controls, and
Java classes to process outbound messages from Maximo Asset Management to
IBM TRIRIGA. A separate publish channel is provided for each outbound interface.
You can view the supported publish channels in the External Systems application.
You configure publish channels in the Publish Channels application and you can
create publish channels if you want to support additional outbound interfaces.
Processing rules are configured on the predefined enterprise services and publish
channels that control processing behavior. Some rules use integration controls to
Chapter 1. Product overview
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provide substitute values for particular fields. Cross-reference integration controls,
for example, are used to map status values in Maximo Asset Management to their
corresponding status values in IBM TRIRIGA. To add or change substitute values
for a field, you can add or change integration controls. To change the processing
behavior, you can replace a default processing rule with a new rule. To replace a
rule, you must disable the current rule and add the new rule. Rules are evaluated
in a specific order. Sometimes, data is set in one rule and then used by a
subsequent rule. To minimize issues, ensure that all new rules observe the existing
processing order.
Each enterprise service and publish channel is associated with an object structure
that specifies the format and structure of the data for the interface. A separate
object structure is provided for each outbound and inbound interface.
Publish channels are associated with endpoints that specify the destination and
transport protocol for outbound messages. Two endpoints are installed and you
configure these endpoints in the End Points application.

IBM TRIRIGA object migration package
The object migration package is a compressed file that contains the components that
are required for Maximo Integrators for TRIRIGA. The package installs integration
objects, workflows, staging tables, forms, and other components.
You can use the DataConnect feature in IBM TRIRIGA for the initial load of
portfolio data for assets, persons, and locations from Maximo Asset Management
to IBM TRIRIGA. The Has staging table check box indicates whether IBM
TRIRIGA maintains a staging table for the business object. If the check box is
selected and the business object is published, a staging table is either created or
updated. If the check box is not selected and the business object is published, the
publish process deletes any existing staging table. By default, the check box is not
selected.
IBM TRIRIGA Connector for Business Applications includes an IBM TRIRIGA web
service that receives messages from a Maximo Asset Management publish channel
for ongoing updates to the integrated portfolio and transactional data.
IBM TRIRIGA also provides workflow processes and integration objects that are
used to apply integration business rules, data mapping, and data transformation.
The workflow processes and integration objects call the Maximo Asset
Management integration servlet for all transaction processing from IBM TRIRIGA
to Maximo Asset Management. The object migration package installs tools that
enable you to perform batch loads of location, asset, and people records from IBM
TRIRIGA to Maximo Asset Management.
In IBM TRIRIGA, you must configure a user as a member of the trimax security
group to manage integration records. Members of the trimax security group can
create and modify integration-related records that are sent to Maximo Asset
Management and can ensure that integration records that are sent from Maximo
Asset Management are correctly populated in IBM TRIRIGA records.
The components that are provided with the product support standard integration
scenarios. You can also use these components as templates if you want to create
custom components to implement custom scenarios.
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Related information:
Integrating data with external applications
Integration components
Integration data processing
Application Building for the IBM TRIRIGA Application Platform 3: Data
Management
IBM TRIRIGA Connector for Business Applications 3 Technical Specification

Data integration
To implement the predefined integration scenarios, you must decide how to
manage the ownership and maintenance of portfolio data between the products.
Portfolio data consists of location, asset, and person data. After you integrate
portfolio data, transactional data is sent between both products. Transactional data
consists of service requests, work orders, work order costs, and location updates
for asset and person records.
The process and integration flow of transactional data between IBM TRIRIGA and
Maximo Asset Management is dependent on the synchronization of portfolio data,
which includes location, asset, and person data.

Portfolio data integration
Maximo Integrators for TRIRIGA is designed for use primarily by existing Maximo
Asset Management customers with a new installation of IBM TRIRIGA. The ability
to load seed data for locations, assets, and people from existing records in Maximo
Asset Management to the new IBM TRIRIGA environment speeds the deployment
process. Integrated portfolio data supports the integration of space and move
management and opportunities management business processes.
When you batch export location, asset, and person records from Maximo Asset
Management to IBM TRIRIGA, the TRIRIGA ID fields in these records is set to
PENDING. You cannot update records that have the status of pending. When an
exported record is received in IBM TRIRIGA, IBM TRIRIGA sends an update for
the record to Maximo Asset Management that contains the TRIRIGA ID value.
After the updated values are received in Maximo Asset Management, you can
update the records.
For the initial load of data, you can select existing locations in Maximo Asset
Management to send to IBM TRIRIGA. After the initial load of location data, you
can create and update integrated locations and manage the location hierarchy only
in IBM TRIRIGA. After the initial load, if you send an IBM TRIRIGA location to
Maximo Asset Management, you can update this location in Maximo Asset
Management, but any changes you make are not integrated to IBM TRIRIGA. The
integration of location data supports a limited set of location fields, but you can
configure more fields for inclusion in the integration.
You can maintain asset data within either Maximo Asset Management or IBM
TRIRIGA. For example, you can maintain all your enterprise and facility assets in
Maximo Asset Management and integrate only the assets whose physical
movements you want to manage in IBM TRIRIGA. A move process in IBM
TRIRIGA can move assets that exist in both IBM TRIRIGA and Maximo Asset
Chapter 1. Product overview
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Management or assets that exist only in IBM TRIRIGA. Selected IBM TRIRIGA
asset types are supported by default for integration, but you can configure any
asset type for inclusion in the integration.
You can implement processes to control where asset creation and updates are
completed for those asset types that are configured for integration. Depending on
the asset type, you might complete updates to the same asset in both products. The
integration of asset data supports a limited set of asset fields, but you can
configure more fields for inclusion in the integration.
You can maintain person data within either product. You can maintain all person
data in Maximo Asset Management and integrate only the data of people who are
involved in moves that you plan to manage in IBM TRIRIGA. A move process in
IBM TRIRIGA can move person data that exists in both products or person data
that exists only in IBM TRIRIGA. Selected IBM TRIRIGA person types are
supported for integration, but you can configure more person types for inclusion in
the integration.
You can implement processes to control where person data is created and updated
for the person types that are configured for the integration. If your person data is
integrated with an external application, such as an HR system, you might need to
consider how the external integration affects integration between Maximo Asset
Management and IBM TRIRIGA. Depending on the person type, you might update
the same person in both systems. The integration of person data supports a limited
set of fields, but you can configure more fields for inclusion in the integration.
Most implementations export data from Maximo Asset Management to provide
seed data for a new IBM TRIRIGA installation, Maximo Integrators for TRIRIGA
includes applications that you can use to perform batch exports of portfolio data
from IBM TRIRIGA to Maximo Asset Management.

Transactional data integration
The IBM TRIRIGA work task is the primary transactional integration point for
transferring transactions between Maximo Asset Management and IBM TRIRIGA.
An IBM TRIRIGA project is a logical grouping of work tasks. An IBM TRIRIGA
work task is the equivalent of a Maximo Asset Management work order. After you
mark an IBM TRIRIGA work task for integration and activate the work task, the
data is sent to Maximo Asset Management to create the approved work order.
You can also create work tasks inside an IBM TRIRIGA capital project record. After
you save a capital project record that contains integrated work tasks, the IBM
TRIRIGA project ID and project name fields are sent to Maximo Asset
Management. You are not required to activate a work task in a capital project
record to have the project ID and project name information sent to Maximo Asset
Management.
Transactional data also includes service requests, work order costs, and location
updates for asset and person records. These transactions reference the integrated
assets, locations, and person records. As work is undertaken to complete tasks on
integrated work orders, costs are accumulated on the work order and sent back to
the IBM TRIRIGA work task.
The following data is transferred and synchronized between Maximo Asset
Management and IBM TRIRIGA.
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Maximo Asset Management data

IBM TRIRIGA data

Service requests

Work requests

Work orders

Work tasks

Work order costs

External cost items

Asset and person

Location changes

Integration processing
Integration between Maximo Asset Management and IBM TRIRIGA uses staging
tables, web services, and enterprise services.
The initial load of portfolio data from Maximo Asset Management to IBM
TRIRIGA uses the IBM TRIRIGA DataConnect staging tables. All ongoing
integration from Maximo Asset Management to IBM TRIRIGA uses the IBM
TRIRIGA web service. All integration from IBM TRIRIGA to Maximo Asset
Management uses enterprise services that are called by IBM TRIRIGA by using the
Maximo Asset Management integration servlet.
As part of the integration processing, the key fields of a record in one system are
saved to the corresponding record in the other system. This enables the integration
processing and also makes visible the key for the record of the other system. In
most cases, the key fields in both systems match, but they can be different in some
circumstances. For example, the Maximo Asset Management Asset application
shows the asset ID of the corresponding IBM TRIRIGA asset. The IBM TRIRIGA
asset form shows the Maximo Asset Management asset key, which is the
combination of the asset number and site id, displayed as assetnumber~siteid.
In the Maximo Asset Management applications for locations, assets, persons, work
orders, and service requests, you cannot delete or duplicate records that are
integrated between Maximo Asset Management and IBM TRIRIGA. Instead of
deleting a record, you can change the status of the record.

Data exchange between Maximo Asset Management and IBM
TRIRIGA
The following diagram shows how data is exchanged between Maximo Asset
Management and IBM TRIRIGA.

Chapter 1. Product overview
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Maximo Asset Management

IBM TRIRIGA

Portfolio

Portfolio

Locations

Locations

Assets

Assets

People

People

Transactional

Transactional

Service request

Work request

Work order

Work task

The integration of portfolio data supports the initial data load and the ongoing
updates to the data. The portfolio data exchange is bidirectional.
The integration of transactional data supports the creation and ongoing updates of
the data. The data exchange between the systems is either one-way or
bidirectional, depending on the data. The transactional data includes the
integration of Maximo Asset Management service requests and IBM TRIRIGA work
requests, IBM TRIRIGA work tasks and Maximo Asset Management work orders,
and the update of Maximo Asset Management asset and person locations
Related information:
IBM TRIRIGA 10 Connector User Guide
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Chapter 2. Planning your implementation
You can implement Maximo Integrators for TRIRIGA by using data that is already
implemented in one system and loading that data to provide seed data for the
second system. After seed data is loaded, users can work together on facility
moves and condition assessments. You can load seed data from Maximo Asset
Management to IBM TRIRIGA, or you can load seed data from IBM TRIRIGA to
Maximo Asset Management. If your environment is integrated with another
system, such as a financial system or a human resources system, you might have
to do more planning and configuration.

Sequence of data integration
The integration requires the loading of multiple sets of data between Maximo
Asset Management and IBM TRIRIGA. To comply with data dependencies, you
load initial data in a specific order. After initial data loads are complete, you
perform additional configurations to support transactional data integration.
Space planning integration requires that you share location, asset, person, work
order, and service request data between Maximo Asset Management and IBM
TRIRIGA. To apply the integration to existing Maximo Asset Management records,
you perform initial data loads. After you complete these initial data loads, you
configure these interfaces to support ongoing data updates. The work order and
service request interfaces do not require initial data loads and the only
configuration required is to enable the creation of records and communication of
updates until the work is complete.
You start by integrating location data because other interfaces are dependent on
the existence of this data. You can configure existing Maximo Asset Management
locations to integrate to IBM TRIRIGA for use in space planning. For integrated
space planning, location records are arranged in a hierarchy of five levels: property,
building, floor, space, and subspace. You perform a separate load for the records in
each level of the hierarchy, starting at the top level of the hierarchy and exporting
batches of locations sequentially down to lower levels of the hierarchy. You load
Maximo Asset Management property level records at the top of the hierarchy first.
You must wait for a responding load of these records back from IBM TRIRIGA
before you load the locations for the next level in the location hierarchy. To verify
that a location record has been updated by IBM TRIRIGA, check that the record
includes a value in the Tririga ID field and that the location exists in the
PLUSYSYS location hierarchy system. After each export, always wait for the
responding load that returns the updated locations back to Maximo Asset
Management. After you load and verify the receipt of updates for the records in
each level of the hierarchy, you configure components to enable the ongoing
creation and update of location records.
After location data is loaded to IBM TRIRIGA, you can load data for the assets and
people that are associated with those locations. After the initial data is loaded, you
configure components to enable the creation and update of asset and person
records.
When the location, asset, and person interfaces are integrated, you can configure
work order integration. The integration enables you to create a space planning task
© Copyright IBM Corp. 2013
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in IBM TRIRIGA and to send it to Maximo Asset Management where a
corresponding work order is created to execute the work.
Finally, you configure the service request interface if you plan to accept space
planning service requests in Maximo Asset Management. When you integrate
service requests, you can create a space planning service request in Maximo Asset
Management and send it to IBM TRIRIGA. The move is then planned in IBM
TRIRIGA before sending the task to Maximo Asset Management where the work is
carried out.

Scenarios for integrating portfolio data
Before you can integrate transactions between Maximo Asset Management and
IBM TRIRIGA, you prepare the data formats, configure communication between
the systems, and load seed data for integrated locations, assets, and people.
Even if you do not intend to implement transactional integration, integrated
portfolio data can provide Maximo Asset Management with insight into current
space utilization that is available in IBM TRIRIGA.

Scenario: Preparing Maximo Asset Management and IBM
TRIRIGA for integration
Company ABC uses Maximo Asset Management to manage the assets in the
enterprise. The company plans to deploy Maximo Integrators for TRIRIGA and
IBM TRIRIGA to support integrated workplace management for the facilities
management team. Maximo Integrators for TRIRIGA installs components that must
be configured on both systems to support data integration.

Background
Integrated facilities management requires the integration of two types of data:
portfolio data and transactional data. Lee is a system administrator who configures
Maximo Asset Management to send batches of portfolio data to IBM TRIRIGA
DataConnect staging tables and to send transaction data to an IBM TRIRIGA web
service. Mario is a system administrator who configures integration objects in IBM
TRIRIGA to send responses to Maximo Asset Management when seed data is
batch-loaded and to send ongoing transaction messages from IBM TRIRIGA to
Maximo Asset Management.

Step 1. Configure communications from Maximo Asset
Management to IBM TRIRIGA
In Maximo Asset Management, in the End Points application, Lee configures the
PLUSYDC endpoint to point to the IBM TRIRIGA database. This endpoint is used
for the initial data loads, which exports batches of data to IBM TRIRIGA
DataConnect staging tables. Lee also configures the PLUSYBC endpoint to point to
the URL for the IBM TRIRIGA web service. This communication is used after the
initial data loads to send integrated transaction messages, such as service requests
or work order status updates.
In the External Systems application, Lee checks that all of the necessary publish
channels and enterprise services are enabled for the PLUSYEXTSYS external
system. Lee then enables the external system.
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Step 2. Configure data formats
The length of the data fields in Maximo Asset Management must be large enough
to support the length of the corresponding fields in IBM TRIRIGA. Lee reviews the
data mappings and compares the lengths of corresponding fields. In Maximo Asset
Management, in the Database Configuration application, Lee changes the length of
fields as necessary and then updates the database.

Step 3. Configure data processing
Some processing rules that are configured on publish channels and enterprise
services in Maximo Asset Management use integration controls to set values in
integrated fields. Processing rules are also used to apply filtering conditions on
integration messages. Many of these values are based on the values that are set in
associated domains.
In Maximo Asset Management, in the Domains application, Lee checks the values
that are set for the domains that are associated with processing rules. In the
External Systems application, Lee modifies the values that are associated with
integration controls to match the values that are configured for the associated
domains.

Step 4. Configure communications from IBM TRIRIGA to Maximo
Asset Management
Mario verifies that all of the required DataConnect staging tables were installed by
Maximo Integrators for TRIRIGA. In IBM TRIRIGA, in the Integration Objects
application, Mario configures each HTTP Post - Maximo Integration object to point
to the URL for its corresponding enterprise service on Maximo Asset Management.

Scenario: Loading initial data from Maximo Asset Management
to IBM TRIRIGA
Company ABC uses Maximo Asset Management to manage assets. The company
plans to deploy Maximo Integrators for TRIRIGA and IBM TRIRIGA to support
integrated workplace management for the facilities management team. The
implementation team exports data from Maximo Asset Management to provide
seed data for the new IBM TRIRIGA environment.

Background
Integrated facilities management requires the integration of data for the locations,
assets, and people that are managed in the facility. iIn IBM TRIRIGA, this data is
known as portfolio data. Because Maximo Asset Management is already
operational in company ABC, the implementation team can use location, person,
and asset data from Maximo Asset Management for the initial population of data
in IBM TRIRIGA. After this seed data is integrated, the implementation team can
integrate transactions, such as sending service requests from Maximo Asset
Management to IBM TRIRIGA, and sending work tasks from IBM TRIRIGA to
Maximo Asset Management.
Lee is a system administrator who is responsible for preparing and sending seed
data from Maximo Asset Management to IBM TRIRIGA.
Mario is a system administrator who is responsible for receiving the seed data in
IBM TRIRIGA, modifying imported location records if necessary, and activating
Chapter 2. Planning your implementation
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imported records to send responses to Maximo Asset Management.

Step 1. Configure location records to match the IBM TRIRIGA
location hierarchy
The integration uses an IBM TRIRIGA location hierarchy that is based on five
levels: property, building, floor, space, and subspace. Lee begins by deciding which
sites to integrate.
In the Site tab of the Organizations application on Maximo Asset Management,
Lee enables a site for integration with IBM TRIRIGA. In the Location Drill Down
window, Lee browses the locations that exist in the same location system. Lee
assigns the appropriate IBM TRIRIGA location hierarchy level to each location in
the site that is intended for integration, including buildings, floors, and spaces. Lee
does not configure locations at the subspace level because Mario will use the
visualization features of IBM TRIRIGA CAD Integrator/Publisher to allocate
locations into spaces and subspaces.
Lee repeats this procedure for each site that is intended for integration.

Step 2. Load locations from Maximo Asset Management to IBM
TRIRIGA
When all the locations for integration are assigned to the appropriate IBM
TRIRIGA location hierarchy, Lee coordinates with Mario to export the data to IBM
TRIRIGA. In Maximo Asset Management, in the External Systems application, in
the Publish Channels tab, Lee selects the PLUSYPROP publish channel and clicks
Data Export. Lee restricts the export to just one site.
In IBM TRIRIGA, in the Portfolio portal, in the Locations application, Mario
receives the property that Lee exported. Mario activates the record, which sends a
message to Maximo Asset Management that updates the hierarchy information for
the record in read-only format.
After the updated record is received by Maximo Asset Management, Lee exports
the buildings in this property by using the PLUSYBLDG publish channel.
In IBM TRIRIGA, Mario receives the buildings for the property and activates them
to send updates to Maximo Asset Management.
When all the buildings are updated in Maximo Asset Management with responses
from IBM TRIRIGA, Lee exports all the floors in the property by using the
PLUSYFLOOR publish channel. Each floor record identifies the parent building for
the floor.
In IBM TRIRIGA, Mario receives the floors and activates them to send updates to
Maximo Asset Management.
Finally, Lee exports space locations to IBM TRIRIGA by using the PLUSYSPACE
publish channel.
Mario receives the spaces in the property from Maximo Asset Management, and
uses IBM TRIRIGA CAD Integrator/Publisher to visualize the property, buildings,
floors, and spaces. Mario works with the facilities manager to rearrange spaces. In
some cases spaces are assigned as subspaces. When each space and subspace is
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arranged correctly, Mario activates the records to send updates to Maximo Asset
Management that includes any change in the location hierarchy.
Lee and Mario repeat these steps for each site that is intended for integration. After
all of the required locations are integrated, Mario manages these records in IBM
TRIRIGA and is responsible for all changes and additions to these locations. Lee
continues to manage locations in Maximo Asset Management that are not
integrated with IBM TRIRIGA.

Step 3. Load assets from Maximo Asset Management to IBM
TRIRIGA
Lee wants to integrate four types of asset: facilities, IT, furniture, and telephone
assets. In Maximo Asset Management, in the Domains application, Lee adds
furniture and telephone assets to the ASSETTYPE domain and updates the
database for the changes to take effect. The PLUSYTOASSETXREF and
PLUSYFRASSETXREF integration controls list the asset types that can be integrated
and, by default, the integration controls support facilities and IT asset types. In
Maximo Asset Management, in the External Systems application, Lee adds
furniture and telephone asset types to these integration controls.
In the Publish Channels application, Lee exports one asset type at a time. The
records are sent in batches by using the PLUSYASSET publish channel. The publish
channel uses a processing rule to limit the export to assets that are associated with
space and subspace locations that are integrated with IBM TRIRIGA.
In IBM TRIRIGA, Mario receives the assets from Maximo Asset Management.
When Mario activates the imported asset records, updates are sent to Maximo
Asset Management that include the IBM TRIRIGA identifiers for the assets.
When all of the seed data for assets is loaded, both Lee and Mario can create and
modify integrated assets.

Step 4. Load people from Maximo Asset Management to IBM
TRIRIGA
Lee plans to integrate all employees in the organization that contains the integrated
locations. Maximo Integrators for TRIRIGA supports three employee types:
employee, consultant, and external contact. The existing implementation for person
records in Maximo Asset Management supports more employee types, including
part-time, full-time, and contract employees.
In Maximo Asset Management, in the External Systems application, Lee configures
the PLUSYEMPTYPEXREF cross-reference integration control to associate both
part-time and full-time employees with the employee value in IBM TRIRIGA and
to associate contractors with the consultant value in IBM TRIRIGA.
Because people integration is bidirectional, Lee creates another cross-reference
integration control and associates this new integration control with the
PLUSYPERSON enterprise service. This new integration control ensures that
employees that are sent from IBM TRIRIGA to Maximo Asset Management are
mapped to the appropriate employee type in Maximo Asset Management.
The values in the PLUSYPERSONSTATUS list control must match the values in the
PERSONSTATUS domain. In the Domains application, Lee reviews these values
and, in the External Systems application, Lee updates the PLUSYPERSONSTATUS
Chapter 2. Planning your implementation
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list integration control with matching values. Lee then updates the
PLUSYPERSONSTATUSXREF cross-reference integration control to map the status
values in Maximo Asset Management with their equivalent status values in IBM
TRIRIGA.
In the External Systems application, Lee selects the PLUSYPERSON publish
channel and exports the person records for the organization. Mario receives these
records in IBM TRIRIGA and activates them to send updates to Maximo Asset
Management.
When all seed data for employees is loaded, Lee can create and modify integrated
person records in Maximo Asset Management, and Mario can create and modify
integrated people records in IBM TRIRIGA.

Scenario: Loading initial data from IBM TRIRIGA to Maximo
Asset Management
Company XYZ uses IBM TRIRIGA for integrated workplace management. The
company plans to deploy Maximo Integrators for TRIRIGA and Maximo Asset
Management to provide enhanced asset and work management capabilities for the
facilities management team. The implementation team loads initial portfolio data in
batches from IBM TRIRIGA to Maximo Asset Management to provide seed data for
the new Maximo Asset Management environment.

Background
Integrated facilities management requires the integration of data for the locations,
assets, and people that are managed in the facility. In IBM TRIRIGA, this data is
known as portfolio data. After the portfolio data is integrated, the implementation
team can integrate transactions, such as sending service requests from Maximo
Asset Management to IBM TRIRIGA, and sending work tasks from IBM TRIRIGA
to Maximo Asset Management.
Sam is a system administrator who is responsible for preparing and sending seed
data from IBM TRIRIGA to Maximo Asset Management.
Viv is a system administrator who is responsible for receiving the seed data in
Maximo Asset Management.

Step 1. Load locations from IBM TRIRIGA to Maximo Asset
Management
Maximo Integrators for TRIRIGA supports a location hierarchy that is based on
five levels: property, building, floor, space, and subspace. In IBM TRIRIGA, in the
Location application, Sam reviews how locations are arranged in the IBM TRIRIGA
location hierarchy and adjusts the hierarchy levels for locations if necessary.
In IBM TRIRIGA, in the Location Export to Maximo application, in the Properties
tab, Sam clicks Find to return a list of active properties. Sam selects a property to
export, clicks OK, and then clicks Export to Maximo.
When the property is received in Maximo Asset Management, a property record
and a corresponding site record are automatically created.
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A response is sent to IBM TRIRIGA that updates the property record in IBM
TRIRIGA with the Maximo ID value. When the response for the property record is
received in IBM TRIRIGA, Sam can send the buildings in the property.
With the integrated property selected, in the Buildings tab, Sam clicks Find to
return a list of active buildings. Sam selects the buildings to integrate, clicks OK,
and then clicks Export to Maximo.
For each building record that is received, Maximo Asset Management sends a
response that updates the record in IBM TRIRIGA.
Sam selects the integrated buildings and, in the Floors tab, Sam selects the floors to
export. Sam repeats the process of waiting for the responses that update the floor
records and then exports selected spaces in these floors. Sam finally exports
subspaces in selected integrated spaces.
Sam repeats this procedure for each property that is intended for integration with
Maximo Asset Management.

Step 2. Load assets from IBM TRIRIGA to Maximo Asset
Management
After the initial load of location data from IBM TRIRIGA to Maximo Asset
Management, Viv configures Maximo Asset Management to receive the assets that
are associated with those locations. Maximo Asset Management is configured to
exchange facility and IT assets with IBM TRIRIGA, but Sam also wants to integrate
furniture, office equipment, and telephone asset types.
In Maximo Asset Management, in the Domains application, Viv adds furniture,
office equipment, and telephones to the ASSETTYPE domain and updates the
database for these changes to take effect. In Maximo Asset Management, in the
External Systems application, Viv configures the PLUSYASSETTOXREF and
PLUSYASSETFRXREF integration controls to include all five supported asset types.
In IBM TRIRIGA, in the Asset Export to Maximo application, Sam selects the
Building Equipment tab, and clicks Find to return a list of active facility assets.
Sam selects the assets to integrate and clicks Export to Maximo.
When an asset record is created in Maximo Asset Management, a response is sent
that updates the record in to IBM TRIRIGA.
Sam repeats this procedure for the other four asset types that are intended for
integration.
After the initial load of assets, both Viv and Sam can create and modify these
records.

Step 3. Load people from IBM TRIRIGA to Maximo Asset
Management.
Maximo Integrators for TRIRIGA supports the integration of employee, consultant,
and external contact employee types, and Sam plans to integrate all three
employee types.

Chapter 2. Planning your implementation
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In IBM TRIRIGA, in the People Export to Maximo application, Sam selects a
person type and clicks Find to return a list of active records for the person type.
Sam selects the people records to integrate and clicks Export to Maximo.
When a people record is received in Maximo Asset Management, a corresponding
person record is created, and a response is sent that updates the record in IBM
TRIRIGA.
Sam repeats this procedure for the other two person types that are intended for
integration.
After the initial load of people, both Viv and Sam can create and modify these
records.

Implementation in an environment that supports other integrations
If your environment is integrated with other products, such as HR systems, some
of the changes that are required to implement Maximo Integrators for TRIRIGA
might affect the other integrations.

STOP rule for the PERSON object
A STOP processing rule for the PERSON object prevents the update of the location
for an existing person record when the data is maintained in IBM TRIRIGA. When
a person’s location is managed by IBM TRIRIGA, the location in the person record
should only change after the completion of an IBM TRIRIGA move request. If the
integrated system sends updates for the location data for the person object, the
STOP rule prevents the update of the location data in Maximo Asset Management.
Review your processes for the management of person data and determine whether
changes are required in the integrations.

mxe.int.keyresponse system property
The mxe.int.keyresponse system property provides response content for all
synchronous inbound integration messages for all operations. Maximo Integrators
for TRIRIGA relies on this capability to synchronize the ID values in Maximo Asset
Management when a message from IBM TRIRIGA creates a record in Maximo
Asset Management.
The implementation of Maximo Integrators for TRIRIGA sets the
mxe.int.keyresponse system property to a value of 1, which is true. As a result, all
synchronous inbound integration messages to Maximo Asset Management provide
response content to the invoker of the service. If your current integration calls
enterprise or object structure services in a synchronous manner, verify whether the
1 value affects the integration with other systems. The value of the
mxe.int.keyresponse system property applies to the sync, change, and delete
operations. The query and sync operations currently support response content for
synchronous transactions.

Additional information for your implementation
Several guides and topics in the information center can assist you in planning and
implementing your integration.
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The IBM TRIRIGA 10 Portfolio Management User Guide contains the following
relevant information about portfolio data:
Chapter

Sections for implementing the integration

Chapter 5, Locations

The following sections contain relevant
information:
v Hierarchy/Relationships
v Locations

Chapter 6, People

The following sections contain relevant
information:
v People Forms
v People

Chapter 7, Assets

The following sections contain relevant
information:
v Asset Forms
v Assets

The IBM TRIRIGA 10 Space and Move Management User Guide provides the
following relevant information about the move process:
Chapter

Sections for implementing the integration

Chapter 2, Move Management

The following sections contain relevant
information:
v Move Management Process
v Move Service Request Process
v Move Request Line Item
v Move Planning Process

The IBM TRIRIGA 10 Facility Assessment User Guide provides the following
relevant information about the condition inspection process:
Chapter

Sections for implementing the integration

Chapter 1, Facility Assessment

The following sections contain relevant
information:
v Facility Assessment Process
v Facility Condition Index (FCI) and System
Condition Index (CI)

Chapter 2, Planning

The following sections contain relevant
information:
v Condition-Related Classifications
v Condition-Related Classification Records

Chapter 3, Assessing

The following sections contain relevant
information:
v Opportunities
v Inspection Request Process

The Application Building for the IBM TRIRIGA Application Platform 3: Data
Management guide provides the following relevant information about IBM
TRIRIGA DataConnect:
Chapter 2. Planning your implementation
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Chapter

Sections for implementing the integration

Chapter 2, DataConnect

The following sections contain relevant
information:
v Process Overview
v Create and Maintain Business Object
Staging Tables
v Moving Data from the External Source
v Use Workflow to Move Data
v DataConnect Tips

The IBM TRIRIGA Connector for Business Applications 3 Technical Specification
provides the following relevant information about the web service:
Chapter

Sections for implementing the integration

Chapter 1, Architecture

The following sections contain relevant
information:
v Diagram
v WSDL Location
v Getting Started
v CustomBusinessConnectTask for
Integrations

The IBM TRIRIGA 10 Connector User Guide provides the following relevant
information about the IBM TRIRIGA integration object:
Chapter

Sections for implementing the integration

Chapter 3, TRIRIGA Integration Object

The following sections contain relevant
information:
v Database Scheme
v File to DC Sceme
v Http Post Scheme
v Outbound Formats
v Other Ways to Trigger Integration

The Integrating data with external applications section in the information center
provides the following relevant information about the Maximo Asset Management
integration framework:
v Integration components
v Integration data processing
v Configuring the integration framework
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Chapter 3. Installing IBM Maximo Integrators for TRIRIGA
The installation of IBM Maximo Integrators for TRIRIGA involves installing two
sets of components. You install one set of components on IBM Maximo Asset
Management to support integration with IBM TRIRIGA. Next, you install a set of
components on IBM TRIRIGA to support the integration.

Installation prerequisites
Before you install IBM Maximo Integrators for TRIRIGA, you must ensure that the
software and security requirements are available in the installation environments
for Maximo Asset Management and IBM TRIRIGA.

Software prerequisites
You install IBM Maximo Integrators for TRIRIGA on the same administrative
workstation where Maximo Asset Management version 7.5.0.4 is installed. You can
download Maximo Asset Management version 7.5.0.4 from IBM Passport
Advantage® (www-01.ibm.com/software/howtobuy/passportadvantage/
pao_customers.htm).
To install IBM Maximo Integrators for TRIRIGA on IBM TRIRIGA, you must
complete the following actions:
1. Contact customer support to request access to the installers for IBM TRIRIGA
Application Platform version 3.3 and version 10.3 of the following products and
licenses:
v IBM TRIRIGA Facilities Manager
v IBM TRIRIGA Facility Assessment
v IBM TRIRIGA Portfolio Data Manager
v IBM TRIRIGA Connector for Business Applications
2. Install IBM TRIRIGA Application Platform version 3.3 and the IBM TRIRIGA
version 10.3 products.
Installation instructions are provided in
Installing IBM TRIRIGA Application Platform
(pic.dhe.ibm.com/infocenter/tivihelp/v49r1/index.jsp?topic=
%2Fcom.ibm.tap.doc_3.3%2Fcommon%2Ft_ctr_install_tap.html)
and in Installing IBM TRIRIGA
(pic.dhe.ibm.com/infocenter/tivihelp/v49r1/index.jsp?topic=
%2Fcom.ibm.tri.doc_10.3%2Fcommon%2Fc_ctr_install_tri.html).
3. Download IBM TRIRIGA Application Platform version 3.3.1 from IBM Passport
Advantage® (www-01.ibm.com/software/howtobuy/passportadvantage/
pao_customers.htm).
4. Upgrade from IBM TRIRIGA Application Platform version 3.3 to IBM TRIRIGA
Application Platform version 3.3.1.
Upgrade instructions are provided in the IBM TRIRIGA Release Notes®
(www.ibm.com/developerworks/community/wikis/home?lang=en#/wiki/
IBM+TRIRIGA1/page/Release+Notes).
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Security requirements
The following table shows the user permissions that are required to configure data
integration between Maximo Asset Management version 7.5.0.4 and IBM TRIRIGA
version 10.3.
Table 1.
Activity

Permission

Install, configure, and maintain IBM Maximo Administrator rights on Maximo Asset
Integrators for TRIRIGA on Maximo Asset
Management and on IBM TRIRIGA
Management and on IBM TRIRIGA.
Perform initial load of portfolio data
between Maximo Asset Management and
IBM TRIRIGA.

Administrator rights on Maximo Asset
Management and on IBM TRIRIGA

On IBM TRIRIGA, send and receive
transactional data to and from Maximo
Asset Management.

IBM TRIRIGA users must be members of the
Space Planner, Space Manager, and trimax
security groups. The trimax security group is
installed when you install the object
migration package on IBM TRIRIGA.

Upgrade restrictions
IBM Maximo Integrators for TRIRIGA version 1.2 replaces IBM Maximo Integrators
for TRIRIGA versions 1.1 and 1.1.1 and there is no upgrade path.

Installing on Maximo Asset Management
You download the Maximo Integrators for TRIRIGA package and install the
package on a computer that has Maximo Asset Management version 7.5.0.4
installed.

Procedure
1. From the ISM library, search for the Maximo Integrators for TRIRIGA package
and download the package. (www.ibm.com/software/brandcatalog/
ismlibrary/) Do not extract the compressed file for IBM TRIRIGA. The
compressed file for IBM TRIRIGA must remain compressed for installation.
2. Shut down the application server.
3. Create backup copies of the existing install_home directory files and back up the
database. The database administrator must complete this task.
4. Extract the files in the IBM_Maximo_Integrators_for_TRIRIGA_V1.2-MX.zip file to
the install_home directory and select the options to overwrite existing files and
use folder names.
5. Run the database scripts for the package, by using the updatedb.bat utility.
a. Open a command prompt window and run the following command:
cd\install_home\tools\maximo
b. From the install_home\tools\maximo directory, run the updatedb.bat utility.
6. Delete the application server cache. The location of the cache files depends on
the version of application server that you are running, for example:
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Application server

Location of cache files

Oracle WebLogic Server

weblogic_home\user_projects\domains\
mydomain\MAXIMOSERVER\

Application server

Location of cache files

®

IBM WebSphere Application Server

websphere_home\AppServer\profiles\
Custom01\temp\machinenameNode01\
MAXIMOSERVER

7. Delete the web browser cache on every computer that uses the product.
8. Rebuild and redeploy the EAR files.
9. Restart the application server.

Results
In the System Information dialog box, the Version field contains information for
IBM Maximo Integrators for TRIRIGA version 1.2.
Related information:
Troubleshooting and support

Installing on IBM TRIRIGA
The IBM_Maximo_Integrators_for_TRIRIGA_V1.2-TRI.zip file includes an object
migration package and a patch helper file. After you extract the compressed file,
you import the object migration package and then import the patch helper into
your IBM TRIRIGA environment.

Installing the object migration package on IBM TRIRIGA
The object migration package is a compressed file that contains the data that is
required for IBM Maximo Integrators for TRIRIGA. The package includes
workflows, objects, staging tables, forms, and other components.

Procedure
In the IBM TRIRIGA Administrator Console, enable the Object Migration agent.
Log in to IBM TRIRIGA and select Tools > Administration > Object Migration.
From the action bar, click New Import.
In the File field, navigate to the IBM_Maximo_Integrators_for_TRIRIGA_V1.2OM.zip file, select the file, and click OK.
5. In the Object Migration window, select the Validate action.
6. In the Objects panel, click Wait to stop the migration process so that the
validation process can run.
7. After the validation is complete, click Import on the action bar.
1.
2.
3.
4.

8. In the IBM TRIRIGA Administrator Console, disable the Object Migration
agent.

What to do next
Import the patch helper that you extracted from the
IBM_Maximo_Integrators_for_TRIRIGA_V1.2-TRI.zip file.

Importing the patch helper to IBM TRIRIGA
To complete the installation of IBM Maximo Integrators for TRIRIGA, you must
import the patch helper into your IBM TRIRIGA environment. The patch helper
triggers workflows that create essential information and update existing records
within the database.
Chapter 3. Installing IBM Maximo Integrators for TRIRIGA

23

Before you begin
Import the object migration package into your IBM TRIRIGA environment before
you import the patch helper.

Procedure
1. On IBM TRIRIGA, select Tools > Administration > Data Integrator.
2. Select the upload file options as follows:
Table 2. Patch helper file upload values
IBM TRIRIGA Field

Option

Module

triHelper

Business Object

triPatchHelper

Form

triPatchHelper

Import Type

Add

Action

triCalculate

3. Browse to and select the
PatchHelper_IBM_Maximo_Integrators_for_TRIRIGA.txt file that you extracted
from the IBM_Maximo_Integrators_for_TRIRIGA_V1.2-TRI.zip file.
4. Upload the patch helper. You receive a notification in your Reminders portal
section when the import process is complete.
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Chapter 4. Configuring integration components
After you install IBM Maximo Integrators for TRIRIGA, you must configure the
integration components on Maximo Asset Management and IBM TRIRIGA. The
configuration tasks require knowledge of the application implementations on
Maximo Asset Management and IBM TRIRIGA.

Configuring Maximo Asset Management
To prepare for the integration, you configure the endpoints that route messages to
IBM TRIRIGA and configure values in integration controls.

Before you begin
Configure Maximo Asset Management for integration, including configuring Java™
Message Service (JMS) queues and enabling the integration framework.
Related tasks:
Enabling data export and import
Configuring the integration framework

Changing lengths of fields in Maximo Asset Management to
match IBM TRIRIGA
When you implement your integration, you might have to change the lengths of
fields in Maximo Asset Management to accommodate the longer field lengths in
IBM TRIRIGA. If the length of a field in Maximo Asset Management is less than
the length of the corresponding field in IBM TRIRIGA, increase the length of the
field in Maximo Asset Management.

Procedure
1. In Maximo Asset Management, in the Database Configuration application, open
the object. In the Attribute tab, find the field whose length you want to change.
2. For each field that requires adjustment, change the length and save the object.
The following table lists lengths for some of the fields that are shared in the
integration. You might have to change other fields in addition to these fields.
Table 3. Integrated field lengths
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Object

Field

Length of field in Maximo
Asset Management

SITE

SITEID

50

SITE

DESCRIPTION

700

LOCATIONS

LOCATION

50

LOCATIONS

DESCRIPTION

700

ASSET

ASSETNUM

50

ASSET

DESCRIPTION

700

PERSON

PERSONID

50

WORKORDER

DESCRIPTION

700
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3. Update the database to implement the changes.
Related information:
Modes of database configuration
Configuring the database in administration mode
Configuring the database in command-line mode

Configuring endpoints
Two endpoints route outbound messages to IBM TRIRIGA. One endpoint loads
data to IBM TRIRIGA DataConnect staging tables and the other endpoint routes
messages to the IBM TRIRIGA web service. To enable the integration, you
configure the destination URLs and security information for the endpoints.

About this task
The PLUSYDC endpoint routes location, asset, and person data to IBM TRIRIGA
DataConnect staging tables. The PLUSYBC endpoint routes messages to the IBM
TRIRIGA web service.

Procedure
1. In the End Points application, open the PLUSYDC endpoint record to specify
values in the Properties section.
2. In the Driver field, specify the driver for the IBM TRIRIGA database.
Option

Description

Oracle Database

oracle.jdbc.OracleDriver

Microsoft SQL Server database

com.microsoft.sqlserver.jdbc.
SQLServerDriver

3. In the ISREMOTE field, verify that the value is set to 1 (true).
4. In the URL field, specify the URL for IBM TRIRIGA DataConnect.
Option

Description

Oracle Database

jdbc:oracle:thin:@<HOST>:<PORT>:<SID>

Microsoft SQL Server database

jdbc:sqlserver://hostname:port;
databaseName=dbname
;integratedSecurity=false;

5. In the Username and Password fields, specify values that are configured with
security access to IBM TRIRIGA DataConnect.
6. If IBM TRIRIGA is configured in a multi-schema Oracle Database
environment, specify the name of the schema to use.
7. Save the endpoint.
8. Open the PLUSYBC endpoint.
9. In the ENDPOINTURL field, specify the URL for the IBM TRIRIGA web
service, for example http://server_address:port/ws/TririgaWS/context_path.
The context_path value is an optional value that can be configured in IBM
TRIRIGA. If a value is set for the context_path attribute in IBM TRIRIGA, you
must specify the same value at the end of URL. To check if a value is
configured for the context path, in the IBM TRIRIGA administrator console,
select System Manager.
10. In the SERVICENAME field, verify that TririgaWS is the specified value.
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11. In the Username and Password fields, specify values that are configured with
security access to the IBM TRIRIGA web service.
12. Save the endpoint.

Configuring integration controls
Some processing rules that are set on publish channels and enterprise services use
integration controls to provide values in integration messages. For some of these
integration controls, you must configure the values to match the values in the
Maximo Asset Management implementation environment. You can view all of the
integration controls in the External Systems application.
Related reference:
Chapter 7, “Reference information,” on page 67

Configuring integration controls to match domain values
The values in many integration controls are validated against values that are
configured for associated domains. Before implementation, check that the values in
integration controls match the values in corresponding domains and, if necessary,
change the values in the integration control.

Procedure
1. In the External Systems application, open the PLUSYEXTSYS external system.
2. Select Select Action > Setup Integration Controls.
3. In the Setup Integration Controls window, click Edit Detail on an integration
control, for example the PLUSYWOSTATUS integration control.
4. Note the name of the associated domain and the values that are configured for
the integration control.
5. In the Domains application, compare the noted values with the values for the
associated domain, for example the PLUSYWOSTATUS integration control is
associated with the WOSTATUS domain.
6. If the values in the integration control do not match the values in the
associated domain, return to the External Systems application to change the
values for the integration control.
7. Repeat this procedure for each integration control.
8. Save the external system.

Configuring cross-reference integration controls
Cross-reference integration controls are used to map a selection of values in
Maximo Asset Management with corresponding values in IBM TRIRIGA. Before
you integrate space planning, you specify the cross-reference mappings for these
integration controls to match the values that are used in your implementation
environments.

Procedure
1. In the External Systems application, select the PLUSYEXTSYS external system.
2. Select Select Action > Setup Integration Controls.
3. In the Setup Integration Controls window, click Edit Detail on a cross-reference
integration control, for example the PLUSYPERSTATUSXREF integration
control.
4. In the CrossReference Control window, specify the appropriate mapping values
for your environment. Maximo Asset Management values go in the Default
Value column and the corresponding IBM TRIRIGA values go in the External
Value column.
Chapter 4. Configuring integration components
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5. Click OK to save the new values and then click OK again to save the changes
to the integration control.
6. Repeat this procedure for each cross-reference integration control.

Enabling the external system
Before you can export data from Maximo Asset Management, you must enable the
external system for integration.

Procedure
1. In the External Systems application, open the PLUSYEXTSYS external system.
2. In the Publish Channels tab, verify that the publish channels that you plan to
use are enabled. At least one publish channel must be enabled before you can
enable the external system.
3. In the Enterprise Services tab, verify that the enterprise services that you plan
to use are enabled. At least one enterprise service must be enabled before you
can enable the external system.
4. In the System tab, select the Enabled check box.
5. Click Save External System.

Configuring IBM TRIRIGA
When you import the IBM Maximo Integrators for TRIRIGA package, the data
from IBM Maximo Asset Management is imported as well. However, you must
configure the connection between Maximo Asset Management and IBM TRIRIGA.

Load of IBM Maximo Asset Management data into IBM
TRIRIGA
In IBM Maximo Integrators for TRIRIGA, the initial load of data is made through
staging tables, which are copies of attribute tables that you can modify without
affecting IBM TRIRIGA. All necessary staging tables for the integration are
included in the compressed file in the ISM library.
The IBM TRIRIGA DataConnect tool processes the staging tables that contain the
data that is received from IBM Maximo Asset Management and creates the
corresponding IBM TRIRIGA Business Object. Each application in IBM TRIRIGA
uses different staging tables. The following table lists the staging tables that are
used by the IBM TRIRIGA applications.
Table 4. Staging tables
Application

Staging table

Locations

S_TRIPROPERTY, S_TRIBUILDING, S_TRIFLOOR and
S_TRISPACE

People

S_TRIPEOPLE

Assets

S_TRIBUILDINGEQUIPMENT, S_TRIFURNITURE,
S_TRIOFFICEEQUIPMENT, S_TRITECHNOLOGYASSETS and
S_TRITELEPHONES

After the initial load of data, any data that is created or updated in Maximo Asset
Management is transferred to IBM TRIRIGA through a web service. You can use
the IBM TRIRIGA web service to input or update information, and to retrieve
queries from IBM TRIRIGA applications. The IBM TRIRIGA web service uses the
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same business logic that is defined in the IBM TRIRIGA application and validates
that the required fields are inserted. Read-only fields are not updated.

Configuring the connection with IBM Maximo Asset
Management
You must configure the Http Post section of each integration object with the
address of each enterprise service in IBM Maximo Asset Management application
server and the login information.

Procedure
1. Log in to IBM TRIRIGA and select Tools > System Setup > Integration >
Integration Object.
2. Select one of the HTTP Post - Maximo Integration objects.
3. In the Http Post section, configure the connection.
a. In the Http URL field, specify the address of the application server that
Maximo Asset Management runs on.
b. In the UserName Parameter field, specify the Maximo Asset Management
user name.
c. In the Password Parameter field, specify the Maximo Asset Management
password.
4. Repeat steps 2 and 3 for each HTTP Post - Maximo Integration object.
5. Click the Execute action.

Preventing updates to integrated work task records in IBM
TRIRIGA
You can update integrated work task records only in Maximo Asset Management.
To avoid accidental changes to integrated work task records in IBM TRIRIGA, you
must make configuration changes in IBM TRIRIGA.

Procedure
1. In IBM TRIRIGA, in the Data Modeler tool, add a field named
plusyIntegrateToMaximoBL.
a. In the object browser, expand the triTask module, and select the triTask
business object.
b. Revise the business object and select View > Field List.
c. Specify the field details. Name the field plusyIntegrateToMaximoBL.
d. Save the field and select Tools > Publish BO.
2. In the Workflow Builder, add a switch condition directly above the Add/Update
Work Plans task in the triTask - Synchronous - Work Plan - Update Work
Plans workflow.
a. Expand the triTask module, and select the triTask - Synchronous - Work
Plan - Update Work Plans workflow.
b. Revise the switch condition and set the condition to
plusyIntegrateToMaximoBL == TRUE.
c. Move the Add/Update Work Plans task under the FALSE path of the switch
condition and publish the workflow.
3. In the Report Manager, in the triTask - Workflow - Find Tasks for triWorkPlan
query, add the system filter plusyIntegrateToMaximoBL Equals FALSE.
a. Click My Reports and on the System Reports tab, filter the reports by
entering tritask - workflow in the Name field.
Chapter 4. Configuring integration components
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b. Open the triTask - Workflow - Find Tasks for triWorkPlan query and on
the Filters tab, add the system filter plusyIntegrateToMaximoBL Equals
FALSE.
c. Save the report.
4. In the Report Manager, in the triTask - Display - triDispatchManager - Tasks
for Dispatch query, add the system filter plusyIntegrateToMaximoBL Not
Equals TRUE.
a. On the System Reports tab, filter the reports by entering tritask - display
- tridis in the Name field.
b. Open the triTask - Display - triDispatchManager - Tasks for Dispatch
query, and on the Filters tab, add the system filter
plusyIntegrateToMaximoBL Not Equals TRUE.
c. Save the report.
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Chapter 5. Configuring integration interfaces
Space planning integration requires the integration of data for the location, asset,
person, work order, and service request interfaces.

Integrating location data
Both Maximo Asset Management and IBM TRIRIGA support the management of
assets and people that is based on their physical locations. Maximo Integrators for
TRIRIGA provides integration components so that you can load Maximo Asset
Management locations to IBM TRIRIGA, which then manages the locations.

Location integration overview
When you integrate locations, you create a shared set of facilities management
locations that is managed by IBM TRIRIGA. In IBM TRIRIGA, you plan moves for
the people and assets in these shared locations and generate work orders on
Maximo Asset Management to carry out the work.
If you have already implemented a Maximo Asset Management environment, you
can use existing Maximo Asset Management locations to perform an initial
population of locations in IBM TRIRIGA. You must identify any existing Maximo
Asset Management locations that you want to integrate for facilities management
and assign each of these locations to an appropriate level in the IBM TRIRIGA
location hierarchy. You then export these locations to IBM TRIRIGA.
When you export locations to IBM TRIRIGA, they are automatically activated in
IBM TRIRIGA and are sent back to Maximo Asset Management. When locations
are returned to Maximo Asset Management, they are configured in the PLUSYSYS
location hierarchy system that is defined in Maximo Asset Management. This
hierarchy represents the IBM TRIRIGA hierarchy structure for the Maximo Asset
Management location. A Maximo Asset Management location can also be
associated with other location hierarchies, aside from the PLUSYSYS location
hierarchy.
After you complete the initial export of locations data to IBM TRIRIGA, the IBM
TRIRIGA location hierarchy value is set to read-only mode in Maximo Asset
Management. If you change the hierarchy level of a shared location in IBM
TRIRIGA, an update is sent to Maximo Asset Management. You add all new
locations in IBM TRIRIGA and corresponding records are then created in Maximo
Asset Management.
The following table shows the activities that are involved in this integration.
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Table 5. Activities in integration location data
Integration activity

Description

Initial load of location data from Maximo
Asset Management to IBM TRIRIGA. This
is an optional step if you want to apply
IBM TRIRIGA space planning features to
locations that are already configured in
Maximo Asset Management.

To configure existing locations in Maximo Asset Management for the
purpose of facilities management, you enable a site for the integration,
identify the locations within that site that you want to integrate and
assign an IBM TRIRIGA location hierarchy level to each of these
locations. For the records in each level of the IBM TRIRIGA location
hierarchy, you perform an initial load of data. You start by exporting
property locations and then you wait for an update of these location
records from IBM TRIRIGA before you export the locations in the next
level, building, of the IBM TRIRIGA location hierarchy.

Ongoing creation and updates of location
data from IBM TRIRIGA to Maximo Asset
Management.

After the initial integrations are complete, ongoing maintenance for
the shared locations occurs in IBM TRIRIGA and can include the
following tasks:
v Adding new records to the IBM TRIRIGA locations hierarchy and
sending these records to Maximo Asset Management.
v Changing records in the IBM TRIRIGA locations hierarchy and
sending these updates to Maximo Asset Management.

To prepare Maximo Asset Management locations for data export, you start by
identifying the sites that contain the locations that you want IBM TRIRIGA to
manage. For each of these sites, you choose the locations that you want to
integrate and assign the applicable IBM TRIRIGA hierarchy level to them. You do
not integrate any sites or locations that you do not want IBM TRIRIGA to manage.
Locations in IBM TRIRIGA are organized in a hierarchy of levels that indicate how
the different locations in a property are related to one another. The integration uses
a fixed IBM TRIRIGA location hierarchy that has five levels.
The following table shows the mappings between levels in the locations hierarchy
in IBM TRIRIGA and Maximo Asset Management.
Table 6. Mapping the IBM TRIRIGA location hierarchy levels to locations in Maximo Asset Management
IBM TRIRIGA
locations

Maximo Asset Management
locations

Maximo Asset Management
TRIRIGA hierarchy level

Property

Site (with a corresponding location
record)

00

Building

Location

10

Floor

Location

20

Space

Location

30

Subspace

Location

40

In the first stage of the integration, in Maximo Asset Management you prepare
locations and then you load this data in batches to IBM TRIRIGA DataConnect
staging tables. Management of these location records then passes to IBM TRIRIGA.
You perform a separate export for the locations in each level of the location
hierarchy, starting at the top level and working down each level of the hierarchy in
sequence. You start by exporting property records to IBM TRIRIGA. You do not
have to export locations to every level of the location hierarchy. However, any level
that you export must have locations configured at the parent level. For example, if
you configure a floor location, it must be under a location that is configured as a
building.
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In IBM TRIRIGA, the imported locations are loaded and activated automatically.
For each location record, the activation sends an update back to Maximo Asset
Management that includes the corresponding IBM TRIRIGA location keys. For IBM
TRIRIGA property records that are created from a Maximo Asset Management site,
IBM TRIRIGA sends a response that creates a new location in Maximo Asset
Management that has a location hierarchy level of 00.
In IBM TRIRIGA, review the location hierarchy. The hierarchy view shows a User
Message flag (!) for any location that encountered an error, for example the
BMXAA8229W - record key has been updated by another user error message. If an
error occurs and you need to resend the location to Maximo Asset Management,
revise and reactivate the location to send an update message to Maximo Asset
Management.
You must receive updates in Maximo Asset Management for all of the property
location records that you loaded to IBM TRIRIGA before you can load building
locations. The processing time for sending the updates to Maximo Asset
Management can vary and is partly dependent on the configuration of the sleep
time parameter of the DataConnect agent in IBM TRIRIGA.
Similar to properties, you must wait for record updates from IBM TRIRIGA before
you export the records for buildings, floors, and spaces. This approach ensures
that, if you change the hierarchy level of a record in IBM TRIRIGA, its position in
the IBM TRIRIGA location hierarchy is updated in Maximo Asset Management
before you export dependent records.
When you review a location record in IBM TRIRIGA you can adjust its position in
the IBM TRIRIGA location hierarchy. You can create a partial hierarchy in Maximo
Asset Management, such as a property, buildings, and floors, and apply space and
subspace levels in IBM TRIRIGA. IBM TRIRIGA supports recursive levels of
hierarchy where a space can contain subspaces and each subspace can contain
more subspaces.
After you load a location record to IBM TRIRIGA, the record passes to IBM
TRIRIGA management. Any future changes or additions to the data in integrated
fields can be made only in IBM TRIRIGA, which then passes these updates to
Maximo Asset Management.
After the initial data load, if you add a new property in IBM TRIRIGA, a
corresponding location is created in Maximo Asset Management. Maximo Asset
Management integration processing evaluates whether a site exists that matches
the new property record. If a site does not exist, the processing creates the site first
and then creates the corresponding location record for that property.
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Related reference:
“Components for location integration” on page 67
Location integration components include object structures that define the format
and structure of integration data, publish channels that process and send outbound
data, and an enterprise service that receives and processes inbound data. The
publish channels and enterprise service use processing rules and integration
controls to ensure that data is correctly mapped.

Preparing location data for export from Maximo Asset
Management
To export Maximo Asset Management locations to IBM TRIRIGA, you first choose
the locations to integrate and then you assign each location with the appropriate
level in the IBM TRIRIGA location hierarchy.

Enabling sites for export from Maximo Asset Management
A site in Maximo Asset Management is the equivalent of a property in IBM
TRIRIGA. When you enable a site for integration with IBM TRIRIGA, you can then
assign an IBM TRIRIGA location hierarchy level to each location in the site before
you export the locations.

Procedure
1. In the Site tab of the Organizations application, select an existing site for
export.
2. In the Details section for the site, select the Integration to TRIRIGA check box.
3. Identify an existing location system that contains the site, such as the Primary
system, and specify that value in the Location System field. You can use this
system to view the site locations in a hierarchy view to help you to assign the
appropriate level in the IBM TRIRIGA location hierarchy.
4. Click Save Organization on the toolbar.

Applying hierarchy values to location data
IBM TRIRIGA requires locations to be organized in a specific hierarchy. When you
enable a site for integration, you can assign the hierarchy values from IBM
TRIRIGA to locations in the Maximo Asset Management site.

About this task
The locations integration uses a fixed locations hierarchy with the following levels:
v
v
v
v
v

Property (not assigned a location hierarchy level)
Building
Floor
Space
Subspace

You must assign the appropriate hierarchy level to each location in the site that
you want to integrate with IBM TRIRIGA except for property locations. Integrate
only the locations that you want IBM TRIRIGA to manage. Any floor, space or
subspace location that you configure must be under a location that is also
configured for a parent level. A floor must be under a building, a space must be
under a floor, and a subspace must be under a space.
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Procedure
1. In the Locations application, select a site that is enabled for export to IBM
TRIRIGA.
2. Select Select Action > Open TRIRIGA Drilldown.
3. Select the system that you specified in the Location System field on the site
record. In the Location Hierarchy section, you can view the current hierarchy
level for each location and choose which locations to integrate.
4. Select a location to integrate, and select the hierarchy level for this location in
the TRIRIGA Hierarchy field.
5. Repeat step 4 for each location to include in the integration for this site.
6. Save the changes.

Exporting location data to IBM TRIRIGA
The initial load of locations from Maximo Asset Management is a batch export that
loads the records into IBM TRIRIGA DataConnect staging tables. After the initial
load, management of these records passes to IBM TRIRIGA.

About this task
Export location hierarchy levels in sequence from the top of the IBM TRIRIGA
location hierarchy, starting with the property (or site) location. After each export,
you must wait until these records are updated by IBM TRIRIGA before you export
the records for the next level of the IBM TRIRIGA location hierarchy. The following
table shows the export sequence and lists the publish channels to use to export
each level in the locations hierarchy.
Table 7. Publish channels for exporting locations data
Export
sequence

Hierarchy level

Publish channel

1

00 - Property (Site)

PLUSYPROP

2

10 - Building

PLUSYBLDG

3

20 - Floor

PLUSYFLOOR

4

30 - Space

PLUSYSPACE

5

40 - Subspace

PLUSYSSPACE

If you plan to integrate multiple sites, export all locations for one site before you
export the next site.

Procedure
1. In the External Systems application, select the PLUSYEXTSYS external system
and open the Publish Channels tab.
2. Select the PLUSYPROP publish channel and click Data Export.
3. In the Export Condition field, enter siteid=’site’ to restrict the export to only
one site. You can set the value in this field to suit your environment.
4. Click OK and then click Yes in the generic warning message to proceed with
the export.
5. Repeat steps 2 - 4 for each publish channel where you configured locations at
that corresponding location hierarchy level.

Chapter 5. Configuring integration interfaces

35

Related tasks:
“Configuring cross-reference integration controls” on page 27
Cross-reference integration controls are used to map a selection of values in
Maximo Asset Management with corresponding values in IBM TRIRIGA. Before
you integrate space planning, you specify the cross-reference mappings for these
integration controls to match the values that are used in your implementation
environments.
“Configuring integration controls to match domain values” on page 27
The values in many integration controls are validated against values that are
configured for associated domains. Before implementation, check that the values in
integration controls match the values in corresponding domains and, if necessary,
change the values in the integration control.
Related reference:
“Components for the initial load of location data from Maximo Asset Management
to IBM TRIRIGA” on page 67
IBM Maximo Integrators for TRIRIGA installs object structures on Maximo Asset
Management that define the format and structure of location data to send to IBM
TRIRIGA. Predefined publish channels process batch exports of location data to
send to IBM TRIRIGA staging tables that are installed by IBM Maximo Integrators
for TRIRIGA.
“Integration controls associated with location integration components” on page 77
Publish channels and enterprise services use integration controls to adapt data
formats and structures during the outbound and inbound processing of location
XML messages.

Managing location records in IBM TRIRIGA
Maximo Asset Management locations are loaded to IBM TRIRIGA in draft status
and are automatically converted to active status. For each imported record, you
review the hierarchy level and adjust if necessary.

About this task
To change the hierarchy level for a location in IBM TRIRIGA, you revise the
location, make the necessary changes, and then reactivate the location. The
reactivation sends the location with revised hierarchy information back to Maximo
Asset Management.

Procedure
1. Select Portfolio > Locations.
2. In the Hierarchy section, open an imported record.
3. Review the location hierarchy level and change it if necessary. Alternatively,
you can adjust the hierarchy level with the IBM TRIRIGA CAD
Integrator/Publisher tool.
4. Activate the record. When you activate the record, the updated record is sent to
Maximo Asset Management where the hierarchy data is available in read-only
format.
5. To add a new location to the set of shared data:
a. Create the location in IBM TRIRIGA.
b. Activate the new record.
IBM TRIRIGA sends the data to Maximo Asset Management where a
corresponding read-only record is created.
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Related reference:
“IBM TRIRIGA integration components” on page 107
IBM Maximo Integrators for TRIRIGA installs predefined components on IBM
TRIRIGA to support integration with Maximo Asset Management.
Related information:
IBM TRIRIGA 10 Portfolio Management User Guide

Exporting locations to Maximo Asset Management from IBM
TRIRIGA
The initial load of locations from IBM TRIRIGA is a batch export that loads the
records into Maximo Asset Management. After the initial load, location records are
managed in IBM TRIRIGA.

About this task
Maximo Integrators for TRIRIGA supports an IBM TRIRIGA location hierarchy of
five levels: property, building, floor, space, and subspace. The HTTP Post - Maximo
Integration objects in IBM TRIRIGA correspond to the following location hierarchy
on Maximo Asset Management.
IBM TRIRIGA integration object

Location type in Maximo Asset
Management

triProperty - HTTP Post - Maximo
Integration

Site

triBuilding - HTTP Post - Maximo
Integration

Building

triFloor - HTTP Post - Maximo Integration

Floor

triSpace - HTTP Post - Maximo Integration

Space, subspace

Procedure
1. In IBM TRIRIGA, in the Integration Objects application, configure the HTTP
Post - Maximo Integration object for each location type to point to
http://hostname:port/meaweb/es/PLUSYEXTSYS/PLUSYLOCHIER. This URL points
to the PLUSYLOCHIER enterprise service that processes locations that are sent
to Maximo Asset Management from IBM TRIRIGA.
2. In IBM TRIRIGA, in the Location Export to Maximo application, select the Find
action to load active locations.
3. In the Properties tab, select a property to export. Load all of the locations for
this property before you load the locations for another property.
4. Select the Export to Maximo action to load the property record to Maximo
Asset Management. Maximo Asset Management receives the property, creates a
property record and a corresponding site record, and returns a response that
updates the property record in IBM TRIRIGA with the Maximo ID value.
5. Select an integrated property and export the buildings for the property.
a. Click the Buildings tab.
b. Select the Find action to load the active buildings in the selected property.
c. Select the buildings that you want to integrate.
d. Click OK.
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e. Select the Export to Maximo action to load the building records to Maximo
Asset Management. Maximo Asset Management receives the building
records and returns a response that updates the building records in IBM
TRIRIGA with the Maximo ID value.
6. Select all of the buildings that are integrated for this property and export the
floors in the buildings.
a. Click the Floors tab.
b. Select the Find action to load the active floors for the selected buildings.
c. Select the floors that you want to integrate.
d. Click OK.
e. Select the Export to Maximo action to load the floor records to Maximo
Asset Management. Maximo Asset Management receives the floor records
and returns a response that updates the floor records in IBM TRIRIGA with
the Maximo ID value.
7. Select all of the floors that are integrated for this property and export the
spaces.
a. Click the Spaces tab.
Select the Find action to load the active spaces for the selected floors.
Select the spaces that you want to integrate.
Click OK.
Select the Export to Maximo action to load the space records to Maximo
Asset Management. Maximo Asset Management receives the space records
and returns a response that updates the space records in IBM TRIRIGA with
the Maximo ID value.
8. Select all of the spaces that are integrated for this property and export the
subspaces.
a. Click the Subspaces tab.
b.
c.
d.
e.

b.
c.
d.
e.

Select the Find action to load the active subspaces for the selected spaces.
Select the subspaces that you want to integrate.
Click OK.
Select the Export to Maximo action to load the subspaces records to
Maximo Asset Management. Maximo Asset Management receives the
subspaces records and returns a response that updates the subspaces
records in IBM TRIRIGA with the Maximo ID value.

9. Repeat steps 2-8 for each property that you want to integrate.

Integrating asset data
Both Maximo Asset Management and IBM TRIRIGA support the management of
assets and people based on their physical locations. Maximo Integrators for
TRIRIGA includes predefined components that you can use to implement a
bidirectional integration of asset data between Maximo Asset Management and
IBM TRIRIGA.
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Related reference:
“Components for asset integration” on page 77
The asset interface includes object structures that define the format and structure of
integration data, publish channels that process and send outbound data, and an
enterprise service that receives and processes inbound data. The publish channels
and enterprise service use processing rules and integration controls to ensure that
data is correctly mapped.

Asset integration overview
To integrate asset data, you export assets from Maximo Asset Management for
initial loading into IBM TRIRIGA, and then you load facility assets from IBM
TRIRIGA to Maximo Asset Management. Integration of asset data is bidirectional,
and on-going creation and update of assets can be done in either system.
Maximo Integrators for TRIRIGA provides components for the bidirectional
loading of asset data between the systems and for managing ongoing updates of
assets in either system. The default configuration supports the integration of
facility and IT assets but you can also integrate furniture, office equipment, and
telephone assets. You can use the External Systems application in Maximo Asset
Management to add asset type values to the PLUSYTOASSETTYPEXREF and the
PLUSYFRASSETTYPEXREF cross-reference integration controls.
You can create or update asset records either in Maximo Asset Management or in
IBM TRIRIGA, and IBM Maximo Integrators for TRIRIGA transfers your changes
between the systems.
In Maximo Asset Management, you cannot change the asset type of an asset that is
integrated. You can change the status of the asset to Retired in IBM TRIRIGA, and
then you can create another asset with the asset type that you want.
Asset data is integrated in four stages. Two stages occur at the start of the
integration and two stages occur on an ongoing basis to update data.
The following table shows the stages that are involved in the integration of asset
data.
Stage

Integration activity

Description

1

Initial load of asset data from Asset data can be exported in logical
Maximo Asset Management groups, for example all assets of the same
to IBM TRIRIGA
type or all assets within the same location.

2

Initial load of facility asset
data from IBM TRIRIGA to
Maximo Asset Management

In IBM TRIRIGA, you can configure
selected assets to integrate with Maximo
Asset Management when the assets are
activated.

3

Ongoing creation or update
of asset data from IBM
TRIRIGA to Maximo Asset
Management

After the initial integration of asset data,
Maximo Integrators for TRIRIGA transfers
any new or updated assets that are
managed in IBM TRIRIGA to Maximo Asset
Management.

4

Ongoing creation or update
of asset data from Maximo
Asset Management to IBM
TRIRIGA

After the initial integration of asset data,
Maximo Integrators for TRIRIGA updates
IBM TRIRIGA with any changes that you
make to the assets in Maximo Asset
Management.
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Related tasks:
“Configuring cross-reference integration controls” on page 27
Cross-reference integration controls are used to map a selection of values in
Maximo Asset Management with corresponding values in IBM TRIRIGA. Before
you integrate space planning, you specify the cross-reference mappings for these
integration controls to match the values that are used in your implementation
environments.

Asset integration processing
The integration of asset data is supported bidirectionally through the PLUSYASSET
and PLUSYASSET2 publish channels and the PLUSYASSET enterprise service.

Initial data load from Maximo Asset Management to IBM TRIRIGA
The initial data load from Maximo Asset Management to IBM TRIRIGA is done
through the PLUSYASSET publish channel. You can export asset data and send the
data to IBM TRIRIGA by using IBM TRIRIGA DataConnect processing. The
PLUSYASSET publish channel is the initial load mechanism. The ongoing creation
and updates of asset data in Maximo Asset Management are sent through the
PLUSYASSET2 publish channel. After an asset record is loaded from Maximo Asset
Management to IBM TRIRIGA through the PLUSYASSET publish channel, the asset
record cannot be sent again through this publish channel. The initial load does not
require that all assets be extracted and loaded at one time. You can load asset data
based on logical groups, such as all assets of the same type or all assets within the
same location.

Initial data load and ongoing updates from IBM TRIRIGA to Maximo
Asset Management
The PLUSYASSET enterprise service receives asset data from IBM TRIRIGA. This
single service is used to integrate the following types of asset data from IBM
TRIRIGA to Maximo Asset Management:
v Initial data load of activated facility assets
v Ongoing load of assets that you create in IBM TRIRIGA
v Ongoing updates that you make to the asset data for integrated assets
Field values such as status and type are set according to the processing rules and
integration control values. The processing of updates into Maximo Asset
Management results in either the creation of new asset records or the update of
existing asset records.

Ongoing updates from Maximo Asset Management to IBM TRIRIGA
After the initial data load, when you create or update asset records in Maximo
Asset Management, the new or changed data is sent to IBM TRIRIGA through the
PLUSYASSET2 publish channel. The PLUSYASSET2 publish channel uses the event
listener so that messages are sent whenever you create or update an asset record in
Maximo Asset Management.
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Related reference:
“Components for the initial load of asset data from Maximo Asset Management to
IBM TRIRIGA” on page 78
Predefined object structures and publish channels are provided for the outbound
integration of asset data. The object structures define how asset data is formatted
and sent from Maximo Asset Management to IBM TRIRIGA. Publish channels
process the outbound asset data and send the data to IBM TRIRIGA.
“Components for loading and updating asset data to Maximo Asset Management
from IBM TRIRIGA” on page 79
Maximo Integrators for TRIRIGA includes an object structure, enterprise service,
processing rules, and integration controls for importing and updating IBM
TRIRIGA asset data to Maximo Asset Management.
“Components for updating asset data from Maximo Asset Management to IBM
TRIRIGA” on page 81
After the initial load of asset data is completed, updates and new asset records can
be sent to IBM TRIRIGA through the PLUSYASSET2 publish channel, which uses
the PLUSYASSETTO2 object structure to map the data. Integration controls and
processing rules are used to format and validate the data.

Exporting assets to IBM TRIRIGA
Maximo Integrators for TRIRIGA includes predefined components that you use to
export batches of asset records from Maximo Asset Management to IBM TRIRIGA.
The data is exported to IBM TRIRIGA DataConnect staging tables.

Before you begin
You must enable a site for integration and synchronize the location data. The asset
records that you plan to export must be in a location that is integrated between
Maximo Asset Management and IBM TRIRIGA.

Procedure
1. In the External Systems application, select the PLUSYEXTSYS external system
and click the Publish Channels tab.
2. Select the PLUSYASSET publish channel and click Data Export.
3. Optional: You can choose your own criteria for exporting groups of assets. For
example, if you want to export all of the assets in a site, in the Export
Condition field, enter siteid='site'.
4. Click OK to run the export.
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Related tasks:
“Configuring cross-reference integration controls” on page 27
Cross-reference integration controls are used to map a selection of values in
Maximo Asset Management with corresponding values in IBM TRIRIGA. Before
you integrate space planning, you specify the cross-reference mappings for these
integration controls to match the values that are used in your implementation
environments.
“Configuring integration controls to match domain values” on page 27
The values in many integration controls are validated against values that are
configured for associated domains. Before implementation, check that the values in
integration controls match the values in corresponding domains and, if necessary,
change the values in the integration control.
Related reference:
“Components for loading and updating asset data to Maximo Asset Management
from IBM TRIRIGA” on page 79
Maximo Integrators for TRIRIGA includes an object structure, enterprise service,
processing rules, and integration controls for importing and updating IBM
TRIRIGA asset data to Maximo Asset Management.
“Integration controls” on page 83
Publish channels and enterprise services use integration controls to adapt data
formats and structures during the outbound and inbound processing of asset data
XML messages.

Maintaining assets in IBM TRIRIGA
Assets in Maximo Asset Management correspond to assets in IBM TRIRIGA. When
you maintain IBM TRIRIGA assets, you can choose which assets to integrate with
Maximo Asset Management. When these IBM TRIRIGA assets become active,
Maximo Asset Management assets are created or updated.

About this task
When the configured IBM TRIRIGA asset records change from a Draft status or
Revision in Progress status to an Active status, Maximo Asset Management
assets are created or updated.

Procedure
1. Select Portfolio > Assets and the type of asset.
2. Open the asset record.
Record

Action

New

Click the Add action. After you specify the required details,
create the draft.

Draft

Open an existing record in Draft status.

Active

Open an existing record in Active status. Revise the record so
that it is in Revision in Progress status.

3. After you specify any additional details, activate the record.
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Related reference:
“IBM TRIRIGA integration components” on page 107
IBM Maximo Integrators for TRIRIGA installs predefined components on IBM
TRIRIGA to support integration with Maximo Asset Management.
Related information:
IBM TRIRIGA 10 Portfolio Management User Guide

Exporting assets to Maximo Asset Management from IBM
TRIRIGA
The initial load of assets from IBM TRIRIGA is a batch export that loads the
records into Maximo Asset Management. After the initial load, asset records can be
managed in either system.

Before you begin
Location records must be integrated between Maximo Asset Management and IBM
TRIRIGA before you integrate asset records.

About this task
IBM TRIRIGA supports the integration of the following types of assets:
v Facility
v
v
v
v

IT
Furniture
Office equipment
Telephone

The HTTP Post - Maximo Integration objects in IBM TRIRIGA correspond to the
following asset types in Maximo Asset Management:
IBM TRIRIGA integration object

Asset type in Maximo Asset Management

triBuildingEquipment - HTTP Post - Maximo Facility
Integration
triTechnologyAssets - HTTP Post - Maximo
Integration

IT

triFurniture - HTTP Post - Maximo
Integration

Furniture

triOfficeEquipment - HTTP Post - Maximo
Integration

Office equipment

triTelephones - HTTP Post - Maximo
Integration

Telephone

Procedure
1. In Maximo Asset Management, in the External Systems application, add the
furniture, office equipment, and telephone asset types to the PLUSYASSETTO
and the PLUSYASSETFR integration controls. By default, Maximo Integrators
for TRIRIGA is configured to exchange facility and IT assets.
2. In IBM TRIRIGA, in the Integration Objects application, configure the HTTP
Post - Maximo Integration object for each asset type to point to
http://hostname:port/meaweb/es/PLUSYEXTSYS/PLUSYASSET. This URL points to
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3.
4.
5.
6.
7.

8.

the PLUSYASSET enterprise service that processes assets that are sent to
Maximo Asset Management from IBM TRIRIGA.
In IBM TRIRIGA, in the Asset Export to Maximo application, select an asset
type to export to Maximo Asset Management.
Select the Find action to load active assets for your selected asset type.
Select the asset records that you want to export and click OK.
Confirm your selection by selecting each line item that you want to export or
by selecting the Select all check box.
Select the Export to Maximo action to load the asset records to Maximo Asset
Management. Maximo Asset Management receives the asset records and returns
a response that updates the asset records in IBM TRIRIGA with the Maximo ID
values.
Repeat steps 3-7 for each asset type that you want to integrate.

Integrating person data
Person data is integrated bidirectionally between Maximo Asset Management and
IBM TRIRIGA. Person data includes the name, location, contact information,
employee type, and employment history, such as the hire date.
Related reference:
“Components for person integration” on page 85
Person integration components include object structures that define the format and
structure of integration data, publish channels that process and send outbound
data, and an enterprise service that receives and processes inbound data. The
publish channels and enterprise service use processing rules and integration
controls to ensure that data is correctly mapped.

Person integration overview
To integrate person data, you initially load data from one product to the other, and
then you maintain the integration by updating the data. Integration of person data
is bidirectional.
Depending on the status of your current implementation of Maximo Asset
Management and IBM TRIRIGA, you can do the initial load of person data from
either product. The decision of which product to use for the initial load of data
depends on which product is already implemented and managing person data.
Also, consider whether either product already has an integration with an HR
system that manages person data. For example, if your person data is managed in
an HR system that sends updates to Maximo Asset Management, then you use
Maximo Asset Management for the initial load of data.
The following table shows the activities that are involved in this integration.
Table 8. Activities in integrating person data
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Integration activity

Description

Initial load of person data from
Maximo Asset Management to IBM
TRIRIGA

To integrate person data from a Maximo Asset
Management environment, you can export that
data in logical groups, such as by employee type.

Initial load of person data from IBM
TRIRIGA to Maximo Asset
Management

To copy person data from an IBM TRIRIGA
environment, you can send that data to Maximo
Asset Management.

Table 8. Activities in integrating person data (continued)
Integration activity

Description

Ongoing creation or update of person You can send ongoing creation and updates of
data in IBM TRIRIGA to Maximo
persons in IBM TRIRIGA to Maximo Asset
Asset Management
Management.
Ongoing creation or update of person You can send ongoing creation and updates of
data in Maximo Asset Management to persons in Maximo Asset Management to IBM
IBM TRIRIGA
TRIRIGA.

Related reference:
“Components for person integration” on page 85
Person integration components include object structures that define the format and
structure of integration data, publish channels that process and send outbound
data, and an enterprise service that receives and processes inbound data. The
publish channels and enterprise service use processing rules and integration
controls to ensure that data is correctly mapped.

Person interface data
When you integrate person data, you must first configure the integration-related
data, such as employee type. Some integration-related data might apply to the
processing of person data in one direction or both directions.

Employee type
By default, the integration is configured to support the following three employee
types that are defined in IBM TRIRIGA:
v Employee
v Consultant
v External Contact
An integration control maps the employee type in Maximo Asset Management to
one of those three values. The integration control is a cross-reference control that is
named PLUSYEMPTYPEXREF. The following table shows the mapping between
the employee types in Maximo Asset Management and IBM TRIRIGA.
Employee type in Maximo Asset
Management

Employee type in IBM TRIRIGA

1

Employee

2

Consultant

3

External Contact

In Maximo Asset Management, you set the employee type value in the
PLUSYEMPTYPEXREF control to the values for your implementation of person
data. The values in this control for the employee types in IBM TRIRIGA are
predefined, and only these values can be used. The PLUSYEMPTYPEXREF control
is used outbound on the PLUSYPERSON and PLUSYPERSON2 publish channels
and for inbound processing on the PLUSYPERSON enterprise service.
You can map multiple employee types in Maximo Asset Management to one IBM
TRIRIGA type for outbound processing. If you do this many-to-one mapping, you
must create a separate cross-reference control for inbound processing so that the
IBM TRIRIGA employee type maps to a single employee type in Maximo Asset
Management. A one-to-many mapping is not supported.
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Based on your implementation of employee type and person data in Maximo Asset
Management, you might find that mapping to the IBM TRIRIGA employee type
cannot be done by using the Maximo Asset Management employee type. For
example, your implementation of employee type specifies the experience level of
the employee, which does not map directly to the three different types in IBM
TRIRIGA. In this case, you might replace this processing rule with a rule that
aligns with your implementation of this data.
The PLUSYEMPLOYEETYPE integration control is used for outbound processing
on the PLUSYPERSON and PLUSYPERSON2 publish channels. The
PLUSYEMPLOYEETYPE integration control is used to filter transactions so that
person records with selected employee types are not integrated with IBM
TRIRIGA. You use the PLUSYEMPLOYEETYPE integration control when you have
person data in Maximo Asset Management that you do not want under IBM
TRIRIGA management.
A default value of 1 is set in this integration control. You must check the domain
for employee type in Maximo Asset Management to determine whether the use of
the PLUSYEMPLOYEETYPE integration control matches the implementation of
person data in your Maximo Asset Management implementation.
If you opt to use the PLUSYEMPLOYEETYPE integration control to skip records
during integration, you must update the control to include employee type values
that you want to integrate with IBM TRIRIGA. Any person records with employee
type values that are not in the list of values in the PLUSYEMPLOYEETYPE
integration control are not sent to IBM TRIRIGA. If the values in the
PLUSYEMPLOYEETYPE integration control do not match your values in the
employee type domain in Maximo Asset Management, you can remove this
condition on the processing rules for each publish channel.
If you use both the PLUSYEMPLOYEETYPE and PLUSYEMPTYPEXREF
integration controls, the values in these controls must align so that the employee
types used in the PLUSYEMPLOYEETYPE list control have corresponding entries
in the PLUSYEMPTYPEXREF cross-reference control.

Person status
The PLUSYPERSTATUSXREF cross-reference control is used in outbound messages
to set the person status value that is based on the person status value in Maximo
Asset Management. The PLUSYFRPERSTATUSXREF cross-reference control is used
in inbound messages.
The PLUSYPERSONSTATUS integration control is used for outbound processing
on the PLUSYPERSON and PLUSYPERSON2 publish channels. The
PLUSYPERSONSTATUS integration control is used to filter transactions so that
person records with selected person status are not integrated with IBM TRIRIGA.
You use the PLUSYPERSONSTATUS integration control to control the timing of
when person data in Maximo Asset Management is to be sent to IBM TRIRIGA
based on the updating of the status value for a person record.
The default values of Active and Inactive are set in this integration control. You
must check the domain for employee status to determine whether the use of the
PLUSYPERSONSTATUS integration control matches the implementation of person
data in your Maximo Asset Management implementation. If you use the
PLUSYPERSONSTATUS integration control to skip records during integration, you
must update the control to include person status values that you want to integrate
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with IBM TRIRIGA. Any person records with person status values that are not in
this list are not sent to IBM TRIRIGA. If use of the PLUSYPERSONSTATUS
integration control does not align with your implementation, you can remove this
condition on the processing rules for each publish channel.
If you use PLUSYPERSTATUSXREF, PLUSYFRPERSTATUSXREF, and
PLUSYPERSONSTATUS integration controls, the values in these controls must
align so that the statuses used in the PLUSYPERSONSTATUS list control have
corresponding entries in the PLUSYFRPERSTATUSXREF and
PLUSYFRPERSTATUSXREF cross-reference control.

Language and time zone
The PLUSYLANGUAGEXREF cross-reference control is used to set the language
value that is based on the language value in Maximo Asset Management. The
PLUSYTIMEZONEXREF cross-reference control is used to set the time zone value
in IBM TRIRIGA based on the time zone value that is set in Maximo Asset
Management.

Person email and phone
When person data is sent from Maximo Asset Management to IBM TRIRIGA, the
primary phone and email of the person are sent to IBM TRIRIGA. When you create
and update person data from IBM TRIRIGA to Maximo Asset Management
through the PLUSYPERSON enterprise service, default values are provided for
email and phone data. A processing rule on the PLUSYPERSON enterprise service
sets the Primary flag for email and phone data to 0, which is false, and sets the
Type value to WORK. If these values do not match your primary values for the
person, you can change the processing rule.
The removal of phone and email information in IBM TRIRIGA does not cause the
removal of the corresponding fields in Maximo Asset Management. If you must
remove phone and email information for an integrated record, make the change in
Maximo Asset Management, which then sends the update to IBM TRIRIGA.
Related reference:
“Components for person integration” on page 85
Person integration components include object structures that define the format and
structure of integration data, publish channels that process and send outbound
data, and an enterprise service that receives and processes inbound data. The
publish channels and enterprise service use processing rules and integration
controls to ensure that data is correctly mapped.

Person integration processing
The integration of person data is supported bidirectionally through the
PLUSYPERSON and PLUSYPERSON2 publish channels and the PLUSYPERSON
enterprise service.

Initial data load from Maximo Asset Management to IBM TRIRIGA
The initial data load from Maximo Asset Management to IBM TRIRIGA is done
through the PLUSYPERSON publish channel. You can export person data and send
the data to IBM TRIRIGA by using IBM TRIRIGA DataConnect processing. The
PLUSYPERSON publish channel is the initial load mechanism. The ongoing
creation and updates of person data in Maximo Asset Management are sent
through the PLUSYPERSON2 publish channel. After a person record is loaded
from Maximo Asset Management to IBM TRIRIGA through the PLUSYPERSON
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publish channel, the person record cannot be sent again through this publish
channel. The initial load does not require that all persons be extracted and loaded
at one time. You can load person data based on logical groups, such as person
records with the same employee type or person records with the same location.
The first time that a person record is integrated from Maximo Asset Management
to IBM TRIRIGA, the IBM TRIRIGA ID is sent to Maximo Asset Management. Each
record on each system has the ID of the record in the other system. When a person
record is selected for export from Maximo Asset Management through the
PLUSYPERSON channel, the following filter conditions must be satisfied:
v The employee type of the person record must be configured in the integration
control.
v The status of the person record must be configured in the integration control.
v The person record must not already be integrated with IBM TRIRIGA.

Ongoing updates from Maximo Asset Management to IBM TRIRIGA
After the initial data load, when person records in Maximo Asset Management are
updated or created, the new or changed data is sent to IBM TRIRIGA through the
PLUSYPERSON2 publish channel. The PLUSYPERSON2 publish channel uses the
event listener so that messages are sent whenever a user updates a person record
in Maximo Asset Management.
The following filter conditions must be satisfied in order for the person record to
be sent through the PLUSYPERSON2 publish channel:
v The employee type of the person record must be configured in the integration
control.
v The status of the person record must be configured in the integration control.
Even if you restricted the initial integration of person records to a specific site or
organization, all changed or updated person records are sent to IBM TRIRIGA if
the filter conditions are met. If you want to further filter the person records, you
can add more filtering criteria to the processing rule on the PLUSYPERSON2
publish channel. For example, you can restrict the sending of person records to
IBM TRIRIGA to only a specific site.

Person updates from another system
If the Maximo Asset Management person data is loaded from an external
application, such as an HR system, updates from the external application can be
sent to IBM TRIRIGA. Such updates are sent the same way that person records are
updated in the People application.
The People application in Maximo Asset Management prevents a user from
changing the site or location if the location is part of the integration, which means
that the location data is managed by IBM TRIRIGA. A processing rule prevents an
update to the location in a person record when that update comes through the
integration. This processing rule prevents an update from an HR system or other
external application from changing the location when the current location of the
person record is managed in IBM TRIRIGA.
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Person updates from IBM TRIRIGA to Maximo Asset Management
The PLUSYPERSON enterprise service receives updates of new or changed
Maximo Asset Management person data from IBM TRIRIGA. This single service is
used for both the initial data load and ongoing updates.
The PLUSYPERSON enterprise service is called by IBM TRIRIGA when person
records are updated in IBM TRIRIGA. Field values such as person status are set
according to the processing rules and integration control values. The processing of
updates into Maximo Asset Management results in either the creation of new
person records or the update of existing person records.
Although IBM TRIRIGA supports the use of the same email address for multiple
persons, Maximo Asset Management does not support this. Transaction errors
occur if duplicated email addresses are used for different person records.
The removal of phone and email information in IBM TRIRIGA does not cause the
removal of the corresponding fields in Maximo Asset Management. If you must
remove phone and email information for an integrated record, make the change in
Maximo Asset Management, which then sends the update to IBM TRIRIGA.
Related reference:
“Components for initial load of person data from Maximo Asset Management to
IBM TRIRIGA” on page 85
Predefined publish channels and object structures are provided for the outbound
integration of person data. The object structure defines how person data is
formatted and sent from Maximo Asset Management to IBM TRIRIGA. The
publish channel process the outbound person data and sends the data to IBM
TRIRIGA.
“Components for creating and updating person data in Maximo Asset
Management from IBM TRIRIGA” on page 87
Maximo Integrators for TRIRIGA provides an object structure, enterprise service,
processing rules, and integration controls for importing IBM TRIRIGA person data
into Maximo Asset Management.
“Components for updating person data from Maximo Asset Management to IBM
TRIRIGA” on page 89
After the initial load of person data is completed, updates and new person records
can be sent to IBM TRIRIGA through the provided publish channel, which uses an
object structure to map the data. Integration controls and processing rules are used
to format and validate the data.

Exporting person data for the initial load of data from Maximo
Asset Management to IBM TRIRIGA
The PLUSYPERSON publish channel exports person data to the IBM TRIRIGA
DataConnect staging tables.

Before you begin
Ensure that the following controls contain values that are applicable to your
implementation:
v PLUSYEMPLOYEETYPE
v PLUSYPERSONSTATUS
v PLUSYEMPTYPEXREF
v PLUSYPERSTATUSXREF
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v PLUSYTIMEZONEXREF
v PLUSYLANGUAGEXREF

Procedure
1. In the External Systems application, select the PLUSYEXTSYS external system
and open the Publish Channels tab.
2. Select the PLUSYPERSON publish channel and click Data Export.
3. Optional: In the Export Condition field, enter a condition to restrict the export.
For example, to limit the export to an organization, enter orgid=’org’.
4. Click OK to run the export. Refer to the processing rule information in the
Related reference chapter.

Results
The person records are loaded to the IBM TRIRIGA staging table and imported
into IBM TRIRIGA through the DataConnect process.
Related concepts:
“Person integration processing” on page 47
The integration of person data is supported bidirectionally through the
PLUSYPERSON and PLUSYPERSON2 publish channels and the PLUSYPERSON
enterprise service.
Related tasks:
“Configuring cross-reference integration controls” on page 27
Cross-reference integration controls are used to map a selection of values in
Maximo Asset Management with corresponding values in IBM TRIRIGA. Before
you integrate space planning, you specify the cross-reference mappings for these
integration controls to match the values that are used in your implementation
environments.
“Configuring integration controls to match domain values” on page 27
The values in many integration controls are validated against values that are
configured for associated domains. Before implementation, check that the values in
integration controls match the values in corresponding domains and, if necessary,
change the values in the integration control.
Related reference:
“Publish channel for initial export of person data” on page 86
The PLUSYPERSON publish channel sends the initial load data to the
S_TRIPEOPLE staging table. Processing rules and integration controls are used to
process and format the data.
“Integration controls associated with person integration components” on page 91
Publish channels and enterprise services use integration controls to adapt data
formats and structures during the outbound and inbound processing of person
data XML messages.

Maintaining people records in IBM TRIRIGA
When you create or update people records in IBM TRIRIGA, you can send those
changes to Maximo Asset Management.
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About this task
In IBM Maximo Integrators for TRIRIGA, people records are initially owned by
IBM Maximo Asset Management. When you send people records from Maximo
Asset Management to IBM TRIRIGA, the record is received in IBM TRIRIGA as an
active record.
However, if you create people records in IBM TRIRIGA, you can indicate that they
are part of Maximo Integrators for TRIRIGA.

Procedure
1. Select Portfolio > People.
2. Select the type of record you want to create. In IBM TRIRIGA, you can create
three types of people records: Employees, Consultants, and External Contacts.
3. On the action bar, click Add.
4. Specify the information about the record.
5. Activate the record.
Related concepts:
“Person integration processing” on page 47
The integration of person data is supported bidirectionally through the
PLUSYPERSON and PLUSYPERSON2 publish channels and the PLUSYPERSON
enterprise service.
Related reference:
“IBM TRIRIGA integration components” on page 107
IBM Maximo Integrators for TRIRIGA installs predefined components on IBM
TRIRIGA to support integration with Maximo Asset Management.
Related information:
IBM TRIRIGA 10 Portfolio Management User Guide

Exporting people to Maximo Asset Management from IBM
TRIRIGA
The initial load of people from IBM TRIRIGA is a batch export that loads the data
as person record into Maximo Asset Management. After the initial load, people can
be managed in either system.

Procedure
1. In IBM TRIRIGA, in the Integration Objects application, configure the triPeople
- HTTP Post - Maximo Integration object to point to http://hostname:port/
meaweb/es/PLUSTEXTSYS/PLUSTEXTSYS/PLUSYPERSON. This URL points to the
PLUSYPERSON enterprise service that processes people records that are sent to
Maximo Asset Management from IBM TRIRIGA.
2. In IBM TRIRIGA, in the People Export to Maximo application, in the Find
menu, select a person type to export to Maximo Asset Management.
3. Select the Find action to load active people for your selected person type.
4. Select the people records that you want to export and click OK.
5. Confirm your selection by selecting each line item that you want to export or
by selecting the Select all check box.
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6. Select the Export to Maximo action to load the people records to Maximo Asset
Management. Maximo Asset Management receives the records, creates
corresponding person records, and sends a response to IBM TRIRIGA that
updates the people records.
7. Repeat steps 2-6 for each person type that you want to integrate.

Integrating work order data
Work order integration is a bidirectional integration that enables a move or a
planned work task in IBM TRIRIGA to create a work order in Maximo Asset
Management. The IBM TRIRIGA work task provides information and instructions
that enable the owner of the work order to perform the work.
Related reference:
“Components for work order integration” on page 92
Work order integration components include object structures that define the format
and structure of integration data, publish channels that process and send outbound
data, and an enterprise service that receives and processes inbound data. The
publish channels and enterprise service use processing rules and integration
controls to ensure that data is correctly mapped.

Work order integration overview
When you mark an IBM TRIRIGA work task for integration and then activate the
work task, the data is sent to Maximo Asset Management to create a corresponding
work order. As the work progresses, Maximo Asset Management sends status
updates and also sends the costs that are associated with the work to IBM
TRIRIGA.
The following table shows the activities that are involved in this integration.
Table 9. Activities involved in integrating work order and work order cost data
Integration activity

Description

Initial send of work tasks from IBM
TRIRIGA to Maximo Asset Management

To integrate a work task in IBM TRIRIGA,
you select the Integrate to Maximo Asset
Management check box and activate the
work task. The work task data is sent to
Maximo Asset Management, where a
corresponding work order is created.

Ongoing updates of work order data from
Maximo Asset Management to IBM
TRIRIGA

Maximo Asset Management can send
updates to IBM TRIRIGA that include status
changes and other attributes.

Updates of work order cost data from
Maximo Asset Management to IBM
TRIRIGA

Maximo Asset Management sends the costs
that are associated with a work order to IBM
TRIRIGA, including the costs of labor,
materials, services, and tools.

IBM TRIRIGA has multiple types of work tasks that can be stand-alone work tasks
or can be grouped as part of a project.
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Initial send of work tasks from IBM TRIRIGA to Maximo Asset
Management
Typically, when a work task is created from a task template, the value of the
Integrate to Maximo flag is applied from the task template to the task. You can
also select the Integrate to Maximo check box on a work task and activate the
work task.
When Maximo Asset Management receives a work task from IBM TRIRIGA, a
work order is created. Maximo Asset Management sends a response XML message
to IBM TRIRIGA that includes the internal and external keys for the work order.
If an IBM TRIRIGA work task fails to create a corresponding Maximo Asset
Management work order, a message is created in the Attention section of the work
task. The message provides details of the failure and the opportunity to revise the
work task to fix the issue. You can then reactivate the work task, which results in a
second attempt to create the work order in Maximo Asset Management.
Integrated work orders include fields that are specific to IBM TRIRIGA work tasks,
including project details, opportunity details, and move line items. For example,
move line items contain the people and assets to move from one location to
another.

Ongoing updates of work orders from Maximo Asset
Management to IBM TRIRIGA
When an integrated work order is created in Maximo Asset Management, an
update is sent to IBM TRIRIGA that includes the internal and external IDs for the
work order. These IDs support the ongoing updates of work order data to IBM
TRIRIGA. As the work on a work order progresses, Maximo Asset Management
sends updates to IBM TRIRIGA including change of status and other attributes.

Sending work order costs from Maximo Asset Management to
IBM TRIRIGA
In Maximo Asset Management, a work order can record the costs of the materials,
tools, labor, and service that are associated with the work. The costs on the work
order are passed back to IBM TRIRIGA so that the work task reflects the actual
costs of the work.
The work order costs that are passed back to IBM TRIRIGA come from the work
order that is directly associated with the work task. If child work orders are
created under this work order, costs that are associated with the child work orders
are not sent back to IBM TRIRIGA.
When the work is complete, IBM TRIRIGA sends messages to Maximo Asset
Management to update the records for the line items that are affected by the work
task.

Configuring work order integration in Maximo Asset
Management
Maximo Integrators for TRIRIGA provides components for integrating Maximo
Asset Management work orders with IBM TRIRIGA work tasks. To prepare for the
integration, you configure these components to match the conditions in your
implementation environment.
Chapter 5. Configuring integration interfaces

53

Related tasks:
“Configuring cross-reference integration controls” on page 27
Cross-reference integration controls are used to map a selection of values in
Maximo Asset Management with corresponding values in IBM TRIRIGA. Before
you integrate space planning, you specify the cross-reference mappings for these
integration controls to match the values that are used in your implementation
environments.
“Configuring integration controls to match domain values” on page 27
The values in many integration controls are validated against values that are
configured for associated domains. Before implementation, check that the values in
integration controls match the values in corresponding domains and, if necessary,
change the values in the integration control.

Assigning the TRIRIGA work type to organizations
Maximo Integrators for TRIRIGA requires new work types in Maximo Asset
Management to support the data that is included in IBM TRIRIGA work tasks.
Before you can integrate work orders, you configure these work types for each
organization that contains sites that you want to integrate.

Procedure
1. In the Organizations application, filter for an organization that contains sites
that you intend to integrate.
2. In the Organization tab, select Select Action > Work Order Options > Work
Type.
3. In the Work Type window, click New Row.
4. In the Details section, specify the values for a work task type from the
following table:
IBM TRIRIGA
work task type

Work Class

Work Type

Description

Type

Planned

WORKORDER

TRIPW

TRIRIGA
Opportunity
Work Type

PLUSYOPP

Move

WORKORDER

TRISP

TRIRIGA Move
Work Type

PLUSYSPACE

5.
6.
7.
8.

Verify that the Record Task Status History Flag check box is selected.
Repeat steps 3 - 5 for each work task type.
Click OK to save the work types.
Repeat these steps for each organization that contains sites that you intend to
integrate.

Configuring default values
The PLUSYWOPRIORITY integration control sets the default value in the
PRIORITY field of a work order. The PLUSYWOPRIORITY integration control is
associated with the PLUSYWO enterprise service. Before you integrate work
orders, you can modify this default value to match the value in your environment.

Procedure
1. In the External Systems application, select the PLUSYEXTSYS external system.
2. From the Select Action menu, select Setup Integration Controls.
3. In the Setup Integration Control window, click the Edit Detail icon for the
PLUSYWOPRIORITY integration control.
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4. In the Value Control window, change the default value to match your
implementation.
5. Click OK to save your changes.
Related reference:
“Enterprise service for processing inbound work orders” on page 98
The PLUSYWO enterprise service receives work task data from IBM TRIRIGA and
maps the data to the structure and formats that are specified in the PLUSYWOFR
object structure.

Maintaining work tasks in IBM TRIRIGA
Work orders in Maximo Asset Management correspond to work tasks in IBM
TRIRIGA. When you configure IBM TRIRIGA work tasks, you can choose which
work tasks to integrate with Maximo Asset Management. When these work tasks
become active, Maximo Asset Management work orders are created.

About this task
You can apply IBM TRIRIGA work task templates to create work task records with
prepopulated data. When you configure IBM TRIRIGA work task templates to
integrate with Maximo Asset Management, the generated work task records are
also preset to integrate with Maximo Asset Management.
If you do not apply IBM TRIRIGA work task templates, you can directly create and
configure IBM TRIRIGA work task records to integrate with Maximo Asset
Management. When the configured records change from a Draft status to an
Active status, Maximo Asset Management work orders are created.

Procedure
1. Select the work task template or record.
Item

Action

Template

Select Projects > Set Up > Task Templates > Work Task.

Record

Select Tasks > Manage Tasks > Work Task.

2. Open the work task template or record.
Item

Action

New template or record

Click the Add action. After you specify the required details,
create the template or draft.

Existing template or
record

Open an existing template or draft.

3. Select the Integrate to Maximo check box.
4. After you specify any additional details, save the template or activate the
record.
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Related tasks:
“Maintaining work tasks in IBM TRIRIGA” on page 55
Work orders in Maximo Asset Management correspond to work tasks in IBM
TRIRIGA. When you configure IBM TRIRIGA work tasks, you can choose which
work tasks to integrate with Maximo Asset Management. When these work tasks
become active, Maximo Asset Management work orders are created.
Related reference:
“Components for outbound integration of work orders” on page 99
Maximo Integrators for TRIRIGA installs an object structure on Maximo Asset
Management that defines the format and structure of work order data to send to
IBM TRIRIGA. Predefined publish channels process outbound work order data and
send it to IBM TRIRIGA.
“IBM TRIRIGA integration components” on page 107
IBM Maximo Integrators for TRIRIGA installs predefined components on IBM
TRIRIGA to support integration with Maximo Asset Management.
Related information:
IBM TRIRIGA 10 Space and Move Management User Guide

Integrating service request data
You can integrate service request data from Maximo Asset Management to work
requests in IBM TRIRIGA. The integration updates service requests in Maximo
Asset Management with status information from IBM TRIRIGA work requests.
Related reference:
“Components for service request integration” on page 103
The service request interface includes object structures that define the format and
structure of integration data, a publish channel that processes and sends outbound
data, and an enterprise service that receives and processes inbound data. The
publish channel and enterprise service use processing rules and integration
controls to ensure that data is correctly mapped.

Service request integration overview
When you integrate service requests, you transfer service requests that are related
to space management from Maximo Asset Management to work requests in IBM
TRIRIGA. You can also start a work request in IBM TRIRIGA without a
corresponding service request in Maximo Asset Management.
You plan and manage the requests in IBM TRIRIGA and the integration transfers
the resulting work tasks to Maximo Asset Management as work orders. When
work orders are complete, the integration updates the task status in IBM TRIRIGA.
When the task is completed in IBM TRIRIGA, the integration updates the status of
the service requests in Maximo Asset Management.
Table 10. Activities in integrating service request data
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Integration activity

Description

Service requests from Maximo Asset
Management are transferred to IBM
TRIRIGA work requests.

Service requests that are related to space
management are integrated to IBM TRIRIGA,
where they become work requests.

The statuses of work requests in IBM
TRIRIGA are transferred to Maximo
Asset Management service requests.

The integration transfers status information from
completed work requests in IBM TRIRIGA to
update the status of the corresponding service
requests in Maximo Asset Management.

Integration configuration of service request data
When you integrate service request data, you must first configure the
integration-related data. Some integration-related data might apply to the
processing of service request data in one direction or both directions.

Service request status
The integration is configured to support the transfer of a service request from
Maximo Asset Management to IBM TRIRIGA. Integration is based on a match
between the status of the service request and the status that is configured in the
PLUSYSRSTATUS integration control. After a service request is loaded from
Maximo Asset Management to IBM TRIRIGA, the service request cannot be sent to
IBM TRIRIGA again.
For service request status updates from IBM TRIRIGA to Maximo Asset
Management, the PLUSYSRSTATUSXREF integration control maps the status of the
IBM TRIRIGA work request to the status of the service request in Maximo Asset
Management. The integration does not support sending service requests with a
status of New and the default status is Queued.
Based on your implementation of service request data in Maximo Asset
Management, you might find that the status mapping to the IBM TRIRIGA work
request cannot be done. In this case, you might change or replace this processing
rule with a rule that aligns with your implementation of this data.

Service request person
When you create a service request that you plan to integrate with IBM TRIRIGA,
the person that you select in the Affected User field must have a person record
that is integrated with IBM TRIRIGA. If the selected person is not in an IBM
TRIRIGA location, the IBM TRIRIGA user must identify the location during the
IBM TRIRIGA work request process.
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Related tasks:
“Configuring cross-reference integration controls” on page 27
Cross-reference integration controls are used to map a selection of values in
Maximo Asset Management with corresponding values in IBM TRIRIGA. Before
you integrate space planning, you specify the cross-reference mappings for these
integration controls to match the values that are used in your implementation
environments.
“Configuring integration controls to match domain values” on page 27
The values in many integration controls are validated against values that are
configured for associated domains. Before implementation, check that the values in
integration controls match the values in corresponding domains and, if necessary,
change the values in the integration control.
Related reference:
“Components for sending service requests from Maximo Asset Management to
IBM TRIRIGA” on page 103
Predefined object structures and publish channels are provided for the outbound
integration of service requests. The object structures define how service request
data is formatted and sent from Maximo Asset Management to IBM TRIRIGA.
Publish channels process the outbound service request data and send the data to
IBM TRIRIGA.

Ticket templates for service requests that are related to space
management
IBM Maximo Integrators for TRIRIGA installs new ticket templates for service
requests that are related to space management. The ticket templates apply
predefined data to service requests to support the integration of service requests
from Maximo Asset Management to IBM TRIRIGA.
When you create a service request that is related to space management in Maximo
Asset Management, you must apply an IBM TRIRIGA ticket template to generate
the service request. The service request data is then integrated to IBM TRIRIGA.
You can update the ticket templates with data, such as a common description, so
that your work requests contain consistent data when processed in IBM TRIRIGA.
If you use the Service Requests application, you can use the IBM TRIRIGA ticket
templates without modifying the application.
If you use the self-service Create Service Request application, you must modify the
self-service View Service Request application to support the additional fields in
IBM TRIRIGA ticket templates.
To show the IBM TRIRIGA Request ID to Maximo Asset Management users, add
the PLUSYID field to the self-service View Service Request application as a
read-only field.
To use the ticket templates that are provided for IBM TRIRIGA requests in the
Create Service Request application, you configure the Start Center in Maximo Asset
Management. For each IBM TRIRIGA ticket template that you plan to use, add an
action that uses the Create Service Request application to the Quick Insert portlet.
You can associate the IBM TRIRIGA ticket template with the action link.
To process the service request using the template and to initiate the sending of the
service request to IBM TRIRIGA, you must assign the owner group on the
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template. When you save the service request, the status is set to QUEUED and the
integration sends the service request to IBM TRIRIGA.
IBM Maximo Integrators for TRIRIGA installs the following ticket templates in
Maximo Asset Management.
Ticket template

Description

Class

Status

Form

PLUSYNDSP

TRIRIGA Need
Space

SR

ACTIVE

triNeedSpace

PLUSYRTSP

TRIRIGA Return SR
Space

ACTIVE

triReturnSpace

PLUSYCHSP

TRIRIGA
Change Space

SR

ACTIVE

triChangeSpace

PLUSYMVSVC

TRIRIGA Move
Service

SR

ACTIVE

triMoveServices

PLUSYNWPER

TRIRIGA New
Hire

SR

ACTIVE

triAddPerson

PLUSYRMPER

TRIRIGA
Remove Person

SR

ACTIVE

triRemovePerson

PLUSYCHPER

TRIRIGA
Change Person

SR

ACTIVE

triChangePerson

You can use ticket templates to prompt the user that enters the service request to
provide specific information.
You can enter text to a maximum length of 700 characters in the template to
specify information for the user to add in the Long Description field in a service
request. The information that the user enters is visible to the IBM TRIRIGA user
when they use the request to create a work task.
Table 11. Example of information requests in ticket templates
Ticket Template

Information request

PLUSYNDSP

Please capture the following information
1. Date Space is Needed
2. Number of People
3. Construction Needed?
4. Space Requirements
5. Special Requirements
6. Move Request Class (Small, Individual, Group)
7. Other Details

PLUSYRTSP

Please capture the following information
1. Effective Date of Return
2. Emergency - Immediate Service Required (Y/N)
3. Location to be relinquished
4. Move Request Class (Small, Individual, Group)
5. Other Details

PLUSYCHSP

Please capture the following information
1.Emergency Request?
2. Move Request Class (Small, Individual, Group)
3. Other Details

Chapter 5. Configuring integration interfaces

59

Table 11. Example of information requests in ticket templates (continued)
Ticket Template

Information request

PLUSYMVSVC

Please capture the following information
1. Reason for Move
2. The Move-To location
3. List of Assets to be Moved
4. Proposed Move Date
5. Other Details

PLUSYNWPER

Please capture the following information
1. Reason for addition
2. Emergency - Immediate Service Required (Y/N)
3. Effective Start Date
4. Space Modification Required?
5. Other Details

PLUSYRMPER

Please capture the following information
1. Emergency - Immediate Service Required (Y/N)
2. Effective Departure Date
3. Reason
4. Person has Equipment to Return
5. Person has Keys to Return

PLUSYCHPER

Please capture the following information
1. Reason for Change
2. Effective Date of Change
3. Other Details

IBM Maximo Integrators for TRIRIGA updates the TCKT2TCKT domain and the
TKTEMPLATE domain with more column mappings between the ticket template
and the service request.
Domain

Column mapping

TCKT2TCKT

PLUSYMOVEFORM

TKTEMPLATE

v PLUSYMOVEFORM
v DESCRIPTION
v DESCRIPTION_LONGDESCRIPTION

Related information:
Quick Insert portlet
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Chapter 6. Customizing and configuring Maximo Integrators
for TRIRIGA
Maximo Integrators for TRIRIGA provides opportunities to customize and
configure the integration to meet your business needs. You can configure
cross-reference controls for many-to-one mapping, change the currency type,
remove data from the integration, and add fields to the integration.

Configuring cross-reference controls for many-to-one mapping
If your implementation includes a one-to-many mapping from Maximo Asset
Management to IBM TRIRIGA, you must ensure that the external system is
configured for a many-to-one mapping.

About this task
Cross-reference controls are used to map data between Maximo Asset Management
and IBM TRIRIGA. In some cases one control can be used to map a field value for
data that is exchanged bidirectionally. However, when a mapping is needed from
many values to a single value, the integration control can no longer support
bidirectional mapping and a second control needs to be implemented, one for each
direction.
For example, the PLUSYEMPTYPEXREF cross-reference control maps person types
in Maximo Asset Management to the following values in IBM TRIRIGA:
Default value in Maximo Asset
Management

Default external value in IBM TRIRIGA

1

triEmployee

2

triConsultant

3

triExternalContact

You can add a 4 default value that also maps to the triExternalContact value. A
message from Maximo Asset Management to IBM TRIRIGA would map the
employee types of 3 and 4 to the IBM TRIRIGA value of triExternalContact.
When a message IBM TRIRIGA contains the triExternalContact value is sent to
Maximo Asset Management, the message is not resolved because the system
cannot identify whether to assign a value of 3 or 4 for the triExternalContact
value.
You can create a second cross-reference control that is used to send data from IBM
TRIRIGA to Maximo Asset Management. After you set up the second control, you
change the processing rule on the enterprise service to use the second control.

Procedure
1. In Maximo Asset Management, in the Enterprise Services application, from the
Select Action menu, select Create Integration Control.
2. From the Select Action menu, select Associate Integration Controls, and
associate the control with the enterprise service.
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3. In the External System application, assign the values for the cross-reference
integration control.
Related tasks:
“Configuring cross-reference integration controls” on page 27
Cross-reference integration controls are used to map a selection of values in
Maximo Asset Management with corresponding values in IBM TRIRIGA. Before
you integrate space planning, you specify the cross-reference mappings for these
integration controls to match the values that are used in your implementation
environments.
Related information:
Integration controls

Changing currency types
Most transactions between Maximo Asset Management and IBM TRIRIGA send a
currency value. The default value for the type of currency is US Dollars, which is
case-sensitive.

About this task
For property locations, the Site record has a field that populates the currency
value. For all other integration points, a processing rule automatically sets the
currency value to US Dollars.
Any currency that you plan to use must exist in the master list of currencies that
are supported in IBM TRIRIGA. To view the master list of currencies, in IBM
TRIRIGA Application Platform, select Tools > Administration > Lists, and in the
Manage By panel, select Currency. For more information on the master list, refer to
Chapter 13, "Lists" in the IBM TRIRIGA 10 Application Administration User Guide.

Procedure
1. In the Application Designer, open the Site dialog box for the Organizations
application, and add a field so that users can select the currency value.
2. For all other integration points, in the Publish Channel application, change the
processing rule to use a customer-defined condition to set the currency value.
You can change the default value from US Dollars to another currency, or you
can conditionally assign US Dollars and another currency.
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Related reference:
“Publish channel for the initial export of property locations” on page 68
The PLUSYPROP publish channel loads initial location property data from Maximo
Asset Management based on the data mappings that are specified in the
PLUSYPROP object structure.
Related information:
IBM TRIRIGA 10 Application Administration User Guide

Returning management of data from IBM TRIRIGA to Maximo Asset
Management
When you integrate Maximo Asset Management and IBM TRIRIGA, you
synchronize data for locations, assets, and people. Because IBM TRIRIGA manages
the integrated data, what you can do with that data in Maximo Asset Management
is limited. You can remove the link between the two systems for certain data,
which returns the data to Maximo Asset Management.

Before you begin
Before you can remove data for an individual asset or person, you first must
change the security configuration for the PLUSYID external ID value so that the
field can be updated. You must also set the PLUSYID external ID value to null.

About this task
You might find that some data was integrated erroneously or does not belong to
the integration because of subsequent business decisions.
For example, in the initial load of data from Maximo Asset Management to IBM
TRIRIGA, you exported data using a WHERE clause that sent all records for a site
to IBM TRIRIGA, but now you find that you do not want some of those records
under IBM TRIRIGA management.

Procedure
1. In IBM TRIRIGA, remove all assets from the location.
2. In IBM TRIRIGA, remove all persons from the location.
3. In IBM TRIRIGA, remove the location from the hierarchy. The data is returned
to Maximo Asset Management, and the ID field and Locklevel field in Maximo
Asset Management are set to null.

Customizing integration points to add fields
You can add new fields to the integration points and user interface. For example,
you can include additional fields that exist on the asset object so that users can
view these attributes in IBM TRIRIGA. You can add new fields to the integration
points that are used to support the initial load of portfolio data through IBM
TRIRIGA DataConnect and also the integration points that support ongoing
updates between Maximo Asset Management and IBM TRIRIGA.
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Adding new fields to the integration staging tables
The initial load of data from Maximo Asset Management to IBM TRIRIGA is done
through the staging tables that are provided by IBM TRIRIGA DataConnect. The
staging tables are predefined but you can customize them to include additional
fields for the integration.

About this task
To enhance an integration point with additional fields, add the columns to the
Maximo object structure that supports the integration point. Then, add the
corresponding column with the same name to the IBM TRIRIGA staging table.
Finally, add this new column in the appropriate IBM TRIRIGA form.

Procedure
1. To add an attribute to a Maximo object, in Maximo Asset Management, in the
Database Configuration application, add a column to the database for the new
field.
2. If you want to add an attribute to a Maximo object, in the Application Designer
application, add the field to the user interface.
3. To include the column in the Maximo object structure, modify the object
structure to include the column in the object structure. Then, assign the alias
value to the field. The alias value must match the name of the new column that
is added to the corresponding staging table in IBM TRIRIGA. Because table
column names are defined in uppercase letters, the object structure must also
be defined in uppercase letters.

What to do next
In IBM TRIRIGA, edit the business object and select the Has Staging Table check
box.
Related tasks:
“Adding fields to business objects in IBM TRIRIGA” on page 65
You can customize Maximo Integrators for TRIRIGA by adding new fields to the
business objects in IBM TRIRIGA. For example, you can add fields to a business
object to capture more data that is required for your business processes.
Related information:
Application Building for the IBM TRIRIGA Application Platform 3: Data
Management

Adding new fields to ongoing integrations
You can add new fields to the integration points between Maximo Asset
Management and IBM TRIRIGA. Integration points can be bidirectional or one
way.

Adding new fields to IBM TRIRIGA for ongoing updates
In Maximo Asset Management, you modify the object structure for the enterprise
service to include the new fields to send to IBM TRIRIGA. Then, in IBM TRIRIGA,
you add the new field to the integration object.
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Procedure
1. In Maximo Asset Management, in the Enterprise Service application, modify
the object structure that supports receiving assets from IBM TRIRIGA to include
the new columns.
2. In IBM TRIRIGA, select Tools > System Setup > Integration Objects and open
the integration object for the business object that is sent to Maximo Asset
Management.
3. In IBM TRIRIGA, select My Reports, and in the System Reports tab, add the
field to the query for the integration object.
a. In the Columns tab, select the field to add to the XML.
b. If necessary, edit the label for the field to match the label value that is sent
to Maximo Asset Management.
4. Optional: If customization is required for the XML generation, open the
integration object, and in the General tab, in the Query for Outbound section,
in the XSLT field, download, edit, and update the XLS file.
5. If any customization is required to send data, select Tools > Builder Tools >
Workflow Builder, open the integration workflow, and verify that the
integration workflow is correct. The integration workflow is typically named
objectname - triActivate - Integration - Maximo Integration.
Related tasks:
“Adding fields to business objects in IBM TRIRIGA”
You can customize Maximo Integrators for TRIRIGA by adding new fields to the
business objects in IBM TRIRIGA. For example, you can add fields to a business
object to capture more data that is required for your business processes.

Adding new fields to Maximo Asset Management for ongoing
updates
In Maximo Asset Management, you modify the object structure for the publish
channel or enterprise service. Then, in IBM TRIRIGA, you add the new field to the
integration object.

Procedure
1. Determine which object structure is used by the publish channel or enterprise
service.
2. In Maximo Asset Management, in the Object Structures application, modify the
object structure to include the new column that is integrated with IBM
TRIRIGA. The alias name must match the actual XML element name that is
supported by the IBM TRIRIGA web service.
3. Optional: If validation is required to process the data in the field, add the
processing rule to the publish channel for outbound messages or to the
enterprise service for inbound messages.

What to do next
Check the data in both directions to ensure that messages are sent correctly.

Adding fields to business objects in IBM TRIRIGA
You can customize Maximo Integrators for TRIRIGA by adding new fields to the
business objects in IBM TRIRIGA. For example, you can add fields to a business
object to capture more data that is required for your business processes.
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About this task
Published business objects are read-only until you click the Revise BO link.
Unpublished business objects are editable.

Procedure
1. In the Data Modeler tool, hover over the Object Browser, and select the
module folder and business object.
2. If the business object is published, click the Revise BO link.
3. Add the field.
Option

Description

If the field exists in another business
object

Locate the field, click the selection box for
the field, and then, in the Field List window,
click Accept.

If the field is new

Click Add, specify the field type and name,
modify the settings, and save the field.

4. Select the Has staging table check box to identify the field as part of the
integration.
5. Publish the business object to activate your changes.
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Chapter 7. Reference information
Maximo Asset Management integration components
The reference information for each interface describes the predefined integration
components that Maximo Asset Management uses to map and process data.

Components for location integration
Location integration components include object structures that define the format
and structure of integration data, publish channels that process and send outbound
data, and an enterprise service that receives and processes inbound data. The
publish channels and enterprise service use processing rules and integration
controls to ensure that data is correctly mapped.
Table 12. Predefined location integration components on Maximo Asset Management
Object structure

Channel or service

Description

PLUSYPROP

PLUSYPROP
publish channel

Initial load of property data from Maximo Asset Management to
IBM TRIRIGA

PLUSYBDLG

PLUSYBDLG
publish channel

Initial load of building data from Maximo Asset Management to
IBM TRIRIGA

PLUSYFLOOR

PLUSYFLOOR
publish channel

Initial load of floor data from Maximo Asset Management to IBM
TRIRIGA

PLUSYSPACE

v PLUSYSPACE
publish channel

v Initial load of space data from Maximo Asset Management to
IBM TRIRIGA

v PLUSYSSPACE
publish channel

v Initial load of subspace data from Maximo Asset Management to
IBM TRIRIGA

PLUSYLOCHIER
enterprise service

Initial and ongoing loads of location data to Maximo Asset
Management from IBM TRIRIGA

PLUSYLOCHIER,
PLUSYLOCSYS

Components for the initial load of location data from Maximo
Asset Management to IBM TRIRIGA
IBM Maximo Integrators for TRIRIGA installs object structures on Maximo Asset
Management that define the format and structure of location data to send to IBM
TRIRIGA. Predefined publish channels process batch exports of location data to
send to IBM TRIRIGA staging tables that are installed by IBM Maximo Integrators
for TRIRIGA.
Outbound data mapping for initial load of property locations:
The PLUSYPROP object structure specifies the property location data that is
mapped from a Maximo Asset Management site to an IBM TRIRIGA property.
The PLUSYPROP object structure is based on the site object. Alias values for
attributes in the object structure identify the corresponding field names for the IBM
TRIRIGA S_TRIPROPERTY staging table. In some cases, the object structure
attribute acts as a placeholder to populate a field in the IBM TRIRIGA staging
table. In these cases, the value for the field is provided by a publish channel and
not from the value in the field in Maximo Asset Management. The following table
shows the attributes and alias values that are configured for property (site)
locations in the object structure.
© Copyright IBM Corp. 2013
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Table 13. Attributes and alias values in the PLUSYPROP object structure
Attribute

Alias
IBM TRIRIGA staging table column

Set by publish channel

DESCRIPTION

TRINAMETX

No

SITEID

TRIIDTX

No

DESCRIPTION_LONGDESCRIPTION TRIDESCRIPTIONTX

No

PLUSYCURRENCYUOM

TRICURRENCYUO

Yes

PLUSYAREAUOM

TRIAREAUO

Yes

PLUSYLENGTHUOM

TRILENGTHUO

Yes

ORGID

PLUSYMAXIMOORGCL

Yes

ENTERBY

DC_PATH

Yes

CHANGEBY

PLUSYIDTX

Yes

Publish channel for the initial export of property locations:
The PLUSYPROP publish channel loads initial location property data from Maximo
Asset Management based on the data mappings that are specified in the
PLUSYPROP object structure.
The PLUSYPROP publish channel uses the PLUSYEXTSYS external system to send
property to IBM TRIRIGA. The PLUSYEXTSYS external system sends the data via
the PLUSYDC endpoint to populate fields in the S_TRIPROPERTY staging table.
Processing rules are configured on the PLUSYPROP publish channel to support
data processing.
Processing rule 10 checks that the site records that you export are configured for
integration with IBM TRIRIGA. If the value of the PLUSYINT field is not set to 1
(true), a SKIP action is applied and the record is not included in the batch export
to the S_TRIPROPERTY staging table.
Processing rule 20 uses a SET action to provide the values for a number of fields:
v The rule sets the default currency value in the PLUSYCURRENCYUOM field.
The default currency value in IBM TRIRIGA is US Dollars and is case-sensitive.
You can customize Maximo Asset Management and IBM TRIRIGA if you want
to provide a different currency value.
v The rule sets the default unit of measure for area in the PLUSYAREAUOM field.
The default unit of measure in IBM TRIRIGA is square-feet and is
case-sensitive.
v The rule sets the default unit of measure for length in the PLUSYLENGTHUOM
field. The default value in IBM TRIRIGA is feet and is case-sensitive.
v The rule sets the default filepath to the location record in the ENTERBY field in
Maximo Asset Management which is used to populate the DC_PATH field in the
IBM TRIRIGA staging table. The default value is \Locations and is case
sensitive.
Processing rule 30 uses a COMBINE action to set the Maximo Asset Management
external key which is used to populate the PLUSYIDTX field in the IBM TRIRIGA
staging table.
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Related tasks:
“Changing currency types” on page 62
Most transactions between Maximo Asset Management and IBM TRIRIGA send a
currency value. The default value for the type of currency is US Dollars, which is
case-sensitive.
Outbound data mapping for the initial load of building locations:
The PLUSYBLDG object structure specifies how building location data is mapped
from a Maximo Asset Management location to an IBM TRIRIGA building.
The PLUSYBLDG object structure is based on the locations object. Alias values for
attributes in the object structure identify the corresponding field names for the IBM
TRIRIGA S_TRIBUILDING staging table. In some cases, the object structure
attribute acts as a placeholder to populate a field in the IBM TRIRIGA staging
table. In these cases, the value for the field is provided by a publish channel and
not from the value in the field in Maximo Asset Management. The following table
shows the attributes and alias values that are configured for building locations in
the object structure.
Table 14. Attributes and alias values for locations in the PLUSYBLDG object structure
Attribute

Alias
IBM TRIRIGA staging table column

Set by publish
channel

DESCRIPTION

TRINAMETX

No

LOCATION

TRIIDTX

No

DESCRIPTION_LONGDESCRIPTION TRIDESCRIPTIONTX

No

SITEID

TRIPARENTPROPERTYTX

Yes

PLUSYSTARTDATE

TRIACTIVESTARTDA

No

PLUSYID

PLUSYIDTX

Yes

LOCATIONSID

PLUSYRECORDIDTX

No

ORGID

DC_PATH

Yes

Publish channel for the initial export of building locations:
The PLUSYBLDG publish channel loads initial building location data from Maximo
Asset Management based on the data mappings that are specified in the
PLUSYBLDG object structure.
The PLUSYBLDG publish channel uses the PLUSYEXTSYS external system to send
building data to IBM TRIRIGA. The PLUSYEXTSYS external system sends the data
via the PLUSYDC endpoint to populate fields in the S_TRIBUILDING staging
table.
Processing rules are configured on the publish channel to support data processing.
Processing rule 10 applies a SKIP action to any records that do not meet all of the
following conditions:
v If the value in the PLUSYLOCHLEVEL field is not equal to 10, the location is
not configured as a building location and the record is not processed for export.
v If the value of the PLUSYID field is not null, the building location has already
been loaded to IBM TRIRIGA.
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v If the value of the PLUSYINT attribute for the associated site is not 1 (one), the
building is not within a site that is configured for integration with IBM
TRIRIGA.
Processing rule 20 uses a SET action to provide \Locations as an initial value in
the ORGID field in Maximo Asset Management.
Processing rule 30 uses COMBINE actions to set values in the PLUSYID field. The
PLUSYID field provides the external key of the Maximo Asset Management record
to the PLUSYIDTX field in the S_TRIBUILDING staging table. The rule combines
the values in the LOCATION and SITEID fields and uses a tilde (~) character as
the separator. The separator value is specified in the PLUSYDELIM integration
control. The PLUSYDELIM integration control is associated with the PLUSYBLDG
publish channel.
The processing class for the publish channel performs additional logic to support
data mapping.
Outbound data mapping for the initial load of floor locations:
The PLUSYFLOOR object structure specifies the floor location data that is mapped
from a Maximo Asset Management location to an IBM TRIRIGA floor.
The following table shows the objects in the PLUSYFLOOR object structure.
Table 15. Objects in the PLUSYFLOOR object structure
Object

Parent

Relationship

LOCATIONS

Parent object in the object
structure

None

LOCHIERARCHY

LOCATIONS

PLUSYSITE

LOCANCESTOR

LOCHIERARCHY

PLUSYFLOOR

The PLUSYFLOOR object structure uses relationships to identify related locations
that are further up in the location hierarchy. The following table describes these
relationships.
Table 16. Relationships used by the PLUSYFLOOR object structure
Relationship
name

Parent

Child

Description

PLUSYSITE

LOCATIONS

LOCHIERARCHY

Provides the IBM TRIRIGA locations hierarchy
from the value in the PLUSYSYSTEMID field on
the SITE table. This field only contains a value if
the site is enabled for integration with IBM
TRIRIGA.

PLUSYFLOOR

LOCHIERARCHY

LOCANCESTOR

Provides the building location that is the parent of
the floor location from the value in the
LOCANCESTOR.ANCESTOR field.

The PLUSYFLOOR object structure is based on the locations, lochierarchy, and
locancestor objects. Alias values for attributes in the object structure identify the
corresponding field names for the IBM TRIRIGA S_TRIFLOOR staging table. In
some cases, the object structure attribute acts as a placeholder to populate a field in
the IBM TRIRIGA staging table. In these cases, the value for the field is provided
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by a publish channel and not from the value in the field in Maximo Asset
Management. The following table shows the attributes and alias values that are
configured for floor locations in the object structure.
Table 17. Attributes and alias values for floor locations in the PLUSYFLOOR object structure
Set by
publish
channel

Object

Attribute

Alias
IBM TRIRIGA staging table column

LOCATIONS

DESCRIPTION

TRINAMETX

No

LOCATION

TRIIDTX

No

DESCRIPTION_LONGDESCRIPTION

TRIDESCRIPTIONTX

No

SITEID

TRIPARENTPROPERTYTX

Yes

PLUSYID

PLUSYIDTX

Yes

LOCATIONSID

PLUSYRECORDIDTX

No

ORGID

DC_PATH

Yes

LOCHIERARCHY

LOCANCESTOR

LOCATION

No

SITEID

No

LOCATION

No

SITEID

No

ANCESTOR

TRIPARENTBUILDINGTX

Yes

Publish channel for the initial export of floor locations:
The PLUSYFLOOR publish channel loads initial floor location data from Maximo
Asset Management based on the data mappings that are specified in the
PLUSYFLOOR object structure.
The PLUSYFLOOR publish channel uses the PLUSYEXTSYS external system to
send property data to IBM TRIRIGA. The PLUSYEXTSYS external system sends the
data via the PLUSYDC endpoint to populate fields in the S_TRIFLOOR staging
table. The PLUSYFLOOR publish channel manages the export of floor locations to
the S_TRIFLOOR staging table.
Processing rules are configured for the PLUSYFLOOR publish channel to to
support data processing.
Processing rule 10 uses a SKIP action to remove any records from the export that
do not meet the following conditions:
v The value in the PLUSYLOCHLEVEL field must be 20 to indicate that the
location is configured as a floor in the IBM TRIRIGA location hierarchy.
v The value in the PLUSYID field must be null. If the value is not null, this
indicates that the record has already been integrated with IBM TRIRIGA.
Processing rule 20 uses a COMBINE action to provide the external key value of the
Maximo Asset Management record to populate the PLUSIDTX field in the
S_TRIFLOOR staging table. The rule combines the values in the LOCATION and
SITEID fields and uses the separator value that is specified in the PLUSYDELIM
integration control. The PLUSYDELIM integration control is associated with the
publish channel.
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The processing class for the publish channel sets the location hierarchy value in the
ORGID field that is used to populate the DC_PATH field in the staging table. The
processing class also supports the mapping of the parent location fields for the
staging table.
Outbound data mapping for the initial load of space and subspace locations:
The PLUSYSPACE object structure specifies the space and subspace location data
that is mapped from Maximo Asset Management to IBM TRIRIGA.
The PLUSYSPACE object structure provides the data for the PLUSYSPACE and
PLUSYSSPACE publish channels. The following table lists the objects in the
PLUSYSPACE object structure.
Table 18. Objects in the PLUSYSPACE object structure
Object

Parent

Relationship

LOCATIONS

Is the parent object in the
object structure

None

LOCHIERARCHY

LOCATIONS

PLUSYSITE

LOCANCESTOR

LOCHIERARCHY

v PLUSYSPACE
v PLUSYSSPACE

The PLUSYSPACE object structure uses relationships to identify related locations
that are further up in the location hierarchy. The following table describes these
relationships.
Table 19. Relationships used by the PLUSYSPACE object structure
Relationship
name

Parent

Child

Description

PLUSYSITE

LOCATIONS

LOCHIERARCHY

Provides the IBM TRIRIGA location hierarchy from the
value in the PLUSYSYSTEMID field on the SITE table.
This field only contains a value if the site is enabled for
integration with IBM TRIRIGA.

PLUSYSPACE

LOCHIERARCHY LOCANCESTOR

Navigates up the IBM TRIRIGA location hierarchy in
Maximo Asset Management to identify the floor that is
the parent of the location. This floor location is set in the
LOCANCESTOR.ANCESTOR field and the value is also
set in the TRIPARENTFLOORTX field in the
S_TRISPACE staging table.

PLUSYSSPACE

LOCHIERARCHY LOCANCESTOR

This relationship is used by a processing class on the
PLUSYSSPACE publish channel only. Navigates up the
IBM TRIRIGA location hierarchy in Maximo Asset
Management to identify the space that is the parent of
the location. This space location is set in the
LOCANCESTOR.ANCESTOR field and the value is also
set in the PLUSYPARENTSPACETX field in the
S_TRISPACE staging table. If the parent of the subspace
is not a space (30) but rather a floor (20), the value in the
PLUSYPARENTSPACETX field is set to null.

The PLUSYSPACE object structure is based on the locations, lochierarchy, and
locancestor objects. Alias values for attributes in the object structure identify the
corresponding field names for the IBM TRIRIGA S_TRISPACE staging table. In
some cases, the object structure attribute acts as a placeholder to populate a field in
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the IBM TRIRIGA staging table. In these cases, the value for the field is provided
by a publish channel and not from the value in the field in Maximo Asset
Management. The following table shows the attributes and alias values that are
configured for space and subspace locations in the object structure.
Table 20. Attributes and alias values for space and subspace locations in the PLUSYSPACE object structure

Object

Attribute

Alias
IBM TRIRIGA staging table
column

LOCATIONS

DESCRIPTION

TRINAMETX

No

LOCATION

TRIIDTX

No

DESCRIPTION_LONGDESCRIPTION

TRIDESCRIPTIONTX

No

SITEID

TRIPARENTPROPERTYTX

Yes

PLUSYID

PLUSYIDTX

Yes

LOCATIONSID

PLUSYRECORDIDTX

Yes

OWNERSYSID

TRIPARENTBUILDINGTX

Yes

ORGID

DC_PATH

Yes

EXTERNALREFID

PLUSYPARENTSPACETX

Yes

TRIPARENTFLOORTX

Yes

LOCHIERARCHY

Set by
publish
channel

LOCATION
SITEID

LOCANCESTOR

LOCATION
SITEID
ANCESTOR

Publish channels for the initial export of space and subspace locations:
The PLUSYSPACE publish channel loads initial space location data and the
PLUSYSSPACE publish channel loads initial subspace location data from Maximo
Asset Management. Both publish channels use the data mappings that are specified
in the PLUSYSPACE object structure.
PLUSYSPACE publish channel
The PLUSYSPACE publish channel uses the PLUSYEXTSYS external system to
send property data to IBM TRIRIGA. The PLUSYEXTSYS external system sends the
data via the PLUSYDC endpoint to populate fields in the S_TRISPACE staging
table.
Processing rules are configured for the PLUSYSPACE publish channel to support
data processing.
Processing rule 10 uses a SKIP action to remove any records from the export that
do not satisfy the following conditions:
v The value in the PLUSYLOCHLEVEL field must be 30 to indicate that the
location is configured as a space in the IBM TRIRIGA location hierarchy.
v The value in the PLUSYID field must be null. If the value is not null, this
indicates that the record has already been integrated with IBM TRIRIGA.
Processing rule 20 uses a COMBINE action to provide the external key value of the
Maximo Asset Management record to populate the PLUSIDTX field in the
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S_TRISPACE staging table. The rule combines the values in the LOCATION and
SITEID fields and uses the separator value that is specified in the PLUSYDELIM
integration control. The PLUSYDELIM integration control is associated with the
publish channel.
Processing rule 30 uses a SET action to set a null value in the EXTERNALREFID
field in Maximo Asset Management and in the PLUSYPARENTSPACETX field in
the staging table. The EXTERNALREFID field is populated only by the subspace
publish channel.
The processing class for the publish channel sets the location hierarchy value in the
ORGID field that is used to populate the DC_PATH field in the staging table. The
processing class also provides support for mapping parent-related fields.
PLUSYSSPACE publish channel
The PLUSYSSPACE publish channel uses the PLUSYEXTSYS external system to
send property data to IBM TRIRIGA. The PLUSYEXTSYS external system sends the
data via the PLUSYDC endpoint to populate fields in the S_TRISPACE staging
table.
Processing rules are configured for the PLUSYSSPACE publish channel to support
data processing.
Processing rule 10 uses a SKIP action to remove any records from the export that
do not satisfy the following conditions:
v The value in the PLUSYLOCHLEVEL field must be 40 to indicate that the
location is configured as a subspace in the IBM TRIRIGA location hierarchy.
v The value in the PLUSYID field must be null. If the value is not null, this
indicates that the record has already been integrated with IBM TRIRIGA.
Processing rule 20 uses a COMBINE action to provide the external key value of the
Maximo Asset Management record to populate the PLUSIDTX field in the
S_TRISPACE staging table. The rule combines the values in the LOCATION and
SITEID fields and uses the separator value that is specified in the PLUSYDELIM
integration control. The PLUSYDELIM integration control is associated with the
publish channel.
The processing class for the publish channel sets the location hierarchy value in the
ORGID field that is used to populate the DC_PATH field in the staging table.
The processing class uses the PLUSYSSPACE relationship to determine if the
subspace location has a parent space location. If a parent space location exists, the
location description is set in the EXTERNALREFID field that is used to populate
the PLUSYPARENTSPACETX field in the staging table.

Components for creating and updating location data in Maximo
Asset Management from IBM TRIRIGA
IBM Maximo Integrators for TRIRIGA provides two object structures, an enterprise
service, processing rules, and integration controls for synchronizing IBM TRIRIGA
location data into Maximo Asset Management.
Inbound data mapping for creating and updating location data:
The PLUSYLOCHIER object structure specifies how location data is mapped from
IBM TRIRIGA to Maximo Asset Management, including property, building, floor,
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space, and subspace locations. The PLUSYLOCSYS object structure specifies how
the data for a new property in IBM TRIRIGA is mapped to create a corresponding
site in Maximo Asset Management.
When locations are created or updated in Maximo Asset Management, the
locations are configured within the PLUSYSYS hierarchy system which represents
the IBM TRIRIGA location hierarchy. You can also configure locations in other
hierarchy systems within Maximo Asset Management.
PLUSYLOCHIER object structure
The object structure includes the following source objects:
v The LOCATIONS object is the parent object of the object structure.
v The LOCHIERIERARCHY object is set as a child object of the LOCATIONS
object.
The fields that are mapped for inbound messages vary depending upon the
location hierarchy level of the inbound record.
The following table shows the field mapping for property records.
Table 21. Field mapping for inbound property records
Maximo Asset Management

IBM TRIRIGA

PLUSYRECORDID

triRecordIdSY

DESCRIPTION

triNameTX

LOCATION

triIdTX

DESCRIPTION_LONGDESCRIPTION

triDescriptionTX

STATUS

triStatusCL

PLUSYORGID

plusyMaximoOrgCL

The following table shows the field mapping for building records.
Table 22. Field mapping for inbound building records
Maximo Asset Management

IBM TRIRIGA

DESCRIPTION

triNameTX

SITEID

triParentPropertyTX

LOCATION

triIdTX

DESCRIPTION_LONGDESCRIPTION

triDescriptionTX

STATUS

triStatusCL

PLUSYRECORDID

triRecordIdSY

PLUSYORGID

plusyMaximoOrgCL

The following table shows the field mapping for floor, space, and subspace records.
Table 23. Field mapping for inbound floor, space, and subspace records
Maximo Asset Management

IBM TRIRIGA

PLUSYID

triIdTX

PLUSYRECORDID

triRecordIdSY
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Table 23. Field mapping for inbound floor, space, and subspace records (continued)
Maximo Asset Management

IBM TRIRIGA

DESCRIPTION

triNameTX

LOCATION

triIdTX

DESCRIPTION_LONGDESCRIPTION

triDescriptionTX

STATUS

triStatusCL

PARENT

triNameTX

SITEID

triNameTX

PLUSYORGID

plusyMaximoOrgCL

PLUSYLOCSYS object structure
The PLUSYLOCSYS object structure is based on the LOCSYSTEM object. The object
structure is used only if the inbound location is a new property that was created in
IBM TRIRIGA that requires the creation of a site in Maximo Asset Management. To
create a site, the LOCSYSTEM object requires values for the following attributes:
v SITEID
v ORGID
v SYSTEMID is set as PLUSYSYS by a processing rule.
v DESCRIPTION is set to TRIRIGA Hierarchy system.
Enterprise service for receiving new and updated location data:
The PLUSYLOCHIER enterprise service receives location data from IBM TRIRIGA
through an integration framework servlet that supports enterprise services.
Processing classes manage site creation for new property locations and changes in
hierarchy values for locations where the parent locations have changed. The values
in some fields are set by processing rules that are associated with the enterprise
service.
The enterprise service can insert new location records, update existing location
records, and create a site and associated location system for a new property that is
created in IBM TRIRIGA.
The PLUSYLOCHIER enterprise service is associated with the PLUSEXTSYS
external system and the URL for the enterprise service is http://hostname:port/
meaweb/es/PLUSYEXTSYS/PLUSYLOCHIER.
Processing rules are configured for the PLUSYLOCHIER enterprise value to ensure
that the correct data is provided.
Processing rule 10 uses a SET action to set the value of the location TYPE field to
OPERATING and the value is case-sensitive.
Processing rule 20 uses a REPLACE action to replace the value in the IBM
TRIRIGA STATUS field with the corresponding status value in Maximo Asset
Management. Status values are mapped by the PLUSYLOCSTATUS cross-reference
integration control that is associated with the PLUSYLOCHIER enterprise service.
After a location record is sent from IBM TRIRIGA to Maximo Asset Management, a
corresponding location record is created in Maximo Asset Management. The
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triRecordIdSY value is appended to the location ID value in the corresponding
location record in Maximo Asset Management to ensure that a unique location ID
is assigned.

Integration controls associated with location integration
components
Publish channels and enterprise services use integration controls to adapt data
formats and structures during the outbound and inbound processing of location
XML messages.
The following table shows the integration controls that are associated with location
integration components:
Table 24. Integration controls that are associated with location integration components
Domain

Default value

Default
external value

PLUSYPROP,
PLUSYBLDG,
PLUSYFLOOR,
PLUSYSPACE,
PLUSYSSPACE
publish channels

None

~ (tilde)

None

Value

PLUSYBLDG,
PLUSYFLOOR
publish channels

None

\ (backslash)

None

Xref

PLUSYLOCHIER
enterprise service

LOCASSETSTATUS

v OPERATING

v Review In
Progress

Integration control

Type

PLUSYDELIM

Value

PLUSYDELIM2

PLUSYLOCSTATUS

Associated channel
or service

v DECOMMISSIONED

v Retired

Components for asset integration
The asset interface includes object structures that define the format and structure of
integration data, publish channels that process and send outbound data, and an
enterprise service that receives and processes inbound data. The publish channels
and enterprise service use processing rules and integration controls to ensure that
data is correctly mapped.
The following table lists the predefined asset integration components.
Table 25. Predefined asset integration components
Object structure

Channel or service

Description

PLUSYASSETTO

PLUSYASSET publish
channel

Initial load of asset data from
Maximo Asset Management
to IBM TRIRIGA.

PLUSYASSETTO2

PLUSYASSET2 publish
channel

Ongoing load of asset data
from Maximo Asset
Management to IBM
TRIRIGA.

PLUSYASSETFR

PLUSYASSET enterprise
service

Initial and ongoing load of
asset data from IBM
TRIRIGA to Maximo Asset
Management.

IBM Maximo Integrators for TRIRIGA does not support parent-child relationship
data for assets.
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Components for the initial load of asset data from Maximo Asset
Management to IBM TRIRIGA
Predefined object structures and publish channels are provided for the outbound
integration of asset data. The object structures define how asset data is formatted
and sent from Maximo Asset Management to IBM TRIRIGA. Publish channels
process the outbound asset data and send the data to IBM TRIRIGA.
Outbound data mapping for initial load of asset data:
The PLUSYASSETTO object structure specifies how asset data is mapped for the
initial load of data from Maximo Asset Management assets to IBM TRIRIGA assets.
The PLUSYASSETTO object structure is based on the asset object. Alias values for
attributes in the object structure identify the corresponding field names for the IBM
TRIRIGA staging tables. In some cases, the object structure attribute acts as a
placeholder to populate a field in the IBM TRIRIGA staging table. The value for
the field in the IBM TRIRIGA staging table is provided by a publish channel and
not by the field value in Maximo Asset Management.
The following table shows the attributes and alias values that are configured for
the assets in the PLUSYASSETTO object structure.
Table 26. Attributes and alias values in the PLUSYASSETTO object structure
Attribute

Alias value
IBM TRIRIGA field

Set by publish
channel

DESCRIPTION

TRINAMETX

Yes

DESCRIPTION_LONGDESCRIPTION

PLUSYMAXDESCTX

Yes

ASSETNUM

TRIIDTX

Yes

LOCATION

PLUSYPRIMARYLOCATIONTX

Yes

SITEID

PLUSYMAINTLOCTX

Yes

ASSETTYPE

PLUSYASSETYPETX

Yes

STATUS

TRISTATUSCL

Yes

SERIALNUM

TRISERIALNUMTX

No

PLUSYID

PLUSYIDTX

Yes

PLUSYRECORDID

TRIRECORDID

Yes

ASSETUID

PLUSYRECORDIDTX

No

ORGID

TRICURRENCYUO

Yes

REFWO

DC_GUI_NAME

Yes

Publish channel for the initial export of asset data:
The PLUSYASSET publish channel loads initial asset data from Maximo Asset
Management based on the data mappings that are specified in the PLUSYASSETTO
object structure.
The PLUSYASSET publish channel uses the PLUSYEXTSYS external system to send
asset data to IBM TRIRIGA. The PLUSYEXTSYS external system sends the data via
the PLUSYDC end point to populate the fields in the asset-related staging tables.
Table names vary based on the asset type of the asset.
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Processing rules are configured on the PLUSYASSET publish channel to support
data processing.
Processing rule 10 uses a SKIP action on any records that do not meet the
following conditions:
v The processing rule skips any asset record if the asset type of the asset does not
exist in the PLUSYASSETTYPE integration control.
v The processing rule skips any asset record if the value in the PLUSYID field is
not null.
v The processing rule skips any asset record if the value in the
PLUSYLOCHLEVEL field for the asset location does not exist in the
PLUSYLOCHLEVEL integration control. By default, the processing rule skips
assets in locations that are not defined as an IBM TRIRIGA space (30) or
subspace (40) location.
v The processing rule skips any asset record if the asset status does not exist in the
PLUSYASSETSTATUS integration control.
Processing rule 20 uses a SET action on the PLUSYID field to provide the external
key of the Maximo Asset Management record to the IBM TRIRIGA PLUSYIDTX
field of the staging table. This field is populated with the asset number and the
asset site ID separated by the value that is configured in the PLUSYDELIM
integration control.
Processing rule 30 uses a SET action on the ORGID field to set a default currency
value of US Dollars. The processing rule also sets the REFWO field to the asset
type value, the SITEID field to a value of null, and the STATUS field to a default
value of Draft.
Processing rule 40 converts the asset type value that is stored in the REFWO field
to an IBM TRIRIGA value by using the PLUSYTOASSETTYPEXREF integration
control.
Additional processing is performed by the processing class that is configured on
the publish channel.
The publish channel and related integration controls are associated with the
PLUSYEXTSYS external system through the PLUSYDC end point. You can
customize your implementation with different fields or mapping values.

Components for loading and updating asset data to Maximo
Asset Management from IBM TRIRIGA
Maximo Integrators for TRIRIGA includes an object structure, enterprise service,
processing rules, and integration controls for importing and updating IBM
TRIRIGA asset data to Maximo Asset Management.
Inbound data mapping for loading and updating asset data:
The PLUSYASSETFR object structure identifies the asset attributes that are mapped
between IBM TRIRIGA and Maximo Asset Management.
The object structure maps fields in Maximo Asset Management to corresponding
fields in IBM TRIRIGA. Extra processing by the enterprise service might change
the value of certain fields. For example, after an asset record is sent from IBM
TRIRIGA to Maximo Asset Management, a corresponding asset record is created in
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Maximo Asset Management. The triRecordIdSY value is appended to the asset ID
value in the corresponding asset record in Maximo Asset Management to ensure
that a unique asset ID is assigned.
The following table shows the mapping for asset attributes from IBM TRIRIGA to
Maximo Asset Management.
Table 27. Asset attribute mapping
IBM TRIRIGA asset attribute

Maximo Asset Management asset attribute

triIdTX

ASSETNUM

triRecordIdSY

PLUSYRECORDID

triIdTX

PLUSYID

triNameTX

DESCRIPTION

plusyMaxDescTX

DESCRIPTION_LONGDESCRIPTION

triNameTX

LOCATION

triFormNameSY

ASSETTYPE

triStatusCL

STATUS

triSerialNumTX

SERIALNUM

triNameTX

SITEID

triSpecNameTX

PLUSYSPECNAME

Enterprise service for importing and updating asset data:
The PLUSYASSET enterprise service loads the asset data to Maximo Asset
Management from IBM TRIRIGA by using the integration framework servlet.
The PLUSYASSET enterprise service is associated with the PLUSEXTSYS external
system and the URL for the enterprise service is http://hostname:port/meaweb/es/
PLUSYEXTSYS/PLUSYASSET.
Messages for each asset record are processed directly into Maximo Asset
Management in a synchronous manner.
Processing rule 10 applies the following cross-reference controls with the
PLUSYASSET enterprise service to set the values for the asset status and asset
type:
v PLUSYASSETSTATUSXREF
v PLUSYFRASSETTYPEXREF
The integration controls map the values for status and type from IBM TRIRIGA to
the corresponding values in Maximo Asset Management.
After an asset record is sent from IBM TRIRIGA to Maximo Asset Management, a
corresponding asset record is created in Maximo Asset Management. The
triRecordIdSY value is appended to the asset ID value in the corresponding asset
record in Maximo Asset Management to ensure that a unique asset ID is assigned.
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Components for updating asset data from Maximo Asset Management to IBM
TRIRIGA:
After the initial load of asset data is completed, updates and new asset records can
be sent to IBM TRIRIGA through the PLUSYASSET2 publish channel, which uses
the PLUSYASSETTO2 object structure to map the data. Integration controls and
processing rules are used to format and validate the data.
Outbound data mapping for updating asset data:
The PLUSYASSETTO2 object structure maps asset data for ongoing updates to
integrated asset records.
The PLUSYASSETTO2 object structure is used to send ongoing updates to IBM
TRIRIGA. The alias values of the attributes in the PLUSYASSETTO2 object
structure are used to identify the XML element names of the IBM TRIRIGA XML.
Attributes are used in the processing rules and exit classes even when the
attributes do not have an alias value. However, if an attribute does not have an
alias value, the attribute is not part of the XML message to IBM TRIRIGA.
The following table lists the attributes and alias values that are configured for the
PLUSYASSETTO2 object structure.
Table 28. Attributes and alias values in the PLUSYASSETTO2 object structure
Maximo Asset Management attribute

Alias

ASSETNUM

ASSETNUM

DESCRIPTION

triNameTX

DESCRIPTION_LONGDESCRIPTION

plusyMaxDescTX

LOCATION

plusyPrimaryLocationTX

SITEID

plusyMaintLocTX

ASSETTYPE

plusyAssetTypeTX

STATUS

triStatusCL

SERIALNUM

triSerialNumTX

ITEMNUM

plusyIntegrationBL

PLUSYID

plusyIdTX

ASSETUID

plusyRecordIdTX

ORGID

triCurrencyUO

PLUSYRECORDID

PLUSYRECORDID

ITEMSETID

ITEMSETID

REFWO

REFWO

PLUSYSPECNAME

triSpecNameTX

STARTDESCRIPTION

triIdTX

Publish channel for sending updates of asset data:
The PLUSYASSET2 publish channel captures updates to asset records in Maximo
Asset Management and sends the updates to IBM TRIRIGA. Processing rules and
integration controls are used to process and format the data.
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The PLUSYASSET2 publish channel uses object events to capture updates to the
asset data in Maximo Asset Management and to send the updates to IBM
TRIRIGA. The PLUSYASSET2 publish channel is associated with the
PLUSYEXTSYS external system and the PLUSYBC end point to send asset updates
to IBM TRIRIGA by using the IBM TRIRIGA web service.
Processing rules are configured on the PLUSYASSET2 publish channel to support
data processing.
Processing Rule 10 uses a SKIP action on an asset when the asset and its location
are not integrated to IBM TRIRIGA. An asset is integrated to IBM TRIRIGA when
the asset was initially created in IBM TRIRIGA or when the asset is placed into an
IBM TRIRIGA managed location.
Processing rule 20 uses a SKIP action on a record that meets any of the following
conditions:
v The processing rule skips any asset record that is not of a type that is configured
in the PLUSYASSETTYPE integration control.
v The processing rule skips any asset record that does not have a status value
equal to one that is configured in the PLUSYASSETSTATUS integration control.
v The processing rule skips any asset record that did not include a change to one
of the following fields: Asset Type Description, Location, Siteid, Status, Serial
Number, TRIRIGA ID.
Processing rule 21 uses a SKIP action on any asset record that is in a location that
is managed by IBM TRIRIGA. The rule skips the asset record if the location level
of the asset is not configured in the PLUSYLOCHLEVEL integration control.
Processing rule 23 uses a STOP action on an asset record when the value in the
TRIRIGA ID field is set to PENDING.
Processing rule 24 sets the STARTDESCRIPTION value to the asset number value.
The STARTDESCRIPTION value is used to set the IBM TRIRIGA asset ID.
Processing rule 25 sets the ITEMSETID to the default value of null and also sets
the ITEMNUM to the value of TRUE.
Processing rule 26 sets the STARTDESCRIPTION to the TRIRIGA ID on the asset
record when the asset is integrated. This action is needed because the IBM
TRIRIGA asset ID might be changed and might not be the same as the Maximo
Asset Management asset number. The value in the STARTDESCRIPTION field is
used to set the value in the IBM TRIRIGA Asset ID field.
Processing rule 30 checks the PLUSYRECORDID value. If the PLUSYRECORDID
value is null, the processing rule sets the value to -1. A PLUSYRECORDID value
of -1 indicates an asset that is being created or updated (in an IBM TRIRIGA
managed location), where that updated asset is not yet integrated to IBM
TRIRIGA. When you set the PLUSYRECORDID value to -1, the ITEMSETID is set
to triCreateDraft.
Processing rule 35 provides a value for the PLUSYID field that holds the ‘external’
key of the asset record.
Processing rule 40 sets the value in the SITEID field to the default value of null.
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Processing rule 48 sets the value of the SITEID field to the value in the LOCATION
field for assets where the current location of the asset is not managed by IBM
TRIRIGA.
Processing rule 50 sets the value of the ITEMSETID field to plusyLockHidden when
the location of the asset is not an IBM TRIRIGA managed location.
Processing rule 55 sets the ITEMSETID field to plusyUnlockHidden if the location of
the asset is updated and if the location is an IBM TRIRIGA managed location.
Processing rule 60 sets the value in the REFWO field to the asset type value. Rule
60 also sets the value in the ORGID field to the default value for the currency.
Processing rule 70 sets the value in the REFWO field to the IBM TRIRIGA asset
type value by using the PLUSYTOASSETYPEXREF integration control. The
processing rule also converts the Maximo Asset Management status value to an
IBM TRIRIGA status value by using the PLUSYASSETSTATUSXREF integration
control.
Integration controls:
Publish channels and enterprise services use integration controls to adapt data
formats and structures during the outbound and inbound processing of asset data
XML messages.
The PLUSYTOASSETTYPEXREF integration control provides the mapping of the
Maximo Asset Management asset type to the IBM TRIRIGA asset type for assets
that are sent from Maximo Asset Management to IBM TRIRIGA.
Maximo Asset Management uses a single asset object with an attribute to identify
different asset types but IBM TRIRIGA uses multiple objects to support different
asset types.
The mapping of the Maximo Asset Management asset type identifies the following
three artifacts to support the integration of assets:
v Object Name
v Stage Table Name
v Form Name
The integration supports several IBM TRIRIGA asset types.
Two of the IBM TRIRIGA asset types are provided as default values in the
PLUSYTOASSETTYPEXREF integration control as follows:
Table 29. Default asset types in the PLUSYTOASSETTYPEXREF integration control
Maximo Asset
Management asset type

IBM TRIRIGA type information

FACILITIES

plusyBuildingEquipmentJob~S_TRIBUILDINGEQUIPMENT~triBuildingEquipment

IT

plusyTechnologyAssetsJob~S_TRITECHNOLOGYASSETS~triTechnologyAssets

You can configure the following IBM TRIRIGA asset types in the
PLUSYTOASSETTYPEXREF integration control:

Chapter 7. Reference information

83

Table 30. Configurable asset types in the PLUSYTOASSETTYPEXREF integration control
IBM TRIRIGA asset type

IBM TRIRIGA type information

Furniture

plusyFurnitureJob~S_TRIFURNITURE~triFurniture

Office equipment

plusyOfficeEquipmentJob~S_TRIOFFICEEQUIPMENT~triOfficeEquipment

Telephones

plusyTelephonesJob~S_TRITELEPHONES~triTelephones

The following table shows the integration controls that are associated with asset
integration components:
Table 31. Integration controls that are associated with asset integration components
Integration control

Domain

Default value
(case sensitive)

Default external value (case
sensitive)

PLUSYASSETTYPE

ASSETTYPE

FACILITIES

Not applicable

A list of asset types
that is used for filtering
asset data.

PLUSYASSETSTATUS

LOCASSETSTATUS

OPERATING

Not applicable

A list of asset statuses
that is used for filtering
asset data.

PLUSYLOCHLEVEL

PLUSYLOCHIER

30

Not applicable

A list of location
hierarchy levels that is
used for filtering asset
data.

IT

40

Description

PLUSYDELIM

None

~ (tilde)

Not applicable

Contains the delimiter
value that is used to
combine multiple field
values to a single field.
Do not change this
control value.

PLUSYTOASSETTYPEXREF

ASSETTYPE

FACILITIES

plusyBuildingEquipmentJob~
S_TRIBUILDINGEQUIPMENT~
triBuildingEquipment

Provides the mapping
of the Maximo Asset
Management asset type
to the IBM TRIRIGA
asset type for assets
that are sent from
Maximo Asset
Management to IBM
TRIRIGA.

IT

plusyTechnologyAssetsJob~
S_TRITECHNOLOGYASSETS~
triTechnologyAssets

PLUSYFRASSETTYPEXREF

PLUSYASSETSTATUSXREF
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ASSETTYPE

LOCASSETSTATUS

FACILITIES

triBuildingEquipment

IT

triTechnologyAssets

OPERATING

Available

NOT READY

Draft

DECOMMISSIONED

Retired

Provides the mapping
of the IBM TRIRIGA
asset type to the
Maximo Asset
Management asset type
for assets that are sent
from IBM TRIRIGA to
Maximo Asset
Management.
Provides the mapping
of the Maximo Asset
Management asset
status to the IBM
TRIRIGA asset status
for assets that are sent
from Maximo Asset
Management to IBM
TRIRIGA.

Table 31. Integration controls that are associated with asset integration components (continued)
Integration control

Domain

Default value
(case sensitive)

Default external value (case
sensitive)

PLUSYFRASSETSTATUSXREF

LOCASSETSTATUS

OPERATING

Available

NOT READY

Draft

DECOMMISSIONED

Retired

Description
Provides the mapping
of the IBM TRIRIGA
asset status to the
Maximo Asset
Management asset
status for assets that
are sent from IBM
TRIRIGA to Maximo
Asset Management.

Components for person integration
Person integration components include object structures that define the format and
structure of integration data, publish channels that process and send outbound
data, and an enterprise service that receives and processes inbound data. The
publish channels and enterprise service use processing rules and integration
controls to ensure that data is correctly mapped.
The following table lists the predefined person integration components.
Table 32. Predefined person integration components on
Object structure

Channel or service

Description

PLUSYPERSONTO

PLUSYPERSON
publish channel

Initial load of person data from Maximo
Asset Management to IBM TRIRIGA

PLUSYPERSONTO2

PLUSYPERSON2
publish channel

Ongoing updates of person data from
Maximo Asset Management to IBM
TRIRIGA

PLUSYPERSONFR

PLUSYPERSON
enterprise service

Initial load and ongoing updates of
person data from IBM TRIRIGA to
Maximo Asset Management

Components for initial load of person data from Maximo Asset
Management to IBM TRIRIGA
Predefined publish channels and object structures are provided for the outbound
integration of person data. The object structure defines how person data is
formatted and sent from Maximo Asset Management to IBM TRIRIGA. The
publish channel process the outbound person data and sends the data to IBM
TRIRIGA.
Outbound data mapping for initial load of person data:
The PLUSYPERSONTO object structure maps person data for the initial load of
data from Maximo Asset Management to IBM TRIRIGA.
The PLUSYPERSONTO object structure is used to extract person data from
Maximo Asset Management and format the data for the staging table that sends
the data to IBM TRIRIGA.
The PLUSYPERSONTO object structure is based on the person object. Alias values
for attributes in the object structure identify the corresponding field names for the
IBM TRIRIGA staging tables. In some cases, the object structure attribute acts as a
placeholder to populate a field in the IBM TRIRIGA staging table and the value for
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the field is provided by a publish channel. The following table shows the attributes
and alias values that are configured for person data in the object structure.
Table 33. Attributes and alias values in the PLUSYPERSONTO object structure

Maximo Asset Management
attribute

Alias in the IBM TRIRIGA staging table

Set by
the
publish
channel

PERSONID

TRIIDTX

No

FIRSTNAME

TRIFIRSTNAMETX

No

LASTNAME

TRILASTNAMETX

No

ADDRESSLINE1

TRIADDRESSTX

No

POSTALCODE

TRIZIPPOSTALTX

No

CITY

TRICITYTX

No

STATEPROVINCE

TRISTATEPROVTX

No

COUNTRY

TRICOUNTRYTX

No

HIREDATE

TRIDATEHIREDA

No

TERMINATIONDATE

TRIDATEEXITDA

No

TITLE

TRITITLETX

No

TIMEZONE

TRITIMEZONESCL

Yes

LANGUAGE

TRIUSERLANGUAGELI

Yes

PRIMARYEMAIL

TRIEMAILTX

No

PRIMARYPHONE

TRIWORKPHONETX

No

EMPLOYEETYPE

DC_GUI_NAME

Yes

STATUS

TRISTATUSCL

Yes

LOCATION

PLUSYPRIMARYLOCATIONTX

No

PLUSYID

PLUSYIDTX

Yes

PERSONUID

PLUSYRECORDIDTX

No

OWNERSYSID

TRYCURRENCYUO

Yes

Publish channel for initial export of person data:
The PLUSYPERSON publish channel sends the initial load data to the
S_TRIPEOPLE staging table. Processing rules and integration controls are used to
process and format the data.
The PLUSYPERSON publish channel exports data to the IBM TRIRIGA
DataConnect staging table. The publish channel supports three types of person
data: employees, consultants, and external contacts.
To select data for the staging table, the processing rule 10 is a skip rule that is
associated with the PLUSYPERSON publish channel. Processing rule 10 omits from
the export any person record that meets any of the following criteria:
v The record contains a person type that is not included in the
PLUSYEMPLOYEETYPE integration control.
v The record has a value in the PLUSYID field, which indicates that the record
was already integrated with IBM TRIRIGA.
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v The person status does not exist in the PLUSYPERSONSTATUS integration
control.
The processing rule 20 sets field values in the data that is selected for integration.
The following table lists the cross-references controls that set the field values.
Table 34. Cross-reference controls that are associated with the PLUSYPERSON publish
channel
Cross-reference control

Description

PLUSYPERSTATUSXREF

Sets the value of the person status field.

PLUSYEMPTYPEXREF

Sets the employee type that maps to the
person form label in IBM TRIRIGA.

PLUSYTIMEZONEXREF

Sets the value of the time zone field.

PLUSYLANGUAGEXREF

Sets the value of the language field.

The processing rule 30 sets the PLUSYID field to the person ID and also sets the
currency.
The PLUSYPERSON publish channel uses the PLUSYEXTSYS external system to
send person data to IBM TRIRIGA. The PLUSYEXTSYS external system sends the
data via the PLUSYDC endpoint to populate fields in the S_TRIPEOPLE staging
table. You can customize your implementation with different fields or mapping
values.

Components for creating and updating person data in Maximo
Asset Management from IBM TRIRIGA
Maximo Integrators for TRIRIGA provides an object structure, enterprise service,
processing rules, and integration controls for importing IBM TRIRIGA person data
into Maximo Asset Management.
Inbound data mapping for creating and updating person data:
The PLUSYPERSONFR object structure specifies how person data is mapped
between IBM TRIRIGA and Maximo Asset Management.
The PLUSYPERSONFR object structure is used to load the following person types
that are supported in IBM TRIRIGA: employees, consultants, and external contacts.
The object structure provides attributes from the following source objects:
v The PERSON object
v The PHONE object
v The EMAIL object
The object structure maps fields in Maximo Asset Management to corresponding
fields in IBM TRIRIGA. Extra processing by the enterprise service might change
the value of certain fields. For example, after a person record is sent from IBM
TRIRIGA to Maximo Asset Management, a corresponding person record is created
in Maximo Asset Management. The triRecordIdSY value is appended to the person
ID value in the corresponding person record in Maximo Asset Management to
ensure that a unique person ID is assigned.
The object structure contains the following fields:
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Table 35. Field values in the PLUSYPERSONFR object structure
Maximo Asset Management
field

IBM TRIRIGA field

PLUSYID

plusyIdTX

PERSONID

triIdTX

FIRSTNAME

triFirstNameTX

LASTNAME

triLastNameTX

ADDRESSLINE1

triAddressTX

POSTALCODE

triZipPostalTX

CITY

triCityTX

STATEPROVINCE

triStateProvTX

COUNTRY

triCountryTX

LOCATION

triNameTX

LOCATIONSITE

triParentPropertyTX

HIREDATE

triActiveStartDA

TERMINATIONDATE

triActiveEndDA

STATUS

triStatusCL

TITLE

triTitleTX

EMPLOYEETYPE

triFormNameSY

PLUSYRECORDID

triRecordIDSY

LANGUAGE

triUserLanguageLI

TIMEZONE

triTimeZonesCL

PHONE

triWorkPhoneTX

EMAIL

triEmailTX

Enterprise service for receiving new and updated person data:
The PLUSYPERSON enterprise service loads the person data for employees,
consultants, and external contacts from IBM TRIRIGA through the integration
framework servlet. Associated processing rules set the field values in the PERSON,
PHONE, and EMAIL objects.
The enterprise service can insert new person records and update existing person
records. The PLUSYPERSON enterprise service is associated with the PLUSEXTSYS
external system , and the URL for the enterprise service is http://hostname:port/
meaweb/es/PLUSTEXTSYS/PLUSYPERSON. Messages for each person record are
processed directly into Maximo Asset Management in a synchronous manner.
Cross-reference controls are used to convert the IBM TRIRIGA value to the
corresponding Maximo Asset Management value. The processing rule 10 uses the
following cross-reference controls with the PLUSYPERSON enterprise service:
v PLUSYFRPERSTATUSXREF
v PLUSYEMPTYPEXREF
v PLUSYTIMEZONEXREF
v PLUSYLANGUAGEXREF
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The processing rule 20 sets the IsPrimary flag for the PHONE object to 1, which is
true, and sets the type to WORK.
The processing rule 30 sets the IsPrimary flag for the EMAIL object to 1, which is
true, and sets the type to WORK.
For the PHONE and EMAIL objects, if you do not want the integration to update
the primary values or use the type of WORK, you can reconfigure the processing
rules to meet your requirements.
After a person record is sent from IBM TRIRIGA to Maximo Asset Management, a
corresponding person record is created in Maximo Asset Management. The
triRecordIdSY value is appended to the person ID value in the corresponding
person record in Maximo Asset Management to ensure that a unique person ID is
assigned.

Components for updating person data from Maximo Asset
Management to IBM TRIRIGA
After the initial load of person data is completed, updates and new person records
can be sent to IBM TRIRIGA through the provided publish channel, which uses an
object structure to map the data. Integration controls and processing rules are used
to format and validate the data.
Outbound data mapping for updating person data:
The PLUSYPERSONTO2 object structure maps person data for ongoing updates to
integrated person records.
The PLUSYPERSONTO2 object structure is used to send ongoing updates to IBM
TRIRIGA. The alias values of the attributes in the PLUSYPERSONTO2 object
structure are used to identify the XML element names of the IBM TRIRIGA XML.
Some attributes are used in the processing rules and exit classes even when the
attributes do not have an alias value. However, if an attribute does not have an
alias value, the attribute is not part of the XML message to IBM TRIRIGA.
The object structure provides attributes from the following source objects:
v The PERSON object
v The PHONE object
v The EMAIL object
The following table lists the attributes and alias values that are configured for the
PLUSYPERSONTO2 object structure.
Table 36. Attributes and alias values in the PLUSYPERSONTO2 object structure
Maximo Asset Management
attribute

Alias in the IBM TRIRIGA
staging table

Set by publish channel

PERSONID

triIdTX

No

FIRSTNAME

triFirstNameTX

No

LASTNAME

triLastNameTX

No

ADDRESSLINE1

triAddressTX

No

POSTALCODE

triZipPostalTX

No

CITY

triCityTX

No

STATEPROVINCE

triStateProvTX

No
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Table 36. Attributes and alias values in the PLUSYPERSONTO2 object
structure (continued)
Maximo Asset Management
attribute

Alias in the IBM TRIRIGA
staging table

Set by publish channel

COUNTRY

triCountryTX

No

HIREDATE

triActiveStartDA

No

TERMINATIONDATE

triActiveEndDA

No

TITLE

triTitleTX

No

TIMEZONE

triTimeZonesCL

Yes

LANGUAGE

triUserLanguageLI

Yes

PRIMARYEMAIL

triEmailTX

No

PRIMARYPHONE

triWorkPhoneTX

No

STATUS

triStatusCL

Yes

LOCATION

plusyPrimaryLocationTX

No

PLUSYID

plusyIdTX

Yes

PERSONUID

plusyRecordIdTX

No

SENDERSYSID

plusyIntegrationBL

Yes

EMPLOYEETYPE

triPersonTypeLI

Yes

PLUSYRECORDID

(No alias provided.)

Yes

OWNERSYSID

triCurrencyUO

Yes

DROPPOINT

plusyPersonStatusCL

Yes

Publish channel for sending updates of person data:
The PLUSYPERSON2 publish channel captures updates in Maximo Asset
Management and sends the updates to IBM TRIRIGA. Processing rules and
integration controls are used to process and format the data.
The PLUSYPERSON2 publish channel uses object events to capture updates to the
person data in Maximo Asset Management and uses an IBM TRIRIGA web service
to send the updates to IBM TRIRIGA. The PLUSYPERSON2 publish channel is
associated with the PLUSYEXTSYS external system and with the PLUSYBC end
point.
The processing rule 10 prevents an update to the location of an existing person
record when the PLUSYID field is not null, which means that the record was
already integrated and the location can be updated only in IBM TRIRIGA.
The processing rule 15 stops actions on a person record when the value in the
PLUSYID field is set to PENDING. Person records are pending when the records are
sent to IBM TRIRIGA but the IBM TRIRIGA ID is not yet included in the Maximo
Asset Management record.
The processing rule 20 omits any person record that meets the following criteria:
v The employee type of the record does not exist in the PLUSYEMPTYPETYPE
integration control.
v The status of the record does not exist in the PLUSYPERSTATUS integration
control.
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The processing rule 30 sets field values in the message that sends the updated
fields to IBM TRIRIGA. The following table lists the cross-references controls that
set the field values.
Table 37. Cross-reference controls that are associated with the PLUSYPERSON publish
channel
Cross-reference control

Description

PLUSYPERSTATUSXREF

Sets the value of the person status field.

PLUSYEMPTYPEXREF

Sets the employee type that maps to the
person form label in IBM TRIRIGA.

PLUSYTIMEZONEXREF

Sets the value of the time zone field.

PLUSYLANGUAGEXREF

Sets the value of the language field.

The processing rule that is named rule 50 sets default multiple values in the IBM
TRIRIGA XML for the OWNERSYSID, PLUSYID, and SENDERSYSID fields.

Integration controls associated with person integration
components
Publish channels and enterprise services use integration controls to adapt data
formats and structures during the outbound and inbound processing of person
data XML messages.
The following table shows the integration controls that are associated with person
integration components:
Table 38. Cross-reference controls that are used to set values in IBM TRIRIGA
Default
value
(casesensitive)

Default external
value (case-sensitive) Description

ACTIVE
INACTIVE

Active
Retired

Sets the IBM TRIRIGA
person status based on the
Maximo Asset Management
person status

Integration control

Domain_t

PLUSYPERSTATUSXREF

PERSONSTATUS

PLUSYEMPTYPEXREF

EMPLOYEETYPE 1
2
3

triEmployee
triConsultant
triExternalContact

Sets the IBM TRIRIGA
employee type based on the
Maximo Asset Management
employee type

PLUSYTIMEZONEXREF

TIMEZONE

America/
New_York

(GMT -5) Eastern
Time (US, Canada)
[US/Eastern]

Converts the Maximo Asset
Management time zone to
the IBM TRIRIGA time zone

PLUSYLANGUAGEXREF

N/A

EN

US English

Converts the Maximo Asset
Management language code
to the IBM TRIRIGA
langauge.

PLUSYEMPLOYEETYPE

EMPLOYEETYPE 1

n/a

Lists the Maximo Asset
Management employee
types to filter person data

PLUSYPERSONSTATUS

PERSONSTATUS

n/a

Lists the person status
values to filter person data.

ACTIVE
INACTIVE
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Table 38. Cross-reference controls that are used to set values in IBM TRIRIGA (continued)

Integration control

Domain_t

PLUSYFRPERSTATUSXREF

PERSONSTATUS

Default
value
(casesensitive)

Default external
value (case-sensitive) Description

ACTIVE
ACTIVE
INACTIVE

Active
Active User
Retired

Sets the Maximo Asset
Management person status
based on the IBM TRIRIGA
person status

Components for work order integration
Work order integration components include object structures that define the format
and structure of integration data, publish channels that process and send outbound
data, and an enterprise service that receives and processes inbound data. The
publish channels and enterprise service use processing rules and integration
controls to ensure that data is correctly mapped.
Table 39. Predefined work order integration components on Maximo Asset Management

Object structure

Channel or service

Description

PLUSYWOTO

PLUSYWO
publish channel

Ongoing updates of work order data from Maximo Asset
Management to IBM TRIRIGA

PLUSYWOCOST

PLUSYWOCOST
publish channel

Ongoing updates of work order cost data from Maximo
Asset Management to IBM TRIRIGA

PLUSYWOFR

PLUSYWO
enterprise service

Creation of a work order in Maximo Asset Management
from an IBM TRIRIGA work task

Components for importing work order data to Maximo Asset
Management
Maximo Integrators for TRIRIGA includes an object structure, enterprise service,
processing rules, and integration controls for importing IBM TRIRIGA work tasks
to Maximo Asset Management.
Inbound data mapping for work orders:
The PLUSWOFR object structure specifies how work order data is mapped to
Maximo Asset Management from IBM TRIRIGA.
The PLUSYWOFR object structure includes the WORKORDER object, the
PLUSYMOVELINEITEMS object, the PLUSYOPPORTUNITY object, and the object.
The WORKORDER object and the PLUSYOPPORTUNITY object are primary
objects. A WORKORDER object can have a one-to-many relationship with multiple
PLUSYMOVELINEITEMS objects, and a PLUSYOPPORTUNITY object can have a
one-to-many relationship with multiple PLUSYOPPDETAILS objects.
The following table shows the data that a work task from IBM TRIRIGA provides
that maps to attributes in the WORKORDER, PLUSYMOVELINEITEMS,
PLUSYOPPORTUNITY, and PLUSYOPPDETAILS objects.
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Table 40. Field mapping for inbound work task records
Business Object

Maximo Asset Management fields

WORKORDER

PLUSYDEPENDENCY

IBM TRIRIGA work task
record fields

PLUSYFORMLABELS
PLUSYPROJECTID
PLUSYPROJECTNAME
PLUSYID

triIdTX

PLUSYTASKTYPE

triTaskTypeCL

WOPRIORITY

triPriorityClassCL

WONUM

AutoKey – configured as Set
Restricted

DESCRIPTION

triNameTX

WORKTYPE

TRISP or TRIPW

SITEID

triIdTX of the related property
record

TARGSTARTDATE
TARGCOMPDATE
LOCATION

Valid Location within Site

DESCRIPTION_LONGDESCRIPTION

triDescriptionTX

OWNER

Valid Person

WOCLASS

WOCLASS – Synonym Domain

STATUS

triStatusCL

PLUSYRECORDID

triRecordIdTX

PLUSYDEPENDENCY

triNameTX

PLUSYFORMLABELS

triFormNameSY

STATUS

PLUSYMOVELINEITEMS

OWNER

triIdTX

REPORTEDBY

triRequestedByTX

ONBEHALFOF

triRequestedForTX

PLUSYMOVELINEITEMS_PLUSYID

triIdTX

PLUSYRECORDID

triRecordIdTX

PLUSYASSETNUM

triNameTX

PLUSYASSETDESC

triDescriptionTX

PLUSYASSETFROMBLDG

triParentBuildingTX

PLUSYASSETFROMFLOOR

triParentFloorTX

PLUSYASSETFROMSPACE

triNameTX

PLUSYASSETTOBLDG

triParentBuildingTX

PLUSYASSETTOFLOOR

triParentFloorTX

PLUSYASSETTOSPACE

triNameTX

PLUSYMOVEINSTRUCT

triMoveInstructionsTX

PLUSYPERSONID

triIdTX

PLUSYPERSONDESC

triLastNameTX
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Table 40. Field mapping for inbound work task records (continued)
Business Object

Maximo Asset Management fields

IBM TRIRIGA work task
record fields

PLUSYPERSONFROMBLDG
PLUSYPERSONFROMFLOOR
PLUSYASSETFROMSPACE
PLUSYPERSONTOBLDG
PLUSYPERSONTOFLOOR
PLUSYPERSONTOSPACE
WONUM
SITEID
PLUSYRECORDID
PLUSYTARGETDESC
ORGID
PLUSYMLID
PLUSYOPPORTUNITY

triNameTX

WONUM
SITEID
ORGID

PLUSYOPPDETAILS

PLUSYID

Task ID

PLUSYRECORDID

Opportunity internal ID

PLUSYOPPID

Opportunity ID

PLUSYOPPSTATUS

Opportunity status

PLUSYOPPNAME

Opportunity name

PLUSYOPPDESC

Opportunity description

PLUSYOPPTYPE

Opportunity Type

PLUSYOPPINSPECTBY

Opportunity inspect by

PLUSYOPPINSPECTDATE

Opportunity inspect date

PLUSYOPPCLASS

Opportunity class

PLUSYOPPCOMMENT

Opportunity comment

PLUSYOPPREPCLASS

Opportunity repair class

PLUSYOPPREPCOMMENT

Opportunity repair comment

PLUSYLOCNAME

Opportunity location

PLUSYDEFPRIORITY

Opportunity priority

PLUSYBLDGSYSTEM

Building system item

PLUSYBLDGSYSCLASS

Building system class

PLUSYESTCOST

Opportunity estimated cost

PLUSYSTARTDATE

Opportunity start date

WONUM
SITEID
PLUSYID
ORGID
PLUSYOPPID
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Table 40. Field mapping for inbound work task records (continued)
Business Object

IBM TRIRIGA work task
record fields

Maximo Asset Management fields
PLUSYASSETID
PLUSYASSETNAME
PLUSYSECLOCNAME
PLUSYSECBUILDING
PLUSYSECFLOOR
PLUSYASSETRECID
PLUSYSECLOCRECID

The following table shows the attributes that the PLUSYWOFR object structure
provides to the WORKORDER object.
Table 41. WORKORDER object attributes received from the PLUSYWOFR object structure
Attribute

Description

PLUSYDEPENDENCY

Reserved for future use.

PLUSYFORMLABELS

The label of the IBM TRIRIGA form that is used to create the work
task.

PLUSYPROJECTID

The IBM TRIRIGA project ID if the work task is part of project.

PLUSYPROJECTNAME

The IBM TRIRIGA project name if the work task is part of a project.

PLUSYID

The work task ID.

PLUSYTASKTYPE

The work task type.

WOPRIORITY

Default value that is set by processing rule.

WONUM

The work order number is not provided by IBM TRIRIGA but is set
based on the configuration of the AutoKey in Maximo Asset
Management. You must configure the WONUM field to use the
AUTOKEY.

DESCRIPTION

The work task name in IBM TRIRIGA.

WORKTYPE

Default value that is set by processing rule.

SITEID

The ID of the site that contains the location.

TARGSTARTDATE

Target start date for the work.

TARGCOMPDATE

Target completion date for the work.

LOCATION

Valid location within the site.

DESCRIPTION_LONGDESCRIPTION

The description of the work task in IBM TRIRIGA.

OWNER

Valid person.

WOCLASS

Default value that is set by processing rule.

STATUS

Value that is set by a cross-reference integration control that replaces
the IBM TRIRIGA work task status with a Maximo Asset
Management work order status.

PLUSYRECORDID

Unique internal record ID.

PLUSYOPPID

Opportunity ID.

PLUSYOPPSTATUS

Opportunity status.

PLUSYOPPNAME

Opportunity name.

PLUSYOPPDESC

Opportunity description.
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Table 41. WORKORDER object attributes received from the PLUSYWOFR object structure (continued)
Attribute

Description

PLUSYOPPTYPE

Opportunity type.

PLUSYOPPINSPECTBY

Opportunity inspect by.

PLUSYOPPINSPECTDATE

Opportunity inspect date.

PLUSYOPPCLASS

Opportunity class.

PLUSYOPPCOMMENT

Opportunity comment.

PLUSYOPPREPCLASS

Opportunity repair class.

PLUSYOPPREPCOMMENT

Opportunity repair comment.

PLUSYLOCNAME

Opportunity location.

PLUSYDEFPRIORITY

Opportunity priority.

PLUSYBLDGSYSTEM

Building system item.

PLUSYBLDGSYSCLASS

Building system class.

PLUSYESTCOST

Opportunity estimated cost.

PLUSYSTARTDATE

Opportunity start date.

The PLUSYMOVELINEITEMS business object is a new business object that holds
move line item details for work orders that are received from IBM TRIRIGA. The
following table shows the PLUSYMOVELINEITEMS object attributes that are
provided by the PLUSYWOFR object structure.
Table 42. PLUSYMOVELINEITEMS object attributes provided by the PLUSYWOFR object structure
Attribute

Description

PLUSYID

The same work task ID as stored in the parent WO object.

PLUSYMLID

The ID of the move line item.

PLUSYRECORDID

The same unique internal record ID as stored in the WO object.

PLUSYASSETNUM

The asset number of the asset to move.

PLUSYASSETDESC

Description of the asset to move.

PLUSYASSETFROMBLDG

Building from which to move the asset.

PLUSYASSETFROMFLOOR

Floor from which to move the asset.

PLUSYASSETFROMSPACE

Space from which to move the asset.

PLUSYASSETTOBLDG

Building to which the asset moves.

PLUSYASSETTOFLOOR

Floor to which the asset moves.

PLUSYASSETTOSPACE

Space to which the asset moves.

PLUSYMOVEINSTRUCT

Move instructions.

PLUSYPERSONID

The ID of the person to move.

PLUSYPERSONDESC

Description of the person to move.

PLUSYPERSONFROMBLDG

Building from which to move the person.

PLUSYPERSONFROMFLOOR

Floor from which to move the person.

PLUSYPERSONFROMSPACE

Space from which to move the person.

PLUSYPERSONTOBLDG

Building to which the person moves.

PLUSYPERSONTOFLOOR

Floor to which the person moves.

PLUSYPERSONTOSPACE

Space to which the person moves.
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Table 42. PLUSYMOVELINEITEMS object attributes provided by the PLUSYWOFR object structure (continued)
Attribute

Description

PLUSYTARGETDESC

The description of the destination.

SITEID

The same site ID as stored in the parent WO object.

WONUM

The same work order number as stored in the parent WO object.

ORGID

The same ORGID as stored in the parent WO object.

PLUSYMOVELINEITEMSID

The internal ID of the Maximo Asset Management table

The PLUSYOPPORTUNITY business object is a new business object that holds the
opportunities for a task in Maximo Asset Management. The following table shows
the PLUSYOPPORTUNITY object attributes that are provided by the PLUSYWOFR
object structure.
Table 43. PLUSYOPPORTUNITY object attributes provided by the PLUSYWOFR object structure
Attribute

Description

WONUM

The same work order number as stored in the parent WO
object.

SITEID

The same site ID as stored in the parent WO object.

ORGID

The same organization ID as stored in the parent WO
object.

PLUSYID

Task ID

PLUSYRECORDID

Opportunity internal record ID

PLUSYOPPID

Opportunity ID

PLUSYOPPSTATUS

Opportunity status

PLUSYOPPNAME

Opportunity name

PLUSYOPPDESC

Opportunity description

PLUSYOPPTYPE

Opportunity type

PLUSYOPPINSPECTBY

Opportunity inspect by

PLUSYOPPINSPECTDATE

Opportunity inspect date

PLUSYOPPCLASS

Opportunity class

PLUSYOPPCOMMENT

Opportunity comment

PLUSYOPPPREPCLASS

Opportunity repair class

PLUSYOPPPREPCOMMENT

Opportunity repair comment

PLUSYLOCNAME

Opportunity location

PLUSYDEFPRIORITY

Opportunity priority

PLUSYBLDGSYSTEM

Building system item

PLUSYBLDGSYSCLASS

Building system class

PLUSYESTCOST

Opportunity estimated cost

PLUSYSTARTDATE

Opportunity start date

The PLUSYOPPDETAILS business object is a new business object that holds
opportunity details for work orders that are received from IBM TRIRIGA. The
following table shows the PLUSYOPPDETAILS object attributes that are provided
by the PLUSYWOFR object structure.
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Table 44. PLUSYOPPDETAILS object attributes provided by the PLUSYWOFR object structure
Attribute

Description

WONUM

The same work order number as stored in the parent WO object.

SITEID

The same site ID as stored in the parent WO object.

ORGID

The same organization ID as stored in the parent WO object.

PLUSYID

Task ID

PLUSYOPPID

Opportunity ID

PLUSYASSETID

The secondary asset ID.

PLUSYASSETNAME

The secondary asset name.

PLUSYSECLOCNAME

The secondary location name.

PLUSYSECBUILDING

The secondary building name.

PLUSYSECFLOOR

The secondary floor name.

PLUSYSECLOCRECID

The secondary location ID

PLUSYASSETRECID

Asset ID

Enterprise service for processing inbound work orders:
The PLUSYWO enterprise service receives work task data from IBM TRIRIGA and
maps the data to the structure and formats that are specified in the PLUSYWOFR
object structure.
The PLUSYWO enterprise service is associated with the PLUSYEXTSYS external
system and the URL for the enterprise service is
http://hostname:port/meaweb/es/PLUSYEXTSYS/PLUSYWO.
Processing rules are configured on the enterprise service to provide certain values.
Processing rule 10 uses a REPLACE action to substitute the status value in the IBM
TRIRIGA work task with its equivalent status value in the work order. The rule
applies the PLUSYWOSTATUSXREF integration control to map the status values
and the integration control is associated with the PLUSYWO enterprise service.
You can modify the integration control to specify alternative mapping values that
match the values that are used in your environment.
Processing rule 15 uses a REPLACE action to substitute the value in the
WOPRIORITY field with the value configured in the PLUSYWOPRIORITYXREF
cross-reference integration control. The PLUSYWOPRIORITYXREF integration
control is associated with the PLUSYWO enterprise service.
Processing rule 20 uses a SET action to provide the following default values:
v The value in the WORKTYPE field is set to PLUSYTASKTYPE.
v The value in the WOCLASS field is set to WORKORDER.
v If the value in the WOPRIORITY field is null, the value is set in the field by the
PLUSYWOPRIORITY value integration control. The PLUSYWOPRIORITY
integration control is associated with the PLUSYWO enterprise service. The
default value is 0 but you can change this value to suit the configurations in
your environment.
Processing rule 30 uses a REPLACE action to substitute the value in the
WORKTYPE field with the value configured in the PLUSYWOTYPEXREF

98

Implementation Guide

cross-reference integration control. The PLUSYWOTYPEXREF integration control is
associated with the PLUSYWO enterprise service.

Components for outbound integration of work orders
Maximo Integrators for TRIRIGA installs an object structure on Maximo Asset
Management that defines the format and structure of work order data to send to
IBM TRIRIGA. Predefined publish channels process outbound work order data and
send it to IBM TRIRIGA.
Outbound data mapping for work orders:
The PLUSYWOTO object structure specifies how work order data is mapped from
Maximo Asset Management to IBM TRIRIGA XML fields.
The PLUSYWOTO object structure is based on the WO (work order) object. Alias
values for attributes in the object structure identify the corresponding field names
for IBM TRIRIGA XML data. In some cases, the object structure attribute acts as a
placeholder to populate an IBM TRIRIGA XML field, and the value for the field is
provided by a publish channel. The following table shows the attributes and alias
values that are configured for work orders in the object structure.
Table 45. Attributes and alias values in the PLUSYWOTO object structure
Attribute

Alias
IBM TRIRIGA work task field

Set by publish
channel

WONUM

plusyWonumTX

No

SITEID

plusyIntegrationBL

Yes

PLUSYID

plusyIdTX

Yes

ACTSTART

plusyWoActualStartDT

No

ACTFINISH

plusyWoActualFinishDT

No

STATUS

plusyWoStatusTX

No

WORKORDERID

plusyRecordIdTX

No

WORKTYPE

No alias value. Used by processing rule.

No

REPORTEDBY

plusyReportedByTX

No

REPORTDATE

plusyReportedDT

No

DESCRIPTION

plusyWoDescriptionTX

No

STATUSDATE

plusyWoStatusDT

No

SCHEDSTART

plusyWoSchedStartDT

No

SCHEDFINISH

plusyWoSchedFinishDT

No

OWNER

plusyWoOwnerTX

No

OWNERGROUP

plusyWoOwnerGroupTX

No

SUPERVISOR

plusyWoSupervisorTX

No

VENDOR

plusyWoVendorTX

No

PHONE

plusyPhoneTX

No

ORGID

triCurrencyUO

Yes

SENDERSYSID

No alias value. Used to set the name of the action.

No

PLUSRECORDID

No alias value. Used to set the ID.

No
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Publish channel for sending work order updates to IBM TRIRIGA:
The PLUSYWO publish channel sends outbound data from Maximo Asset
Management based on the data mappings that are specified in the PLUSYWOTO
object structure.
The PLUSYWOTO publish channel uses the PLUSYEXTSYS external system to
send outbound messages from Maximo Asset Management to IBM TRIRIGA. The
external system sends outbound messages to the PLUSYBC endpoint that calls the
IBM TRIRIGA web service.
Processing rules
Processing rules are configured on the publish channel to ensure that the correct
data is provided.
Rule 10 filters updates that are based on the values in the WORKTYPE and
STATUS fields in Maximo Asset Management. Updates are sent only for work
orders where the WORKTYPE value is TRISP. The PLUSYWOSTATUS integration
control is associated with the publish channel. This integration control holds the
following list of the status values that cause an update to be sent:
v
v
v
v

APPR
INPRG
COMP
CAN

Rule 20 provides the external key for the location record that is associated with the
work order. The external key combines the values in the WONUM and SITEID
fields into the PLUSYID field. The PLUSYDELIM integration control sets the
separator between the values. The default delimiter value is ~ (tilde).
Rule 30 checks that the WORKTYPE of the work order is set to TRISPor to TRIPW,
and sets the field value to triWorkTask.
Rule 40 sets the value in the ORGID field as the currency and sets the value in the
SITEID field as the integration Boolean value. The default currency is US Dollars
and the default integration Boolean value is TRUE.
Rule 50 specifies the action in the XML message. The default action is triSave. Rule
50 sets the value in the SENDERSYSID to the default value of null.
Rule 60 sets the value of the SENDERSYSID field to triComplete when the value in
the work order status is set to COMP (complete).
Outbound data mapping for work order costs:
The PLUSYWOCOST object structure specifies how the cost data associated with a
work order is mapped from Maximo Asset Management to IBM TRIRIGA. The
integration sends work order costs for the top-level work order only. Costs for
child work orders are not integrated.
The PLUSYWOCOST object structure holds data about the actual costs incurred for
the materials, tools, labor, and services that are required to complete a work order.
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The object structure adapts the data structure for different cost transactions,
depending on the value in the SOURCEMBO field of object. The SOURCEMBO
field holds one of the following values:
v
v
v
v

MATUSETRANS: Cost of materials
LABTRANS: Cost of labor
SERVRECTRANS: Cost of service
TOOLTRANS: Cost of tools

For a materials cost, for example, the SOURCEMBO value is MATUSETRANS. For
a labor cost, the SOURCEMBO value is LABTRANS. The PLUSYWOCOST
relationship supports the lookup of a work order related to a cost transaction.
Table 46. Relationship used by the PLUSYWOCOST object structure
Relationship
name
WONUM

Description

Parent

Child

SQL WHERE clause

Work order related
to cost

MXGLTXN

WORKORDER

wonum=:wonum and
siteid=:siteid

Alias values for attributes in the object structure identify the corresponding field
names for IBM TRIRIGA XML data. In some cases, the object structure attribute
acts as a placeholder to populate a IBM TRIRIGA XML field, and the value for the
field is provided by a publish channel. The following table shows the attributes
and alias values that are configured for work order costs in the object structure.
Table 47. Attributes and alias values in the PLUSYWOCOST object structure
Attribute

Alias value
IBM TRIRIGA XML field

Set by publish
channel

SOURCEMBO

triNameTX

Yes

DESCRIPTION

triDescriptionTX

Yes

TRANSDATE

triDateDA

Yes

LINECOST

triTotalNU

Yes

BINNUM

triLinlineNumberNU

No

WONUM

TriTaskIdTX

Yes

Publish channel for sending work order cost updates to IBM TRIRIGA:
The PLUSYWOCOST publish channel sends work order costs from Maximo Asset
Management based on the PLUSYWOCOST object structure.
The PLUSYWOCOST publish channel uses the PLUSYEXTSYS external system to
send outbound messages from Maximo Asset Management to IBM TRIRIGA. The
external system sends outbound messages to the PLUSYBC endpoint that calls the
IBM TRIRIGA web service.
Processing rules
Processing rules are configured on the publish channel to ensure that the correct
data is provided.
Processing rule 10 filters costs and does not process a cost record unless it is
associated with a work order that was created in IBM TRIRIGA.
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Processing rule 20 sets values in the TRANSTYPE and ORGID fields. The
TRANSTYPE field holds the name of the IBM TRIRIGA form. All messages are
mapped to the triWorkTask form. The rule also sets the value in ORGID field as
the currency. The default value is US Dollars.
Processing rule 20 sets values in multiple fields. The TRANSTYPE field holds the
name of the IBM TRIRIGA form. All messages are mapped to the
plusyCostItemDTO form. The rule also sets the value in ORGID field as the
currency. The default value is US Dollars. The rule also sets a default value of null
in the WONUM and BINNUM fields and sets the ASSETNUM field to a value of
-1. Subsequent processing by the publish channel updates these values.
The following processing rules set values in specific fields, based on the type of
cost that is associated with the work order:
v Processing rule 30 sets the value in the SOURCEMBO field and is applied to
material costs.
v Processing rule 40 sets values in the SOURCEMBO, DESCRIPTION, and
ACTUALDATE fields and is applied to labor costs.
v Processing rule 50 sets values in the SOURCEMBO, DESCRIPTION, and
ACTUALDATE fields and is applied to tool costs.
v Processing rule 60 sets values in the SOURCEMBO and ACTUALDATE fields
and is applied to service costs.
The publish channel includes a Java processing class that retrieves the related work
order to access the PLUSYID, PLUSYRECORDID, and WORKTYPE values for the
IBM TRIRIGA work task. The mapping of data to the web service XML file varies
based on the value in the SOURCEMBO field.

Integration controls associated with work order integration
components
Publish channels and enterprise services use integration controls to adapt data
formats and structures during the outbound and inbound processing of work order
XML messages.
The following table shows the integration controls that are associated with work
order integration components:
Table 48. Integration controls that are associated with work order integration components

Integration control

Type

PLUSYDELIM

Value

PLUSYWOSTATUS

List

Associated
channel or
service

Domain

Default
Default value external value

PLUSYWO
publish channel

N/A

~ (tilde)

N/A

Sets the character that
separates values when you
combine multiple values to
form a concatenated value.

PLUSYWO
publish channel

WOSTATUS

v APPR

N/A

Filters the list of work order
statuses to provide updates to
IBM TRIRIGA.

Active

Sets the status of the work
order in Maximo Asset
Management based on the
status of the corresponding
work task in IBM TRIRIGA.

v INPRG

Description

v COMP
v CAN
PLUSYWOSTATUSXREF
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PLUSYWO
enterprise
service

WOSTATUS

APPR

Table 48. Integration controls that are associated with work order integration components (continued)
Associated
channel or
service

Integration control

Type

Domain

PLUSYWOTYPEXREF

Crossreference

PLUSYWO
enterprise
service

WORKTYPE

PLUSYWOPRIORITY

Value

PLUSYWO
enterprise
service

PLUSYWOPRIORITYXREF

Crossreference

PLUSYWO
enterprise
service

Default
Default value external value

Description
Sets the type of the work order
in Maximo Asset Management
based on the type of the
corresponding work task in
IBM TRIRIGA.

v TRISP

v Work

v TRIPW

v Planned

N/A

0

N/A

Sets the value in the
WOPRIORITY field in the
Maximo Asset Management
work order.

None

v 1

v Emergency

v 2

v High

v 3

v Medium

v 4

v Low

Sets the priority of the work
order in Maximo Asset
Management based on the
priority of the corresponding
work task in IBM TRIRIGA.

Components for service request integration
The service request interface includes object structures that define the format and
structure of integration data, a publish channel that processes and sends outbound
data, and an enterprise service that receives and processes inbound data. The
publish channel and enterprise service use processing rules and integration
controls to ensure that data is correctly mapped.
Maximo Integrators for TRIRIGA also includes IBM TRIRIGA ticket templates. The
IBM TRIRIGA ticket templates contain predefined data that you can use to capture
critical and consistent data for different service request types.
The following table lists the predefined service request integration components.
Table 49. Predefined service request integration components
Object structure

Channel or service

Description

PLUSYSRTO

PLUSYSR publish channel

Sends service requests from
Maximo Asset Management
to IBM TRIRIGA.

PLUSYSRFR

PLUSYSR enterprise service

Update of service request
status from IBM TRIRIGA to
Maximo Asset Management.

Components for sending service requests from Maximo Asset
Management to IBM TRIRIGA
Predefined object structures and publish channels are provided for the outbound
integration of service requests. The object structures define how service request
data is formatted and sent from Maximo Asset Management to IBM TRIRIGA.
Publish channels process the outbound service request data and send the data to
IBM TRIRIGA.
Outbound data mapping for sending service request data:
The PLUSYSRTO object structure maps service request data for sending from
Maximo Asset Management to IBM TRIRIGA.
The PLUSYSRTO object structure is used to extract service request data from
Maximo Asset Management and to format the data to send to IBM TRIRIGA. Alias
values for attributes in the object structure identify the corresponding field names
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for the IBM TRIRIGA staging tables. In some cases, the object structure attribute
acts as a placeholder to populate a field in the IBM TRIRIGA staging table. The
value for the field in the IBM TRIRIGA staging table is provided by a publish
channel.
The following table shows the attributes and alias values in the PLUSYSRTO object
structure.
Table 50. Attributes and alias values in the PLUSYSRTO object structure

Attribute

Alias value
IBM TRIRIGA task field

Set by
publish
channel

TICKETID

plusyIdTX

No

DESCRIPTION

triDescriptionTX

Yes

DESCRIPTION_LONGDESRIPTION

Non-persistent configured as
included

Yes

No alias
Used for populating Description
PLUSYMOVEFORM

triBuildingTX

Yes

Used for internal processing
CLASS

No alias

Yes

Used to set the value in the record
ID field
TICKETUID

plusyRecordIdTX

No

AFFECTEDPERSON

plusyRequestedForIDTX

Yes

PLUSYRECORDID

plusyPrimaryLocationTX

Yes

PLUSYID

triCustomerOrgTX

Yes

REPORTDATE

triEffectiveFromDA

No

STATUS

plusyIntegrationBL

Yes

REPORTEDBY

plusyRequestByIdTX

Yes

AFFECTEDEMAIL

triPersonTypeLI

Yes

REPORTEDEMAIL

triPesonTypeLI

Yes

REPORTEDPHONE

triRequestForLI

yes

Publish channel for sending service requests:
The PLUSYSR publish channel sends outbound service requests that are related to
space management from Maximo Asset Management to IBM TRIRIGA. Processing
rules and integration controls are used to process and format the data.
The PLUSYSR publish channel uses the PLUSYEXTSYS external system to send
outbound messages from Maximo Asset Management to IBM TRIRIGA. The
external system sends outbound messages via the PLUSYBC endpoint that calls a
web service. You can customize your implementation with different fields or
mapping values.
Processing rules are configured on the PLUSYSR publish channel to support data
processing.
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Processing rule 10 filters the service request data so that only those requests that
meet the following conditions are exported to IBM TRIRIGA.
v The service request is related to space management. Service requests that are
related to space management have a value in the PLUSYMOVEFORM field.
v The status of the service request matches a status that is configured in the
PLUSYSRSTATUS integration control.
v The service request was not previously exported to IBM TRIRIGA for the
configured status. This check is implemented in the processing class of the
publish channel.
Processing rule 20 provides the external key of the service request to IBM TRIRIGA
by using the TICKETID field to concatenate the TICKETID and CLASS fields of the
service request. The processing rule also uses a COMBINE action to concatenate
the Description and Long Description fields into the DESCRIPTION field.
Processing rule 30 sets the STATUS field with the integration Boolean value of
TRUE.
The processing class for the publish channel also does the following processing:
v Truncates the description field to 1000 characters to match the field size in IBM
TRIRIGA
v Populates the space location of the affected by person
v Sets the email of the affected by person and reported by person
v Sets the HR Org of the affected by person

Components for updating service requests in Maximo Asset
Management from IBM TRIRIGA
Maximo Integrators for TRIRIGA provides an object structure, enterprise service,
processing rules, and integration controls for updating the status of service
requests in Maximo Asset Management.
Inbound data mapping for service request data:
The PLUSYSRFR object structure specifies how updates to the statuses of service
requests are mapped to Maximo Asset Management from IBM TRIRIGA.
The PLUSYSRFR object structure provides the following attributes from the SR
object:
v TICKETID
v CLASS
v STATUS
v PLUSYRECORDID
v PLUSYID
Enterprise service for updating service requests:
The PLUSYSR enterprise service receives updates to service request status from
IBM TRIRIGA. The enterprise service maps the data to the structure and formats
that are specified in the PLUSYSRFR object structure. The inbound XML message
specifies a sync action to update the status of an existing service request.
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The PLUSYSR enterprise service is associated with the PLUSYEXTSYS external
system and the URL for the enterprise service is http://hostname:port/meaweb/es/
PLUSYEXTSYS/PLUSYSR.
A processing rule is configured on the PLUSYSR enterprise service to support data
processing.
Processing rule 10 uses the PLUSYSRSTATUSXREF integration control to map the
status value of the IBM TRIRIGA request to a corresponding status value of the
Maximo Asset Management service request.

Integration controls
Publish channels and enterprise services use integration controls to adapt data
formats and structures during the outbound and inbound processing of service
request XML messages.
The following table shows the integration controls that are associated with service
request integration components:
Table 51. Integration controls that are associated with service request integration components
Integration control

Domain

Default value
(case-sensitive)

Default external value
(case-sensitive)

PLUSYDELIM

None

~ (tilde)

Not applicable

Sets the character that separates values
when you combine multiple values to form
a concatenated value.

PLUSYSRSTATUS

SRSTATUS

QUEUED

Not applicable

The status value for a service request that is
used to filter status transactions that are sent
to IBM TRIRIGA.

PLUSYSRSTATUSXREF

SRSTATUS

PENDING

Review in Progress

INPROG

Issued

A cross-reference integration control that is
used to map an IBM TRIRIGA request status
to a Maximo Asset Management service
request status.

RESOLVED

Completed

RESOLVED

Retired

Description

Conditions that are provided in Maximo Integrators for
TRIRIGA
Several conditions are provided in Maximo Integrators for TRIRIGA to support
object structure and control the display of IBM TRIRIGA data.
The following table lists the conditions that are provided in Maximo Integrators for
TRIRIGA for use in processing rules.
Table 52. Conditions for use in processing rules
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Condition

Description

BMXPLUSYLOC

IBM TRIRIGA location

BMXPLUSYPER

IBM TRIRIGA person

BMXPLUSYSHOW

IBM TRIRIGA display or hide action

BMXPLUSYSITE

IBM TRIRIGA site

BMXPLUSYSR

IBM TRIRIGA request

BMXPLUSYTKT

IBM TRIRIGA ticket template

BMXPLUSYWO

IBM TRIRIGA space work
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IBM TRIRIGA integration components
IBM Maximo Integrators for TRIRIGA installs predefined components on IBM
TRIRIGA to support integration with Maximo Asset Management.

IBM TRIRIGA components for location integration
Predefined integration objects and integration queries specify the data that is
integrated. The DataConnect component provides staging tables and workflows for
importing batches of location data. IBM TRIRIGA Connector for Business
Applications provides a web service and workflows for receiving ongoing updates
of data. Workflows are also provided that send ongoing updates to Maximo Asset
Management via an HTTP servlet provided by Maximo Asset Management.

Components for receiving the initial load of location data from
Maximo Asset Management
The Maximo Asset Management integration framework sends batches of location
data to DataConnect staging tables. DataConnect workflows then import the data
from the staging tables into IBM TRIRIGA.
Before location data is exported from Maximo Asset Management, the locations are
configured with IBM TRIRIGA location hierarchy values. The location hierarchy for
the integration has five levels: property, building, floor, space, and subspace.
Location data is loaded in up to five separate exports, starting with the property
locations at the top level of the location hierarchy and working sequentially down
to the lowest level.
In IBM TRIRIGA, you must import the property locations and activate them. When
you activate the property locations, updates are sent back to Maximo Asset
Management. After these updates are received by Maximo Asset Management, the
locations in the next level of the hierarchy are loaded to IBM TRIRIGA.

Staging tables
The following DataConnect staging tables receive location data from Maximo Asset
Management:
v S_TRIPROPERTY
v S_TRIBUILDING
v S_TRIFLOOR
v S_TRISPACE contains space and subspace location records

Workflows
The following workflows import location data from the DataConnect staging
tables:
v plusyPropertyJob - DC Process - Process Incoming Maximo Property Records
v plusyBuildingJob - DC Process - Process Incoming Maximo Building Records
v plusyFloorJob - DC Process - Process Incoming Maximo Floor Records
v plusySpaceJob - DC Process - Process Incoming Maximo Space Records

Business objects
Each workflow includes a DataConnect task that retrieves each record in the
staging table and creates one of the following IBM TRIRIGA business objects:
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v
v
v
v

triProperty
triBuilding
triFloor
triSpace

Components for sending new and updated location data from
IBM TRIRIGA to Maximo Asset Management
After each batch of location data from Maximo Asset Management is imported into
IBM TRIRIGA, the records are activated and sent back to Maximo Asset
Management. The same predefined integration components also send new and
updated integrated location records to Maximo Asset Management on an ongoing
basis.

triActivate events
The following events start an asynchronous workflow to send location records to
Maximo Asset Management:
v triProperty - triActivate - Integration - Maximo Integration
v triBuilding - triActivate - Integration - Maximo Integration
v triFloor - triActivate - Integration - Maximo Integration
v triSpace - triActivate - Integration - Maximo Integration
The workflow identifies which integration object is configured for the business
object for the location record.

Integration objects
The following integration objects are provided, one for each business object:
v triProperty - HTTP Post - Maximo Integration
v triBuilding - HTTP Post - Maximo Integration
v triFloor - HTTP Post - Maximo Integration
v triSpace - HTTP Post - Maximo Integration

Integration queries
The integration objects use the following queries to determine which records to
return to Maximo Asset Management:
v
v
v
v

triProperty - Integration Object - Maximo Integration
triBuilding - Integration Object - Maximo Integration
triFloor - Integration Object - Maximo Integration
triSpace - Integration Object - Maximo Integration

The query report labels have the same value as the name of the table column in
the message that is sent. For example, the value in the Name field is triNameTX
and the value in the Report Label field is also triNameTX.

Integration business objects
The following integration business objects validate the records for integration:
v plusyProperty
v plusyBuilding
v plusyFloor
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v plusySpace

Integration processing workflows
After records are validated for integration, the following synchronous workflows
manage integration processing:
v triProperty - Synchronous - Integration - Process Integration Object
v triBuilding - Synchronous - Integration - Process Integration Object
v triFloor - Synchronous - Integration - Process Integration Object
v triSpace - Synchronous - Integration - Process Integration Object
A Process Integration Object workflow can start several associated workflows,
depending on the actions that are required. For example, the User Message
workflow sets a message flag on a record if an error occurs, and the Send Data
workflow sends the record to Maximo Asset Management. In IBM TRIRIGA, you
can use the Workflow Builder to review the objects, queries, and workflows that
are configured for an interface.

IBM TRIRIGA components for asset integration
Predefined integration objects and integration queries specify the data that is
integrated. The DataConnect component provides staging tables and workflows for
importing batches of asset data. IBM TRIRIGA Connector for Business Applications
provides a web service and workflows for receiving ongoing updates of data.
Workflows are also provided that send ongoing updates to Maximo Asset
Management via an HTTP servlet provided by Maximo Asset Management.

Components for receiving the initial load of asset data from
Maximo Asset Management
The Maximo Asset Management integration framework can load asset data to IBM
TRIRIGA DataConnect staging tables. DataConnect workflows then import the data
from the staging tables into IBM TRIRIGA.

Staging tables
The following DataConnect staging tables receive asset data from Maximo Asset
Management:
v S_TRIBUILDINGEQUIPMENT
v S_TRIFURNITURE
v S_TRIOFFICEEQUIPMENT
v S_TRITECHNOLOGYASSETS
v S_TRITELEPHONES

Workflows
The following workflows import asset data from the DataConnect staging tables:
v plusyBuildingEquipmentJob - DC Process - Process Incoming Maximo Building
Equipment Records
v plusyFurnitureJob - DC Process - Process Incoming Maximo Furniture Records
v plusyOfficeEquipmentJob - DC Process - Process Incoming Maximo Office
Equipment Records
v plusyTechnologyAssetsJob - DC Process - Process Incoming Maximo Technology
Assets Records
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v plusyTelephonesJob - DC Process - Process Incoming Maximo Telephones
Records

Business objects
Each workflow includes a DataConnect task that retrieves each record in the
staging table and creates one of the following IBM TRIRIGA business objects:
v triBuildingEquipment
v triFurniture
v triOfficeEquipment
v triTechnologyAssets
v triTelephones

Components for sending new and updated asset data from IBM
TRIRIGA to Maximo Asset Management
Predefined integration components send new and updated integrated asset records
to Maximo Asset Management on an ongoing basis.

triActivate events
The following events start an asynchronous workflow to send asset records to
Maximo Asset Management:
v triBuildingEquipment - triActivate - Integration - Maximo Integration
v triFurniture - triActivate - Integration - Maximo Integration
v triOfficeEquipment - triActivate - Integration - Maximo Integration
v triTechnologyAssets - triActivate - Integration - Maximo Integration
v triTelephones - triActivate - Integration - Maximo Integration
The workflow identifies which integration object is configured for the business
object for the asset record.

Integration objects
The following integration objects are provided, one for each business object:
v triBuildingEquipment - HTTP Post - Maximo Integration
v triFurniture - HTTP Post - Maximo Integration
v triOfficeEquipment - HTTP Post - Maximo Integration
v triTechnologyAssets - HTTP Post - Maximo Integration
v triTelephones - HTTP Post - Maximo Integration

Integration business objects
The following integration business objects validate the records for integration:
v plusyBuildingEquipment
v plusyFurniture
v plusyOfficeEquipment
v plusyTechnologyAssets
v plusyTelephones
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Integration processing workflows
After records are validated for integration, the following workflows manage
integration processing:
v triBuildingEquipment - Synchronous - Integration - Process Integration Object
v triFurniture - Synchronous - Integration - Process Integration Object
v triOfficeEquipment - Synchronous - Integration - Process Integration Object
v triTechnologyAssets - Synchronous - Integration - Process Integration Object
v triTelephones - Synchronous - Integration - Process Integration Object
A Process Integration Object workflow can start several associated workflows,
depending on the actions that are required. For example, the User Message
workflow sets a message flag on a record if an error occurs, and the Send Data
workflow sends the record to Maximo Asset Management. In IBM TRIRIGA, you
can use the Workflow Builder to review the objects, queries, and workflows that
are configured for an interface.

Components for receiving ongoing updates to assets from
Maximo Asset Management
After assets are integrated, Maximo Asset Management can send ongoing updates
to these assets via an IBM TRIRIGA web service.
To update integrated asset records, Maximo Asset Management sends an XML
message to the URL for the IBM TRIRIGA web service. The message includes the
following information:
v Values for fields in the asset record.
v The action to perform on the asset record.
v The name of the IBM TRIRIGA form, which is one of the following forms:
– triBuildingEquipment
–
–
–
–

triFurniture
triOfficeEquipment
triTechnologyAssets
triTelephones

The web service calls the form that is specified in the inbound XML message and
applies the same validation processes to the incoming record as are applied when
you manually update a record in IBM TRIRIGA.

IBM TRIRIGA components for people integration
Predefined integration objects and integration queries specify the data that is
integrated. The DataConnect component provides staging tables and workflows for
importing batches of people data. IBM TRIRIGA Connector for Business
Applications provides a web service and workflows for receiving ongoing updates
of data. Workflows are also provided that send ongoing updates to Maximo Asset
Management via an HTTP servlet provided by Maximo Asset Management.

Components for receiving the initial load of people data from
Maximo Asset Management
The Maximo Asset Management integration framework can load people data to a
IBM TRIRIGA DataConnect staging table. A DataConnect workflow then imports
the data from the staging table into IBM TRIRIGA.
The following components load people data from Maximo Asset Management:
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v Person records are loaded to the S_TRIPEOPLE DataConnect staging table.
v The plusyPeopleJob - DC Process - Process Incoming Maximo People Records
workflow imports the data from the staging table.
v The data is imported into the triPeople business object.

Components for sending new and updated people data from IBM
TRIRIGA to Maximo Asset Management
Predefined integration components send new and updated integrated people
records to Maximo Asset Management on an ongoing basis.
The following components send new and updated people records to Maximo Asset
Management:
v The triActivate event starts the triPeople - triActivate - Integration - Maximo
Integration asynchronous workflow that starts the integration. The workflow
identifies the integration object that is configured for the business object for the
people record.
v triPeople - HTTP Post - Maximo Integration is the integration object for the
triPeople object. The integration object is configured with an associated query
that determines which records to send to Maximo Asset Management.
v plusyPeople is the integration business object that validates people records for
integration.
After records are validated for integration, the triPeople - Synchronous Integration - Process Integration workflow manages integration processing. The
Process Integration Object workflow can start several associated workflows,
depending on the actions that are required. For example, the User Message
workflow sets a message flag on a record if an error occurs, and the Send Data
workflow sends the record to Maximo Asset Management. In IBM TRIRIGA, you
can use the Workflow Builder to review the objects, queries, and workflows that
are configured for an interface.

Components for receiving ongoing updates to people from
Maximo Asset Management
After people records are integrated, Maximo Asset Management can send ongoing
updates to these records via an IBM TRIRIGA web service.
To update integrated people records, Maximo Asset Management sends an XML
message to the URL for the IBM TRIRIGA web service. The message includes the
following information:
v Values for fields in the people record.
v The action to perform on the people record.
v The name of the IBM TRIRIGA form, which is triPeopleDTO.
The web service calls the form that is specified in the inbound XML message and
applies the same validation processes to the incoming record as are applied when
you manually update a record in IBM TRIRIGA.

IBM TRIRIGA components for work task integration
Predefined integration objects and integration queries specify the data that is
integrated. Workflows are provided that send new and completed work tasks to
Maximo Asset Management via an HTTP servlet provided by Maximo Asset
Management.IBM TRIRIGA Connector for Business Applications provides a web
service and workflows for receiving ongoing updates of data.
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Components for sending a new work task from IBM TRIRIGA to
Maximo Asset Management
When you mark a work task for integration with Maximo Asset Management,
predefined integration components send the record to Maximo Asset Management.
After the record is sent, the work task is set to read-only mode in IBM TRIRIGA.
The following components send the new work task to Maximo Asset Management:
v The triActivate event starts the triWorkTask - triActivate - Integration - Process
Integration Object asynchronous workflow that starts the integration. The
workflow identifies the integration object that is configured for the business
object for the work task record.
v triWorkTask - HTTP Post - Maximo Integration is the integration object for the
triWorkTask object. The integration object is configured with an associated query
that determines which records to send to Maximo Asset Management.
v plusyWorkTask is the integration business object that validates work task records
for integration.
After a work task record is validated for integration, the triWorkTask - triActivate Integration - Process Integration Object workflow starts the triWorkTask Synchronous - Integration - Send Data workflow to send the record to Maximo
Asset Management. If an error occurs, the triWorkTask - Synchronous - Integration
- User Message - Integration Data Not Sent workflow returns an error message to
the user in IBM TRIRIGA.

Components for receiving ongoing updates to work tasks from
Maximo Asset Management
After an integrated work task is sent to Maximo Asset Management, updates are
sent to IBM TRIRIGA via a web service.
To update integrated work task records, Maximo Asset Management sends an XML
message to the URL for the IBM TRIRIGA web service. The message includes the
following information:
v Values for fields in the work task record, such as status updates or other
attributes.
v The action to perform on the work task record.
v The name of the IBM TRIRIGA form for the record, which is the triWorkTask
form.
The same validation processes are applied to the incoming record as are applied
when you manually update a record in IBM TRIRIGA.

Components for sending updates to Maximo Asset Management
on completion of a work task
When the work on an integrated work task is complete, predefined integration
components send messages to Maximo Asset Management with updates of the
assets and people that are affected by the move.

Asset data updates
For each move line item in the completed work task, the following components
update the assets that are affected by the move:

Chapter 7. Reference information

113

v The triCloseOut event starts the triMoveRequestLineItem - triCloseOut Integration - Process Maximo Integration asynchronous workflow that starts the
integration. The workflow identifies the integration object that is configured for
the business object for the asset record.
v Depending on the asset type, one of the following integration objects is used:
– triBuildingEquipment - HTTP Post - Maximo Integration
– triFurniture - HTTP Post - Maximo Integration
– triOfficeEquipment - HTTP Post - Maximo Integration
– triTechnologyAssets - HTTP Post - Maximo Integration
– triTelephones - HTTP Post - Maximo Integration
The integration object is configured with an associated query that determines
which records to send to Maximo Asset Management.
v The integration object uses one of the following integration business objects to
validate the asset record for integration:
– plusyBuildingEquipment
– plusyFurniture
– plusyOfficeEquipment
– plusyTechnologyAssets
– plusyTelephones
v After an asset record is validated for integration, one of the following workflows
manages the integration:
– triBuildingEquipment – Synchronous – Integration – Process Integration
Object
– triFurniture – Synchronous – Integration – Process Integration Object
– triOfficeEquipment – Synchronous – Integration – Process Integration Object
– triTechnologyAssets – Synchronous – Integration – Process Integration Object
– triTelephones – Synchronous – Integration – Process Integration Object
The Process Integration Object workflow can start several associated workflows,
depending on the actions that are required. For example, the User Message
workflow sets a message flag on a record if an error occurs, and the Send Data
workflow sends the record to Maximo Asset Management.

People data updates
For each move line item in the completed work task, the following components
update the people that are affected by the move:
v The triCloseOut event starts the triMoveRequestLineItem - triCloseOut Integration - Process Maximo Integration asynchronous workflow that starts the
integration. The workflow identifies the integration object that is configured for
the business object for the asset record.
v triPeople - HTTP Post - Maximo Integration is the integration object for the
triPeople object. The integration object is configured with an associated query
that determines which records to send to Maximo Asset Management.
v plusyPeople is the integration business object that validates work task records
for integration.
After records are validated for integration, the triPeople - Synchronous Integration - Process Integration workflow manages integration processing. The
Process Integration Object workflow can start several associated workflows,
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depending on the actions that are required. For example, the User Message
workflow sets a message flag on a record if an error occurs, and the Send Data
workflow sends the record to Maximo Asset Management.

IBM TRIRIGA components for service request integration
Predefined integration objects and integration queries specify the data that is
integrated.IBM TRIRIGA Connector for Business Applications provides a web
service and workflows for receiving service requests from Maximo Asset
Management. Workflows are provided that send service request updates to
Maximo Asset Management via an HTTP servlet provided by

Components for receiving service requests from Maximo Asset
Management
Space planning service requests that are created in Maximo Asset Management are
received via an IBM TRIRIGA web service.
To send a service request, Maximo Asset Management sends an XML message to
the URL for the IBM TRIRIGA web service. The message includes the following
information:
v Values for fields in the service request record.
v The action to perform on the service request record.
v The name of the IBM TRIRIGA form, which is triMoveRequest.
The web service calls the form that is specified in the inbound XML message and
applies the same validation processes to the incoming record as are applied when
you manually update a record within IBM TRIRIGA.

Components for sending service request status updates from
IBM TRIRIGA to Maximo Asset Management
Predefined integration components send status updates for integrated service
requests to Maximo Asset Management on an ongoing basis.

Status update events
The following events start an asynchronous workflow to send status updates to
Maximo Asset Management for integrated service requests:
v triCreateDraft
v triIssue
v
v
v
v
v
v
v

triFinalApprovalHidden
triSave
triSaveAndClose
triCompleteFinalHidden
triComplete
triRetire
triUnretire

The workflow identifies which integration object is configured for the business
object for the service request record.

Asynchronous workflows
Each status change event calls the associated asynchronous workflow, which is one
of the following workflows:
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v
v
v
v
v

triMoveRequest
triMoveRequest
triMoveRequest
triMoveRequest
triMoveRequest

-

triCreateDraft - Integration
triIssue - Maximo Integration
triFinalApprovalHidden - Integration - Maximo Integration
triSave - Maximo Integration
triSaveAndClose - Maximo Integration

v
v
v
v

triMoveRequest
triMoveRequest
triMoveRequest
triMoveRequest

-

triCompleteFinalHidden - Integration - Maximo Integration
triComplete - Maximo Integration
triRetire - Maximo Integration
triUnretire - Maximo Integration

The asynchronous workflow uses the following components to send status updates
for the service request to Maximo Asset Management:
v triMoveRequest- HTTP Post - Maximo Integration is the integration object for
the triMoveRequest object. The integration object is configured with an
associated query that determines which records to send to Maximo Asset
Management.
v plusyMoveRequest is the integration business object that validates service
request updates for integration.
After a service request status update is validated for integration, the
triMoveRequest - Synchronous - Integration - Maximo Integration workflow sends
the record to Maximo Asset Management. Other workflows are also used,
depending on the logic that is required for the status update.
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Chapter 8. Troubleshooting a problem
Troubleshooting is a systematic approach to solving a problem. The goal of
troubleshooting is to determine why something does not work as expected and
how to resolve the problem.
The first step in the troubleshooting process is to describe the problem completely.
Problem descriptions help you and the IBM technical-support representative know
where to start to find the cause of the problem. This step includes asking yourself
basic questions:
v What are the symptoms of the problem?
v Where does the problem occur?
v When does the problem occur?
v Under which conditions does the problem occur?
v Can the problem be reproduced?

What are the symptoms of the problem?
When starting to describe a problem, the most obvious question is “What is the
problem?” This question might seem straightforward; however, you can break it
down into several more-focused questions that create a more descriptive picture of
the problem. These questions can include:
v Who, or what, is reporting the problem?
v What are the error codes and messages?
v How does the system fail? For example, is it a loop, hang, crash, performance
degradation, or incorrect result?
The answers to these questions typically lead to a good description of the problem,
which can then lead you a problem resolution.
Two main ways to approach any problem you encounter are understanding
messages and using log files.

Messages
Messages are issued when unexpected events occur. Messages can have any of
these severities:
Informational
The message confirms an event that was requested or describes another
normal occurrence. Informational messages generally do not require any
action. The identifier of an informational message ends with the letter I.
Warning
The message describes an event that might indicate a problem. Read the
message text and determine whether the event is normal or a problem. The
identifier of a warning message ends with the letter W.
Error
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The message describes an event that requires a response. Read the message
description and the suggested response. The identifier of an error message
ends with the letter E.
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You can find a message description easily by entering its identifier into the Search
box in the information center.

Log files
When a problem occurs, log files can often provide clues as to what occurred and
what precipitated the event. You can use the Log Analyzer to collect and analyze
relevant log files.

Where does the problem occur?
Determining where the problem originates is not always easy, but it is one of the
most important steps in resolving a problem. Many layers of technology can exist
between the reporting and failing components. Networks, disks, and drivers are
only a few of the components to consider when you are investigating problems.
The following questions help you to focus on where the problem occurs to isolate
the problem layer:
v Is the problem specific to one platform or operating system, or is it common
across multiple platforms or operating systems?
v Is the current environment and configuration supported?
If one layer reports the problem, the problem does not necessarily originate in that
layer. Part of identifying where a problem originates is understanding the
environment in which it exists. Take some time to completely describe the problem
environment, including the operating system and version, all corresponding
software and versions, and hardware information. Confirm that you are running
within an environment that is a supported configuration. Many problems can be
traced back to incompatible levels of software that are not intended to run together
or have not been fully tested together.

When does the problem occur?
Develop a detailed timeline of events leading up to a failure, especially for those
cases that are one-time occurrences. You can most easily develop a timeline by
working backward: Start at the time an error was reported (as precisely as possible,
even down to the millisecond), and work backward through the available logs and
information. Typically, you need to look only as far as the first suspicious event
that you find in a diagnostic log.
To develop a detailed timeline of events, answer these questions:
v Does the problem happen only at a certain time of day or night?
v How often does the problem happen?
v What sequence of events leads up to the time that the problem is reported?
v Does the problem happen after an environment change, such as upgrading or
installing software or hardware?
Responding to these types of questions can give you a frame of reference in which
to investigate the problem.
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Under which conditions does the problem occur?
Knowing which systems and applications are running at the time that a problem
occurs is an important part of troubleshooting. These questions about your
environment can help you to identify the root cause of the problem:
v Does the problem always occur when the same task is being performed?
v Does a certain sequence of events need to occur for the problem to surface?
v Do any other applications fail at the same time?
Answering these types of questions can help you explain the environment in
which the problem occurs and correlate any dependencies. Remember that just
because multiple problems might have occurred around the same time, the
problems are not necessarily related.

Can the problem be reproduced?
From a troubleshooting standpoint, the ideal problem is one that can be
reproduced. Typically, when a problem can be reproduced you have a larger set of
tools or procedures at your disposal to help you investigate. Consequently,
problems that you can reproduce are often easier to debug and solve. However,
problems that you can reproduce can have a disadvantage: If the problem is of
significant business impact, you do not want it to recur. If possible, re-create the
problem in a test or development environment, which typically offers you more
flexibility and control during your investigation.
v Can the problem be re-created on a test system?
v Are multiple users or applications encountering the same type of problem?
v Can the problem be re-created by running a single command, a set of
commands, or a particular application?

Problems and solutions
Solution information helps you to understand the causes of an issue with your
product and learn what to do to diagnose or resolve the problem.

Cannot send location or asset data from Maximo Asset
Management to IBM TRIRIGA after installation
You cannot send portfolio data for locations or for assets from Maximo Asset
Management to IBM TRIRIGA.

Symptoms
After you complete the installation process, you create a shared set of locations
that is managed by IBM TRIRIGA, and a shared set of assets that can be managed
in Maximo Asset Management or in IBM TRIRIGA. In some cases, the
administrator might receive a notice that the initial load of location or asset data
was not successful. However, in some cases, the only symptom of the problem is
that the records are not automatically activated in IBM TRIRIGA and sent back to
Maximo Asset Management.

Causes
v The external system or publish channel is not enabled.
v The JMS cron task for the outbound queue is not active.
v The import of IBM TRIRIGA staging tables is not operational, or the time
interval for importing is set too high, or both.
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Diagnosing the problem
v Verify that the IBM TRIRIGA external system and the corresponding publish
channel are enabled.
v Verify that the JMS cron task for the SQOUT outbound queue is active.
v Verify that integration messages arrive at the IBM TRIRIGA staging table but are
not imported to IBM TRIRIGA.

Resolving the problem
v In Maximo Asset Management, select Integration > External Systems and select
Enabled for the IBM TRIRIGA external system and the corresponding publish
channel.
v In Maximo Asset Management, select System Integration > Platform Integration
> Cron Task Setup and select Active for the cron task.
v In IBM TRIRIGA, configure the staging table data to be processed. Also, ensure
that the time interval is set to a short interval value such as 1 minute.

Cannot write to IBM TRIRIGA staging tables
Error message BMXAA5207E occurs when you attempt to send data to the IBM
TRIRIGA staging tables.

Symptoms
When you attempt to send data to the IBM TRIRIGA staging tables, you receive
error message BMXAA5207E: Could not write staging table records in target
environment for package package name.

Causes
The PLUSYDC endpoint is not configured correctly.

Diagnosing the problem
Verify that the PLUSYDC endpoint is configured to point to the IBM TRIRIGA
database

Resolving the problem
In Maximo Asset Management, select Integration > End Points. Select the
PLUSYDC endpoint and specify the URL, table space name, and user details to
ensure that the cron task can connect to the IBM TRIRIGA database.

Cannot send updated data from Maximo Asset Management to
IBM TRIRIGA
After data is initially loaded from Maximo Asset Management to IBM TRIRIGA,
you can update integrated data in Maximo Asset Management, but the updated
data is not sent to IBM TRIRIGA.

Symptoms
Updated data is not sent from Maximo Asset Management to IBM TRIRIGA. In
some cases, the administrator might receive a notice that a message is stuck in the
queue. However, in some cases, the only symptom of the problem is the realization
that data is out of sync between the two systems.

Causes
The problem can have one of the following causes:
v The external system or publish channel is not enabled.
v The JMS cron task is not activated.
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v The PLUSYBC endpoint is not set correctly.

Diagnosing the problem
If you receive an error message in the outbound queue about a problem with
invoking the IBM TRIRIGA web service, the problem is with the PLUSYBC
endpoint.
If you do not receive any error messages, then the problem might be with the
external system, the publish channel, or the JMS cron task.

Resolving the problem
1. In Maximo Asset Management, in the External System application, ensure that
the Enabled flags for IBM TRIRIGA and the publish channel are selected.
2. In Maximo Asset Management, in the Cron Tasks application, activate the
SQOUT JMS cron task.
3. In Maximo Asset Management, in the End Points application, configure the
PLUSYBC endpoint with the correct URL, service name, user name, and
password for connection with the IBM TRIRIGA web service.

Cannot send updated data from IBM TRIRIGA to Maximo Asset
Management
After data is initially loaded from Maximo Asset Management to IBM TRIRIGA,
you can update integrated data in IBM TRIRIGA, but the updated data is not sent
to Maximo Asset Management.

Symptoms
Updated data is not sent from IBM TRIRIGA to Maximo Asset Management.

Causes
In IBM TRIRIGA, the URL in the integration object is not configured correctly for
the Maximo Asset Management enterprise service.

Resolving the problem
1. In IBM TRIRIGA, select Tools > System Setup > Integration > Integration
Object and select an HTTP Post - Maximo Integration object.
2. Set the value of the URL in the integration object to the correct value for the
corresponding enterprise service in Maximo Asset Management.
3. Repeat step 2 for each Maximo integration object.
4. Click Execute.

Primary location and organization are missing from request
because Request For person not found in IBM TRIRIGA
A request in IBM TRIRIGA that was created from Maximo Asset Management
contains a warning message that states that the primary location and organization
are required to process the request.

Symptoms
After a request is sent from Maximo Asset Management to IBM TRIRIGA, a
warning message appears in the Attention section of IBM TRIRIGA. The warning
message states that the primary location and organization are required to process
the request.

Causes
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The person that is specified in the Request For field does not have a
corresponding record in IBM TRIRIGA.

Diagnosing the problem
1. In IBM TRIRIGA, verify that a record does not exist for the person that is
specified in the Request For field.
2. In Maximo Asset Management, determine whether the person record was
exported.
3. If the person record was exported, check the outbound JMS queue and the IBM
TRIRIGA staging table for the record.

Resolving the problem
1. If the person record is in the outbound JMS queue and the IBM TRIRIGA
staging table, complete the unfinished integration.
2. If the person record was not exported, export the person record from Maximo
Asset Management to IBM TRIRIGA:
a. In Maximo Asset Management, in the External Systems application, select
the PLUSYEXTSYS external system and open the Publish Channels tab.
b. Select the PLUSYPERSON publish channel and click Data Export.
c. In the Export Condition field, enter personid=’person’ to restrict the export
to only that person record.
d. Click OK to run the export.
.

Errors when status updates are sent from IBM TRIRIGA to
Maximo Asset Management
When status updates are sent from IBM TRIRIGA to Maximo Asset Management,
errors occur because of status values that are invalid.

Symptoms
The integration of status updates from IBM TRIRIGA to Maximo Asset
Management results in errors because of invalid status values.

Causes
Each integration cross-reference control contains a list of valid values. The status
value that is sent to the Maximo Asset Management record is not a valid value for
the integration cross-reference control.

Diagnosing the problem
1. In the reference chapter of this guide, locate the inbound service that you are
using and find the status cross-reference control that is used by this service.
2. In Maximo Asset Management, open the cross-reference control and verify that
the status value that is sent from IBM TRIRIGA is listed as a valid value.

Resolving the problem
In Maximo Asset Management, open the cross-reference control and add the value
from IBM TRIRIGA to the list of valid values. Ensure that the status values are
properly mapped to valid Maximo Asset Management values.
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Integrated person records are not updated
If your environment contains integrations to multiple products, problems can occur
when integrated person records are updated. For example, an integration with a
human resources system routinely updates Maximo person records. After the
person record is integrated with IBM TRIRIGA, the human resources software
system is unable to change the location or site for the person record.

Symptoms
Person records that are integrated with IBM TRIRIGA cannot be updated in
Maximo Asset Management. Location values for Maximo person records that IBM
TRIRIGA manages cannot be updated.

Causes
A STOP processing rule for the PERSON object prevents the update of the location
for an existing person record when the data is maintained in IBM TRIRIGA.

Diagnosing the problem
Confirm that the integration is either changing a person's location or updating a
person record for which the value of the IBM TRIRIGA ID is set to PENDING.

Resolving the problem
If you have external software systems that integrate with Maximo Asset
Management, design the integration so that the person records are checked for
integration with IBM TRIRIGA and, when integrated, site and location for person
records are not changed. You might decide to change the integration of person data
to Maximo Asset Management. You can also adjust the integration of person data
from Maximo Asset Management to IBM TRIRIGA to match other integrations that
are implemented, such as integrations with HR systems.

Chapter 8. Troubleshooting a problem
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Notices
This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.
IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:
IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.
For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan
The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.
This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.
Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:
IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758 U.S.A.
Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.
The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.
Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.
All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.
This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.
COPYRIGHT LICENSE:
This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.
If you are viewing this information softcopy, the photographs and color
illustrations may not appear.
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Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at www.ibm.com/legal/copytrade.shtml.
Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.
Microsoft, Windows, and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.
UNIX is a registered trademark of The Open Group in the United States and other
countries.
Other product and service names might be trademarks of IBM or other companies.
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Glossary
services that are used to send and receive
integration data. The external system
must be enabled for integration to occur.

This glossary includes terms and definitions for
Maximo Integrators for TRIRIGA.
The following cross-reference is used in this
glossary:
v See refers you from a term to a preferred
synonym, or from an acronym or abbreviation
to the defined full form.
To view glossaries for other IBM products, go to
www.ibm.com/software/globalization/
terminology (opens in new window).

B
business object
In IBM TRIRIGA, the definition of a data
object.
building
In Maximo Integrators for TRIRIGA, the
second level of the fixed location
hierarchy: Property - Building - Floor Space - Subspace.

C
condition assessment
In Maximo Integrators for TRIRIGA, a set
of specialized workflows that supports
the process of inspecting facilities.

E
endpoint
A Maximo Asset Management integration
component that identifies the target
destination and the transport mechanism
that is used to publish data or to call a
service on an external system.
enterprise service
A Maximo Asset Management integration
component that receives and processes
data that is sent by an external system.
external system
An external system is the remote system
in an integration scenario. In Maximo
Asset Management, an external system is
an integration component that specifies
the publish channels and enterprise
© Copyright IBM Corp. 2013

F
floor

In Maximo Integrators for TRIRIGA, the
third level of the fixed location hierarchy:
Property - Building - Floor - Space Subspace.

I
inbound data
In Maximo Integrators for TRIRIGA, data
that is sent from IBM TRIRIGA to
Maximo Asset Management through an
enterprise service.

L
location hierarchy
In IBM TRIRIGA, a structure of locations
that shows how the locations are related
to each other. Maximo Integrators for
TRIRIGA uses a fixed hierarchy of
Property - Building - Floor - Space Subspace.

M
move work task
In IBM TRIRIGA, a record that lists the
work that is required to complete a
request for a space move.

O
object structure
The common data layer that the
integration components use for outbound
and inbound application message
processing. An object structure consists of
one or more related business objects that
define the content of an XML message or
schema.
opportunity
In IBM TRIRIGA, a defect or condition
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from a Maximo database to an IBM
TRIRIGA database or from an IBM
TRIRIGA database to a Maximo database.

that is observed during the condition
assessment and that requires action to
remedy.
organization
In Maximo Asset Management, a record
that identifies a unique legal entity. The
data set for an organization includes
information that companies or other
distinct legal entities might share, such as
calendars, vendors, and financial
information. An organization can contain
one or more sites. See also site.
outbound data
In Maximo Integrators for TRIRIGA, data
that is sent from Maximo Asset
Management to IBM TRIRIGA through a
publish channel.

P
people
In IBM TRIRIGA, a record that contains
data about an individual, such as an
employee or contractor. See also person.
person
In Maximo Asset Management, a record
that contains data about an individual in
an organization, such as an employee. See
also people.
planned work task
In IBM TRIRIGA, a record that lists the
work that is required to complete the
work that is related to an opportunity.
project
In IBM TRIRIGA, a logical grouping of
work tasks. See also work task.
property
In Maximo Integrators for TRIRIGA, the
first level of the fixed location hierarchy:
Property - Building - Floor - Space Subspace.
publish channel
An integration component that is used for
sending asynchronous messages to an
external system.

S
seed data
Data that is loaded from one database to
another database to provide the initial
data for integration. Seed data can go
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site

In Maximo Asset Management, a work
location, such as a plant or facility. See
also organization.

space

In Maximo Integrators for TRIRIGA, the
fourth level of the fixed location
hierarchy: Property - Building - Floor Space - Subspace.

space move planning
In IBM TRIRIGA, a set of specialized
workflows that supports planning for the
efficient use of space and moving assets
and people within the spaces.
subspace
In Maximo Integrators for TRIRIGA, the
fifth level of the fixed location hierarchy:
Property - Building - Floor - Space Subspace.

W
work order
In Maximo Asset Management, a record
that contains information about work that
must be completed. See also work task.
work task
In IBM TRIRIGA, a record that lists the
work that is required. Do not use the
term "task". See also work order.
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asset integration
components
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outbound 78
overview 77
configuring in IBM TRIRIGA 42
DataConnect
business objects 109
staging tables 109
workflows 109
enterprise services
PLUSYASSET 40, 80
exporting asset data 41
IBM TRIRIGA components 109
integrating assets 39
integration objects 110
integration processing workflows 110
integration queries 110
object structures
PLUSYASSETFR 79
PLUSYASSETTO 78
PLUSYASSETTO2 81
overview 39
processing rules 82
publish channel
PLUSYASSET 40
PLUSYASSET2 40
publish channels
PLUSYASSET 78
PLUSYASSET2 81
updating integrated records 111

cross-reference integration controls
configuring 27
configuring for many-to-one
mapping 61
currencies
changing types 62
customizations
adding new fields 64
adding new fields to IBM TRIRIGA
business objects 66

D
database fields
configuring lengths of fields 25
DataConnect
business objects
asset integration 109
location integration 107
person integration 111
service request integration 115
work order integration 113
staging tables
asset integration 109
location integration 107
person integration 111
service request integration 115
work order integration 113
workflows
asset integration 109
location integration 107
person integration 111
service request integration 115
work order integration 113

B
business scenarios
overview 1

C
conditions
processing rules 106
configuration
endpoints 26
external system 28
field lengths 25
IBM TRIRIGA
assets 42
connection to Maximo Asset
Management 29
people 51
work tasks 29
integration controls
cross-reference controls 27
list controls 27
locations in IBM TRIRIGA 36
overview
IBM TRIRIGA 28
Maximo Asset Management 25

© Copyright IBM Corp. 2013

E
employee types
integrating person data 45
endpoints
configuring 26
PLUSYBC 26
PLUSYDC 26
enterprise services
asset integration
PLUSYASSET 40, 80
processing rules 80
enabling the external system
location integration
PLUSYLOCHIER 76
processing rules 76
overview 5
person integration
PLUSYPERSON 47, 88
processing rules 88
service request integration
PLUSYSR 106
processing rules 106
work order integration
PLUSYWO 54, 98
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enterprise services (continued)
work order integration (continued)
processing rules 98

H
hierachy levels
integrating location data
hierachy values
integrating location data

34
34

I
IBM Maximo Integrators for TRIRIGA
importing patch helper
on IBM TRIRIGA 24
installing
on IBM TRIRIGA 23
on Maximo Asset
Management 22
overview 1
removing data 63
IBM TRIRIGA
business objects
adding new fields 66
asset integration 109
location integration 107
person integration 111
service request integration 115
work order integration 113
web service
asset integration 111
person integration 112
work order integration 113
work tasks
integrating work orders 52
preventing unathorized
updates 29
work types
assigning to organizations 54
implementations
environments that support multiple
integrations 18
integrating portfolio data 12
loading initial data
from IBM TRIRIGA to Maximo
Asset Management 16
from Maximo Asset Management
to IBM TRIRIGA 13
planning 11
preparing for integration 12
reference documents 19
installation
IBM Maximo Integrators for TRIRIGA
overview 21
importing patch helper
on IBM TRIRIGA 24
installing 24
on IBM TRIRIGA 23
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installation (continued)
installing (continued)
on Maximo Asset
Management 22
prerequisites 21
troubleshooting sending location or
asset data 119
integration controls
asset integration
PLUSYASSETSTATUS 83
PLUSYASSETSTATUSXREF 83
PLUSYASSETTYPE 83
PLUSYDELIM 83
PLUSYFRASSETSTATUSXREF 83
PLUSYFRASSETTYPEXREF 83
PLUSYLOCHLEVEL 83
PLUSYTOASSETTYPEXREF 83
cross-reference integration controls
configuring 27
configuring for many-to-one
mapping 61
errors sending status updates 122
list integration controls
configuring 27
location integration
PLUSYDELIM 77
PLUSYDELIM2 77
PLUSYLOCSTATUS 77
overview 5
person integration
PLUSYEMPLOYEETYPE 91
PLUSYEMPTYPEXREF 91
PLUSYLANGUAGEXREF 91
PLUSYPERSONSTATUS 91
PLUSYPERSTATUSXREF 91
PLUSYTIMEZONEXREF 91
service request integration
PLUSYDELIM 106
PLUSYSRSTATUS 106
PLUSYSRSTATUSXREF 106
work order integration
PLUSYDELIM 100, 102
PLUSYWOPRIORITYXREF 102
PLUSYWOSTATUS 100, 102
PLUSYWOSTATUSXREF 98, 102
integration objects
asset integration 110
location integration 108
person integration 112
service request integration 115
work order integration 113
integration processing workflows
asset integration 110
location integration 108
person integration 112
service request integration 115
work order integration 113
integration queries
asset integration 110
location integration 108
person integration 112
service request integration 115
work order integration 113
integrations
adding
fields for ongoing updates 65
new fields 64, 65
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integrations (continued)
adding (continued)
new fields during
implementation 64
initial load of Maximo Asset
Management into IBM TRIRIGA 28
integrating portfolio data 12
loading initial data
from IBM TRIRIGA to Maximo
Asset Management 16
from Maximo Asset Management
to IBM TRIRIGA 13
preparing for integration 12
removing data 63
sequence of integrating 11

L
list integration controls
configuring 27
location integration
assigning
hierarchy levels 34
hierarchy values 34
components
initial load from Maximo Asset
Management 67
ongoing updates from Maximo
Asset Management 74
overview 67
DataConnect
business objects 107
staging tables 107
workflows 107
enabling sites for integration 34
enterprise services
PLUSYLOCHIER 76
exporting locations from Maximo
Asset Management 35
hierarchy 31
IBM TRIRIGA components 107
initial load
building data 69
floor data 70
floor location data 71
property data 67, 68
space and subspace data 72
space locations 73
subspace locations 73
integration objects 108
integration processing
workflows 108
integration queries 108
managing in IBM TRIRIGA 36
object structures
PLUSYBLDG 69
PLUSYFLOOR 70
PLUSYLOCHIER 75
PLUSYPROP 67
overview 31
PLUSYEXTSYS external system 35
preparing data 34
processing rules 76
publish channels
PLUSYBLDG 69
PLUSYFLOOR 71
PLUSYPROP 68

location integration (continued)
scenario 1
setting the Location System value
staging tables 35
S_TRIBUILDING 69
S_TRIPROPERTY 68

M
mxe.int.keyresponse property
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O
object structures
asset integration
PLUSYASSETFR 79
PLUSYASSETTO 78
PLUSYASSETTO2 81
location integration
PLUSYBLDG 69
PLUSYFLOOR 70
PLUSYLOCHIER 75
PLUSYPROP 67
PLUSYSPACE 72
overview 5
person integration
PLUSYPERSONFR 87
PLUSYPERSONTO 85
PLUSYPERSONTO2 85
service request integration
PLUSYSRFR 105
PLUSYSRTO 103
work order integration
PLUSYWOCOST 100
PLUSYWOFR 92
PLUSYWOTO 99
organizations
assigning IBM TRIRIGA work
types 54
overview
architecture 5
business scenarios 1
data flow 2
data management 7
enterprise services 5
integration components 5
object structures 5
processing rules 5
product features 1
publish channels 5
scenarios
creating planned work tasks 4
moving employees and assets to
new locations 1

P
patch helper
importing 24
people integration
See person integration
person integration
components
inbound 87
outbound 85, 89
overview 85
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person integration (continued)
configuring in IBM TRIRIGA 51
data processing 47
DataConnect
business objects 111
staging tables 111
workflows 111
employee types 45
exporting to IBM TRIRIGA 49
IBM TRIRIGA components 111
integrating person data 44
integration controls
overview 91
integration objects 112
integration processing workflows 112
integration queries 112
object structures
PLUSYPERSONFR 87
PLUSYPERSONTO 85
PLUSYPERSONTO2 89
overview 44
processing rules 90
status 44
troubleshooting
integrated person records are not
updated 123
Request For person not found in
IBM TRIRIGA 121
updating from external HR
systems 47
updating integrated records 112
portfolio data
assets 39
integration scenario 12
locations 31
overview 9
persons 44
processing rules
conditions 106
publish channels
asset integration
PLUSYASSET 40, 78
PLUSYASSET2 40, 81, 82
enabling the external system 28
location integration
PLUSYBLDG 69
PLUSYFLOOR 71
PLUSYPROP 68
PLUSYSPACE 73
PLUSYSSPACE 73
overview 5
person integration
PLUSYPERSON 47, 86
PLUSYPERSON2 47, 90
service request integration
PLUSYSR 104
work order integration
PLUSWO 100
PLUSYWOCOST 101

S
scenarios
integrating portfolio data 12
loading initial data
from IBM TRIRIGA to Maximo
Asset Management 16

scenarios (continued)
loading initial data (continued)
from Maximo Asset Management
to IBM TRIRIGA 13
preparing for integration 12
service request integration
components
inbound 105
outbound 103
overview 103
configuring service request status 57
DataConnect
business objects 115
staging tables 115
workflows 115
enterprise services
PLUSYSR 106
IBM TRIRIGA components 115
integrating data 56
integration controls
PLUSYDELIM 106
PLUSYSRSTATUS 106
PLUSYSRSTATUSXREF 106
integration objects 115
integration processing workflows 115
integration queries 115
object structures
PLUSYSRFR 103
PLUSYSRTO 103
overview 56
processing rules 104
publish channels
PLUSYSR 104
ticket templates 58
staging tables
adding new fields 64
integrating
locations 31
integrating person data 49
S_TRIBUILDING 69
S_TRIPROPERTY 68
troubleshooting 120
system properties
mxe.int.keyresponse property 18

T
ticket templates
service request integration 58
transactional data
overview 9
service requests 56
work orders 52
work task 52
troubleshooting
errors sending status updates 122
identifying problems 117
integrated person records are not
updated 123
missing primary location and
organization 121
Request For person not found in IBM
TRIRIGA 121
sending location or asset data after
installation 119
sending updates from IBM TRIRIGA
to Maximo Asset Management 121

troubleshooting (continued)
sending updates from Maximo Asset
Management to IBM TRIRIGA 120
systematic problem solving 117
writing to IBM TRIRIGA staging
tables 120

W
work order costs
integrating work orders 52
work order integration
components
inbound 92
outbound 99
overview 92
configuration tasks 54
configuring
PRIORITY default value 54
WOCLASS default value 54
DataConnect
business objects 113
staging tables 113
workflows 113
enterprise services
PLUSYWO 54, 98
IBM TRIRIGA components 113
IBM TRIRIGA work tasks 52, 55
integration controls
PLUSYDELIM 100
PLUSYWOPRIORITYXREF 102
PLUSYWOSTATUS 100
PLUSYWOSTATUSXREF 98
integration objects 113
integration processing workflows 113
integration queries 113
object structures
PLUSYWOCOST 100
PLUSYWOFR 92
PLUSYWOTO 99
organizations
assigning TRIRIGA work
types 54
processing rules 98
publish channels
PLUSWO 100
PLUSYWOCOST 101
status updates 52
updating integrated records 113
work order costs 52
work task
move 52
planned 52
work task integration
See work order integration
work tasks
scenario 4
work type
inspection 54
move 54
planned 54
workflows
asset integration
asynchronous 109, 110
importing from staging tables 109
integration processing 110
synchronous 110
Index
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workflows (continued)
location integration
asynchronous 108
importing from staging tables
integration processing 108
synchronous 107, 108
person integration
asynchronous 111, 112
importing from staging tables
integration processing 112
synchronous 112
service request integration
asynchronous 115
importing from staging tables
integration processing 115
synchronous 115
work order integration
asynchronous 113
importing from staging tables
integration processing 113
synchronous 113
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